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Copyright © 2012 ASUSTeK COMPUTER INC. All Rights Reserved.

No part of this manual, including the products and software described in it, may be reproduced,
transmitted, transcribed, stored in a retrieval system, or translated into any language in any form or by any
means, except documentation kept by the purchaser for backup purposes, without the express written
permission of ASUSTeK COMPUTER INC. (“ASUS").

Product warranty or service will not be extended if: (1) the product is repaired, modified or altered, unless
such repair, modification of alteration is authorized in writing by ASUS; or (2) the serial number of the
product is defaced or missing.

ASUS PROVIDES THIS MANUAL “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT SHALL ASUS, ITS
DIRECTORS, OFFICERS, EMPLOYEES OR AGENTS BE LIABLE FOR ANY INDIRECT, SPECIAL,
INCIDENTAL, OR CONSEQUENTIAL DAMAGES (INCLUDING DAMAGES FOR LOSS OF PROFITS,
LOSS OF BUSINESS, LOSS OF USE OR DATA, INTERRUPTION OF BUSINESS AND THE LIKE),
EVEN IF ASUS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES ARISING FROM ANY
DEFECT OR ERROR IN THIS MANUAL OR PRODUCT.

SPECIFICATIONS AND INFORMATION CONTAINED IN THIS MANUAL ARE FURNISHED FOR
INFORMATIONAL USE ONLY, AND ARE SUBJECT TO CHANGE AT ANY TIME WITHOUT NOTICE,
AND SHOULD NOT BE CONSTRUED AS A COMMITMENT BY ASUS. ASUS ASSUMES NO
RESPONSIBILITY OR LIABILITY FOR ANY ERRORS OR INACCURACIES THAT MAY APPEAR IN THIS
MANUAL, INCLUDING THE PRODUCTS AND SOFTWARE DESCRIBED IN IT.

Products and corporate names appearing in this manual may or may not be registered trademarks or
copyrights of their respective companies, and are used only for identification or explanation and to the
owners’ benefit, without intent to infringe.

Offer to Provide Source Code of Certain Software

This product may contain copyrighted software that is licensed under the General Public License (“GPL")
and under the Lesser General Public License Version (“LGPL"). The GPL and LGPL licensed code in this
product is distributed without any warranty. Copies of these licenses are included in this product.

You may obtain the complete corresponding source code (as defined in the GPL) for the GPL Software,
and/or the complete corresponding source code of the LGPL Software (with the complete machine-
readable “work that uses the Library”) for a period of three years after our last shipment of the product
including the GPL Software and/or LGPL Software, which will be no earlier than December 1, 2011, either
(1) for free by downloading it from http://support.asus.com/download;

or

(2) for the cost of reproduction and shipment, which is dependent on the preferred carrier and the location
where you want to have it shipped to, by sending a request to:

ASUSTeK Computer Inc.
Legal Compliance Dept.
15LiTe Rd.,,

Beitou, Taipei 112
Taiwan

In your request please provide the name, model number and version, as stated in the About Box of the
product for which you wish to obtain the corresponding source code and your contact details so that we
can coordinate the terms and cost of shipment with you.

The source code will be distributed WITHOUT ANY WARRANTY and licensed under the same license as
the corresponding binary/object code.

This offer is valid to anyone in receipt of this information.

ASUSTeK is eager to duly provide complete source code as required under various Free Open Source
Software licenses. If however you encounter any problems in obtaining the full corresponding source code
we would be much obliged if you give us a notification to the email address gpl@asus.com, stating the
product and describing the problem (please do NOT send large attachments such as source code archives
etc to this email address).
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Safety information

Electrical safety

To prevent electrical shock hazard, disconnect the power cable from the electrical outlet
before relocating the system.

When adding or removing devices to or from the system, ensure that the power cables
for the devices are unplugged before the signal cables are connected. If possible,
disconnect all power cables from the existing system before you add a device.

Before connecting or removing signal cables from the motherboard, ensure that all
power cables are unplugged.

Seek professional assistance before using an adapter or extension cord. These devices
could interrupt the grounding circuit.

Ensure that your power supply is set to the correct voltage in your area. If you are not
sure about the voltage of the electrical outlet you are using, contact your local power
company.

If the power supply is broken, do not try to fix it by yourself. Contact a qualified service
technician or your retailer.

Operation safety

Before installing the motherboard and adding devices on it, carefully read all the manuals
that came with the package.

Before using the product, ensure all cables are correctly connected and the power
cables are not damaged. If you detect any damage, contact your dealer immediately.

To avoid short circuits, keep paper clips, screws, and staples away from connectors,
slots, sockets and circuitry.

Avoid dust, humidity, and temperature extremes. Do not place the product in any area
where it may become wet.

Place the product on a stable surface.

If you encounter technical problems with the product, contact a qualified service
technician or your retailer.

vii



viii

About this guide

This user guide contains the information you need when installing and configuring the motherboard.

How this guide is organized

This guide contains the following parts:

Chapter 1: Product introduction

This chapter describes the features of the motherboard and the new technology it
supports.

Chapter 2: Hardware information

This chapter lists the hardware setup procedures that you have to perform when
installing system components. It includes description of the switches, jumpers, and
connectors on the motherboard.

Chapter 3: BIOS setup

This chapter tells how to change system settings through the BIOS Setup menus.
Detailed descriptions of the BIOS parameters are also provided.

Chapter 4: Software support

This chapter describes the contents of the support DVD that comes with the
motherboard package and the software.

Chapter 5: Multiple GPU technology support

This chapter describes how to install and configure multiple ATI® CrossFireX™ and
NVIDIA® SLI™ graphics cards.

Where to find more information

Refer to the following sources for additional information and for product and software updates.

1.

ASUS websites

The ASUS website provides updated information on ASUS hardware and software
products. Refer to the ASUS contact information.

Optional documentation

Your product package may include optional documentation, such as warranty flyers,
that may have been added by your dealer. These documents are not part of the
standard package.



Conventions used in this guide

To ensure that you perform certain tasks properly, take note of the following symbols used
throughout this manual.

// \ DANGER/WARNING: Information to prevent injury to yourself when trying to

"7\ complete a task.

y '\ CAUTION: Information to prevent damage to the components when trying to
e\ complete a task.

AQ\ IMPORTANT: Instructions that you MUST follow to complete a task.

% NOTE: Tips and additional information to help you complete a task.

Typography

Bold text Indicates a menu or an item to select.

Italics Used to emphasize a word or a phrase.

<Key> Keys enclosed in the less-than and greater-than sign means

that you must press the enclosed key.

Example: <Enter> means that you must press the Enter or
Return key.

<Keyl> + <Key2> + <Key3> If you must press two or more keys simultaneously, the key
names are linked with a plus sign (+).

Example: <Ctrl> + <Alt> + <Del>
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Chipset

Expansion slots

Multi-GPU support

LGA1155 socket for Intel® 3rd/2nd Generation Core™ i7 / Core™

i5/ Core™ i3 / Pentium®/ Celeron® Processors

Supports 22/32nm CPU

Supports Intel® Turbo Boost Technology 2.0

* The Intel® Turbo Boost Technology 2.0 support depends on the
CPU types.

** Refer to www.asus.com for Intel CPU support list

Intel® Z77 Express Chipset

4 x DIMM, max. 32GB, DDR3 2600 (O.C.)* / 2400 (O.C.)* /

2200(0.C.)* /2133(0.C.) / 1866(0.C.) / 1600 / 1333 / 1066 MHz,

non-ECC, un-buffered memory

Dual channel memory architecture

Supports Intel® Extreme Memory Profile (XMP)

* Hyper DIMM support is subject to the physical characteristics
of individual CPUs. Please refer to Memory QVL (Qualified
Vendors List) for details.

2 x PCI Express 3.0*/2.0 x16 slots (single at x16, or dual at

x8 / x8 mode)

1 x PCI Express 2.0 x16 slot [black] (max. at x4 mode, compatible
with PCle x1 and x4 devices)

4 x PCI Express 2.0 x1 slots**

* PCle 3.0 speed is supported by Intel®3rd generation Core™
processors.
** The PCle x1_2 shares bandwidth with SATA6G_E12.
SATABG_E12 is enabled by default for system resource
optimization.

Integrated Graphics Processor - Intel® HD Graphics support
Multi-VGA output support: DisplayPort/HDMI port

Supports DisplayPort 1.1a with max. resolution of 2560 x 1600
@60Hz

Supports HDMI 1.4a with max. resolution of 1920 x 1200 @60Hz
Supports Intel®InTru™ 3D/Quick Sync Video/Clear Video HD
Technology/Insider™

Supports NVIDIA® Quad-GPU SLI™ Technology (with 2 PClex16
graphics card)

Supports AMD® 3-Way/Quad-GPU CrossFireX™ Technology
(with 2 PClex16 graphics card)

Supports Lucidlogix Virtu MVP Technology*

*LucidLogix Virtu MVP supports Windows® 7 operating systems.

(continued on the next page)
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Storage

Wireless Data Network

Bluetooth

Intel® Z77 Express Chipset

- 2 X SATA 6.0 Gbl/s ports (gray) with RAID 0, 1, 5, 10 support

- 4 x SATA 3.0 Gbl/s ports (blue) with RAID 0, 1, 5, 10 support

- Supports Intel® Smart Response Technology, Intel® Rapid Start
Technology, Intel® Smart Connect Technology*

Marvell® 9128 PCle SATA 6Gb/s controller

- 2 X SATA 6Gb/s ports (navy blue) with RAID 0, 1 support

ASMedia® SATA 6Gb/s controller**
- 2xeSATA 6Gb/s ports
* Supports on Intel® Core™ processor family with Windows® 7
operating systems.
** These SATA ports are for data hard drives only. ATAPI
devices are not supported.

Dual Gigabit LAN controllers—802.3az Energy Efficient Ethernet
(EEE) appliance

Intel® 82579V Gigabit LAN controller—Dual interconnect between
the Integrated LAN controller and Physical Layer (PHY)

Realtek® 8111F Gigabit LAN controller

Wi-Fi 802.11 a/b/g/n supports dual frequency band 2.4/5 GHz
ASUS Wi-Fi GO! Utility

Bluetooth v4.0
Bluetooth v3.0 + HS

Realtek® ALC898 8-channel high definition audio CODEC
- Absolute Pitch 192khz/24bit True BD Lossless Sound
- BD audio layer content protection
- DTS UltraPC I
- DTS Connect
- Supports jack-detection, multi-streaming and front panel
jack-retasking
- Optical S/PDIF out ports at back I/0

2 x ASMedia® USB 3.0 controllers - supports ASUS USB 3.0
Boost UASP Mode
- 4 xUSB 3.0/2.0 ports at back panel (blue)
Intel® Z77 Express Chipset - supports ASUS USB 3.0 Boost
Turbo Mode*
- 2xUSB 3.0/2.0 ports at mid-board for front panel support
- 2xUSB 3.0/2.0 ports at back panel (blue)
Intel® Z77 Express Chipset
- 8xUSB 2.0/1.1 ports (4 ports at mid-board, 4 ports at back
panel)
*The USB 3.0 ports only support Windows® 7 or later
versions. UASP standard only supports Windows® 8.

(continued on the next page)
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ASUS unique features ASUS Dual Intelligent Processors 3 - SMART DIGI+ Power
Control
Smart DIGI+:

- Smart DIGI+ Key - quickly delivers a higher VRM
frequency, voltage, and current for superior CPU/iGPU/
DRAM overclocking performance with one switch.

- Smart CPU Power Level (VRD 12.5 Ready) - provides
the best digital power saving conditions.

CPU Power

- Industry leading digital 20-phase power design (16-phase
for CPU, 4-phase for iGPU)

- ASUS CPU power utility

DRAM Power
- Industry leading digital 2-phase DRAM power design
- ASUS DRAM power utility

ASUS EPU
- EPU, EPU switch

ASUS TPU
- Auto Tuning, TurboV, GPU Boost, TPU switch

ASUS Wi-Fi GO!:

- Wi-Fi GO! Function: DLNA Media Hub, Smart Motion
Control, Remote Desktop, Remote Keyboard & Mouse,
File Transfer, Capture & Send (available with VV1.01.00 or
later)

- Wi-Fi GO! Remote for portable Smartphone/Tablet
supporting iOS 3.2 or later, and Android 2.3 or later
systems.

- Wi-Fi Engine for network sharing and connection: Client
Mode and AP Mode.

ASUS Exclusive Features:

- Network iControl featuring instant network bandwidth
domination for top network program in use.

- ASUS SSD Caching

- USB 3.0 Boost featuring the latest USB 3.0 UASP standard

- USB Charger+ featuring quick-charging function for all
smart devices.

- Al Charger+

- Disk Unlocker featuring 3TB+ HDD support

- Al Suite Il

- Anti Surge

- MemOK!

(continued on the next page)
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ASUS unique features ASUS Quiet Thermal Solution:

- ASUS Fan Xpert 2 featuring Fan Auto Tuning function for
optimized speed control
- ASUS Fanless Design: Heat-pipe solution

ASUS EZ DIY:

- ASUS USB BIOS Flashback with USB BIOS Flashback
Wizard for EZ BIOS download scheduling

- ASUS UEFI BIOS EZ Mode featuring friendly graphics user
interface

- ASUS O.C. Tuner

- ASUS CrashFree BIOS 3

- ASUS EZ Flash 2

ASUS Q-Design:
- ASUS Q-Code
- ASUS Q-Shield
- ASUS Q-LED (CPU, DRAM, VGA, Boot Device LED)
- ASUS Q-Slot
- ASUS Q-DIMM
- ASUS Q-Connector

ASUS exclusive Precision Tweaker 2:

overclocking features - vCore: Adjustable CPU voltage at 0.005V increment

- VCCIO: Adjustable I/0 voltage at 0.00625V increment
- VCCSA: 144-step system agent voltage control

- vDRAM Bus: 160-step Memory voltage control

- vPCH: 90-step Chipset voltage control

- iGPU: 255-step iGPU voltage control

- VCPU_PLL: 160-step CPU & PCH PLL voltage control

SFS (Stepless Frequency Selection):
- BCLK/PCIE frequency tuning from 80MHz up to 300MHz at
0.1MHz increment

Overclocking Protection:
- ASUS C.P.R.(CPU Parameter Recall)

Back Panel I/O Ports 1 x DisplayPort

1 x HDMI port

1 x BT4 connector for ASUS Wi-Fi GO! cad (Wi-Fi 802.11 a/b/g/n
and Bluetooth v4.0/3.0+HS)

1 x Optical S/PDIF Out port

2 x eSATA ports

2 x LAN (RJ-45) ports (1 x Intel® LAN)

6 x USB 3.0/2.0 ports (blue, 1 supports USB BIOS Flashback)
4 x USB 2.0/1.1 ports

1 x USB BIOS Flashback button

8-channel Audio I/O ports

(continued on the next page)
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Internal 1/0 connectors 1 x USB 3.0/2.0 connector supports additional 2 USB ports (19-pin)
2 x USB 2.0/1.1 connectors support additional 4 USB ports
4 x SATA 6.0 Gb/s connectors (2 x gray; 2 x navy blue)

4 x SATA 3.0 Gb/s connectors (blue)

1 x CPU Fan connector (4-pin)

1 x CPU Optional Fan connector (4-pin)

4 x Chassis Fan connectors (4-pin)

Front panel audio connector (AAFP)

1 x S/IPDIF out header

24-pin EATX Power connector

8-pin EATX 12V Power connector

System Panel (Q-Connector)

1 x MemOK! button

1 x Clear CMOS button

1 x EPU switch

1 x TPU switch

1 x Power-on switch

1 x Reset switch

BIOS features 64 Mb Flash ROM, UEFI AMI BIOS, PnP, DMI 2.0, WfM 2.0,
SM BIOS 2.5, ACPI 2.0a, Multi-language BIOS,

ASUS EZ Flash 2, ASUS CrashFree BIOS 3, F12 PrintScreen
function, F3 Shortcut function, and ASUS DRAM SPD (Serial

Presence Detect) memory information

Manageability WfM 2.0, DMI 2.0, WOL by PME, PXE

Support DVD contents Drivers

ASUS Utilities

ASUS Update

Anti-virus software (OEM version)

Form factor ATX form factor: 12 in. x 9.6 in. (30.5 cm x 24.4 cm)

*Specifications are subject to change without notice.
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1.1 Welcome!
Thank you for buying an ASUS® P8Z77-V DELUXE motherboard!

The motherboard delivers a host of new features and latest technologies, making it another
standout in the long line of ASUS quality motherboards!

Before you start installing the motherboard, and hardware devices on it, check the items in
your package with the list below.

1.2 Package contents

Check your motherboard package for the following items.

C2)

User manual Support DVD

N

1 x ASUS SLI™ bridge
connector

ASUS P8Z77-V DELUXE
motherboard

1 x ASUS Wi-Fi GO! card
1 x ASUS Q-Shield (Wi-Fi 802.11 a/b/g/n and 1x 2-in-1 ASUS Q-Connector kit
Bluetooth v4.0/3.0+HS)

2 x Wi-Fi Ring moving
antennas

« Ifany of the above items is damaged or missing, contact your retailer.

- +  Theillustrated items above are for reference only. Actual product specifications may
vary with different models.

ASUS P8Z77-V DELUXE 11
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1.3 Special features
131 Product highlights

LGA1155 socket for Intel® Second/Third Generation Core™ {7 / Core™
i5/Core™ i3/ Pentium®/ Celeron®Processors

This motherboard supports the Intel® 3rd/2nd generation Core™ i7/i5/i3/Pentium®Celeron®
processors in the LGA1155 package, with iGPU, memory, and PCI Express controllers
integrated to support onboard graphics out with dedicated chipsets, 2-channel (4 DIMMs)
DDR3 memory, and 16 PCI Express 3.0/2.0 lanes. This provides great graphics performance.
Intel® 3rd/2nd generation Core™ i7/i5/i3/Pentium®/Celeron® processors are among the most
powerful and energy efficient CPUs in the world.

Intel® Z77 Express Chipset

The Intel® Z77 Express Chipset is a single-chipset designed to support the 1155 socket Intel®
3rd/2nd generation Core™ i7/i5/ i3/Pentium®/Celeron® processors. It provides improved
performance by utilizing serial point-to-point links, allowing increased bandwidth and stability.
Additionally, Z77 chipset provides 4 USB 3.0 ports for 10 times faster data retrieval speed.
Moreover, Intel® Z77 Express Chipset can also enable iGPU function, letting users enjoy the
latest Intel® integrated graphic performance.

PCl Express® 3.0

PCI Express®3.0 (PCle 3.0) is the latest PCI Express bus standard with improved encoding
schemes that provide twice the performance of the current PCle 2.0. The total bandwidth

for a x16 link reaches a maximum of 32Gb/s, double the 16Gb/s of PCle 2.0 (in x16 mode).
As such, PCle 3.0 provides users an unprecedented data speeds, combined with the
convenience and seamless transition offered by complete backward compatibility with PCle
1.0 and PCle 2.0 devices. PCle 3.0 will become a must-have feature for users who wish to
improve and optimize graphic performance, as well as have the latest technology available to
them.

*PCl 3.0 speed is supported by Intel® 3rd generation Core™ processors.

Dual-Channel DDR3 2600(0.C.) / 2400(0.C.) / 2200(0.C.) / 2133(0.C.) /
1866(0.C.) / 1600 / 1333 / 1066 MHz Support

The motherboard supports DDR3 memory that features data transfer rates of DDR3
2600(0.C.) / 2400(0.C.) / 2200(0.C.) / 2133(0.C.) / 1866(0.C.) / 1600 / 1333 / 1066 MHz to
meet the higher bandwidth requirements of the latest 3D graphics, multimedia, and Internet
applications. The dual-channel DDR3 architecture enlarges the bandwidth of your system
memory to boost system performance.

*Due to Intel 2nd generation processor’s behavior, DDR3 2200 and above, 2000/1800 MHz memory
modules run at DDR3 2133/1866/1600 MHz frequency as default.

Chapter 1: Product Introduction



Quad-GPU SLI™ and Quad-GPU CrossFireX™ Support

Flexible Multi-GPU Solutions, Your Weapon of Choice!

P8Z77-V DELUXE brings you the multi-GPU choice of either SLI™ or CrossFireX. The
motherboard features the most powerful Intel® Z77 platform to optimize PCle allocation in
multiple GPU configurations. Expect a brand-new gaming style you've never experienced
before!

Intel® Smart Response Technology

i
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O

SSD Speed with HDD Capacity

Intel® Smart Response Technology boosts overall system performance. It uses an installed
fast SSD (min 18.6GB available capacity required) as a cache for frequently accessed data.
Key benefits include reduced load and wait times, and lower power consumption through the
elimination of unnecessary hard drive spin. This technology combines SSD performance with
hard drive capacity, operating up to 6X faster than a hard drive-only system, and an important
part of Green ASUS eco-friendly computing.

* Intel® Smart Response Technology is supported by 2nd/3rd generation Intel® Core™ processor
family on Windows® 7™ operating systems.

** Operating systems must be installed on the HDD to launch Intel® Smart Response Technology.
The capacity of the SSD is reserved for caching function.

Intel® Smart Connect Technology
Your computer can receive web updates with fresh content for selected applications, even

when the system is in sleep mode. This means less time waiting for applications to update,
and sync with the cloud, leading to a more efficient computing experience.

Intel® Rapid Start Technology

Allows your computer to quickly resume from a low-power hibernate state in seconds. Saving
system memory to the designed SSD, it provides your computer a faster wake-up response
time, while still keeping the energy use low.

Complete USB 3.0 Integration

ASUS facilitates the strategic USB 3.0 accessibility for both the front and rear panel — 8 USB
3.0 ports in total. Experience the latest plug & play connectivity at speeds up to 10 times
faster than USB 2.0. The P8Z77-V DELUXE affords greater convenience to high speed
connectivity.

Extra SATA 6.0 Gb/s Support

The Intel® Z77 Express Chipset natively supports the next-generation Serial ATA (SATA)
interface, delivering up to 6.0 Gb/s data transfer. ASUS provides extra SATA 6.0 Gb/s ports
with enhanced scalability, faster data retrieval, and double the bandwidth of current bus
systems.

Dual Gigabit LAN support

The P8277-V DELUXE features the dual Gigabit LAN design which complies with 802.3az
Energy Efficient Ethernet (EEE) standard, and allows a PC to serve as a network gateway
for managing traffic between two separate networks. Moreover, this motherboard also
implements one Intel® Gigabit LAN controller which reduces power consumption during

ASUS P8Z77-V DELUXE 1-3
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normal operation, and enhances faster transfer speed through a dual interconnection
between the Integrated LAN controller and physical layer (PHY).

13.2 Dual Intelligent Processors 3.1 with New DIGI+ Power
Control

The world’s first Dual Intelligent Processors from ASUS pioneered twin onboard chips - TPU
(TurboV Processing Unit) and EPU (Energy Processing Unit). Dual Intelligent Processors

3 builds on that foundation with new SMART DIGI+ power control, which includes multiple
digital voltage controllers, allowing ultra-precise tuning for the CPU, iGPU and DRAM. It's
upgraded with one-click extreme performance optimization and selectable CPU wattage
levels, offering easier power control and better power savings with the user-friendly Al Suite
1 utility.

Smart DIGI+ Technology
Get incredible performance increases with TPU and the all-new SMART DIGI+.

Up to 85% CPU O.C. Performance Boost

Always at the forefront of digital power design, ASUS propels you into the future
standard of power management by SMART DIGI+ Technology, which works with the
TPU (TurboV Processing Unit) to give an exceptional increase in CPU overclocking
performance. When combined, you can adjust CPU ratios manually in the TPU and
enable the all new SMART DIGI+ Key by a single click to see an extreme boost in TPU
frequency up to 85%.

CPU Power Wattage cut in half!

SMART DIG+ Technology also includes the Smart CPU Power Level profile, which
reduces CPU power consumption to a specific indicated wattage with a single click,
creating a cooler and quieter PC. With the support for the next generation Intel® VRD
12.5 power design, ASUS once again leaps to the future of innovation.

TPU

Unleash your performance with ASUS’ simple onboard switch or Al Suite Il utility. The TPU
chip offers precise voltage control and advanced monitoring through Auto Tuning and TurboV
functions. Auto tuning offers a user friendly way to automatically optimize the system for fast,
yet stable clock speeds, while TurboV enables unlimited freedom to adjust CPU frequencies
and ratios for optimized performance in diverse situations.

EPU

Tap into the world’s first real-time PC power saving chip through a simple onboard switch or
Al Suite I utility. Get total system-wide energy optimization by automatically detecting current
PC loadings and intelligently moderating power consumption. This also reduces fan noise
and extends component longevity.

Chapter 1: Product Introduction



1.3.3 ASUS Exclusive Features

Wi-Fi GO!

ASUS Wi-Fi GO! makes enjoying home entertainment easier than ever! Exclusive Wi-Fi
functions provide DLNA streaming so you can enjoy a home theater PC, while providing
remote access to your PC with a smart device. ASUS Wi-Fi GO! leads the market by
integrating Wi-Fi connectivity, DLNA access, and all smart devices with a one-stop utility for a
futuristic connected lifestyle.

Wi-Fi hotspot setup for convenience:

Quickly set up and connect anywhere at home, thanks to instant soft access point and device
detection. Build your network without an extra router!

Turn smartphones and tablets into a remote control:

1. Remote Desktop - access your PC from a tablet? No sweat! Control your PC in
real-time from a mobile device for complete comfort. This function brings notebook-like
convenience by creating a virtual remote desktop, offering portable access to your data
in desktop with a smartphone or pad.

2. Motion control your PC - entertaining ang customizable! Using natural gestures, you

can move directionally to use applications with a smartphone or tablet's motion sensors.

For example, in media players you can fast forward, go next, stop or create a music
playing motion control profile. You can even set program sensor scenarios to design
your own motion-based game!

3. Remote keyboard and mouse - sit back and control your computer by using your
tablet's built-in QWERTY keyboard to type and click!

DLNA streaming made easy:

Enjoy HD content, music anf photos from the PC on your DLNA devices via Wi-Fi
connectivity, the perfect match for creating your own home theater!

Easy file and screenshot transfers:

Send and share files and screenshots from your PC to your smart devices directly with a
touch over Wi-Fi.

GPU Boost

GPU Boost accelerates the integrated GPU for extreme graphics performance. The user-
friendly interface facilitates flexible frequency adjustments. It easily delivers stable system-
level upgrades for every use.

USB 3.0 Boost

New ASUS USB 3.0 Boost technology supports UASP (USB Attached SCSI Protocol), the
latest USB 3.0 standard. Witht USB 3.0 Boost technology, a USB device’s transmission
speed is significantly increased up to 170%, adding to an already impressive fast USB 3.0
transfer speed. ASUS software automatically accelerates data speeds for compatible USB
3.0 peripherals without the need for any user interaction.

ASUS P8Z77-V DELUXE
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USB Charger+

With a dedicated onboard controller, quick-charge all your smart devices such as iProducts,
smartphones, tablets, and more, all up to 3x faster, even when the PC is powered off, in
sleep, or hibernation modes.

ASUS SSD Caching

SSD Caching from ASUS is easier than ever. At 3X faster, this feature boosts system
performance by using an installed SSD with no capacity limitations as a cache for frequently
accessed data. Harness a combination of SSD-like performance and response, and hard
drive capacity with just one click, no rebooting needed, and instant activation for complete
ease of use, and even prevent data loss with included backup functionality.

USB BIOS Flashback

Atruly revolutionary hardware-based BIOS update solution. USB BIOS Flashback offers

the most convenient way to update the BIOS! It allows users to update new UEFI BIOS
versions even without hardware such as a CPU or a DRAM installed into the motherboard.
Just plug in a USB flash drive containing the BIOS file, and press the BIOS Flashback button
for 3 seconds with the power supply connected. The UEFI BIOS then automatically updates
without requiring further interaction. With its new complementary Windows® application, users
can regularly check for UEFI BIOS updates, and download the latest BIOS automatically.
Hassle-free updating for the ultimate convenience!

Network iControl

With a single-click on/off button, the application currently in use has its data and network
bandwidth prioritized over other programs. Moreover, you can prioritize your favorite software
easily by configuring profiles through the intuitive user interface. Within the profile, the
programs can be pre-scheduled to run in a specific time period to avoid network congestion.
and long-waits on downloads. Auto PPPOE network connection gives a one-step setup.
Overall, it's an intuitive network bandwidth control center.

Al Suite |l

With its user-friendly interface, ASUS Al Suite Il consolidates all the exclusive ASUS features
into one simple to use software package. It allows you to supervise overclocking, energy
management, fan speed control, voltage and sensor readings, and even interact with mobile
devices via Wi-Fi. This all-in-one software offers diverse and ease to use functions, with no
need to switch back and forth between different utilities.

MemOK!

Any Memory is A-OK!

MemOK! quickly ensures memory boot compatibility. This remarkable memory rescue tool
regires a mere push of a button to patch memory issues. MemOK! determines fail-safe
s/ '\s and dramatically improves your system boot success. Get your system up and
furimmy in no time!
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1.34 ASUS Quiet Thermal Solution

ASUS Fan Xpert 2 - featuring Fan Auto Tuning mode for the Ultimate
Cool and Quiet

Hardware-level ASUS Fan Xpert 2 provides the most customizable settings for an even
cooler and quieter computing environment. Upgraded with the Fan Auto Tuning mode, it
enables tailored fan speed settings for each CPU and chassis fan, with exclusive automatic
fan speed detection, which scans each fan to run at specific settings based on different
criteria, achieving the best balance of cooling performance and low noise. Fan Xpert 2 also
includes an RPM Fixed Mode for users who wish to reduce noise levels to near 0dB with
highly specific fan speed control. It reacts to system loads for greater control.

ASUS Fanless Design—Heat-pipe solution

The ASUS heat-pipe features 0-dB thermal solution that offers you a noiseless PC
environment. Not only the beautiful shape upgrades the visual enjoyment for motherboard
users, but also the heat-pipe design lowers the temperature of the chipset and power phase
area through high efficient heat-exchange. Combined with usability and aesthetics, the ASUS
heat-pipe gives you an extremely silent and cooling experience with its elegant appearance.

DO NOT uninstall the heat-pipe by yourself. Doing so may bend the tubing and affect the
heat dissipation performance.

135 ASUS EZ DIY

ASUS UEFI BIOS (EZ Mode)

Flexible and Easy BIOS Interface

Media-renowned UEFI BIOS offers the first mouse-controlled graphical BIOS designed
with selectable modes and native support for hard drives over 2.2 TB. Users can also drag
and drop boot priorities with the exclusive EZ Mode, while Advanced Mode offers inticrate
settings.

New upgrade! Quick and easy information for enhanced system control
- F12 BIOS snapshot hotkey
F3 Shortcut for most accessed information
ASUS DRAM SPD (Serial Presence Detect) information detecting faulty DIMMs, and
helping with difficult POST situations.

ASUS P8Z77-V DELUXE
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ASUS Q-Design

DIY Quickly, DIY Easily!
ASUS Q-Design enhances your DIY experience. All of Q-LED, Q-Code, Q-Slot, and Q-DIMM
design speed up and simplify the DIY process!

ASUS Q-Shield

Easy and Comfortable Installations

The specially designed ASUS Q-Shield does without the usual "fingers" - making it
convenient and easy to install. With better electric conductivity, it ideally protects your
motherboard against static electricity and shields it against Electronic Magnetic Interference
(EMI).

ASUS Q-Connector

Make Connection Quick and Accurate!

The ASUS Q-Connector allows you to connect or disconnect the chassis front panel cables
in one easy step with one complete module. This unique adapter eliminates the trouble of
plugging in one cable at a time, making the connection quick and accurate.

ASUS EZ-Flash 2

ASUS EZ Flash 2 is a user-friendly utility that allows you to update the BIOS without using a
bootable floppy disk or an OS-based utility.

1.3.6 Other special features

LucidLogix Virtu MVP

LucidLogix Virtu MVP featuring HyperFormance™ Technology boosts your discrete graphics

card up to 30% beyond its original performance. Designed for Intel® processor graphics and

Windows® 7 PCs, it perfectly combines the performance of discrete graphic cards with fast

computing iGPU. Also, with newly designed Virtual Sync, users can enjoy a smoother gaming

experience by eliminating tearing artifacts. LucidLogix Virtu MVP can also dynamically assign

tasks to the best available graphics resource, based on power, performance, and system

load. This allows users to fully utilize 3x faster video conversion with Intel® Quick Sync Video

2.0 technology while retaining high-end 3D rendering and gaming performance, provided

by both NVIDIA and AMD graphic cards. When the discrete graphic cards are not required,

it puts the power use down to zero, making the system more environmentally friendly. For

users searching for perfection, LucidLogix Virtu MVP provides great graphical performance,

and best flexibility and efficiency.

* LucidLogix Virtu MVP supports Windows® 7 operating system.

** Intel® Quick Sync Video feature is supported by 3rd/2nd generation Intel® Core™ processor
family

DisplayPort 1.1a Support

DisplayPort is a digital display interface standard that delivers up to 10.8 Gbps of bandwidth

over standard cables, providing hillions of colors and bi-directional communications, thus

enabling the fastest refresh rates, and the highest resolution digital display through a single

cable. Also, it supports HDCP copy protection for Blu-ray discs. Simply output 3D signals

through the connected DisplayPort 1.1a cable with your 3D display, then you can sit back and

enjoy a perfect 3D animation experience.

Chapter 1: Product Introduction



HDMI 1.4a Support

High Definition Multimedia Surface (HDMI) is a set of digital video standards that delivers
mulit-channel audio and uncompressed digital video for full HD 1080p visuals through a
single cable. Supporting HDCP copy protection such as HD DVD and blu-ray discs, HDMI
provides you with the highest quality home theater experience.

DTS UltraPC Il

DTS UltraPC Il delivers an exceptional 7.1 surround experience through the most popular PC
audio setups—your existing stereo speakers or headphones. In addition to virtual surround,
it upgrades the original sound to new levels with Audio Restoration, recreating dynamic
range of audio files. Symmetry mode improves the balance of perceived loudness across
different input sources, and enhances boost audio quality through high hand low frequency
equalization. With these technologies, users experience better home theater audio with ease.

DTS Connect

Expand Your PC Audio Experience

To get the most out of your audio entertainment across all formats and quality levels, DTS
Connect combines two enabling technologies, DTS Neo:PC™ upmixes stereo sources (CDs,
MP3s, WMAs, internet radio) into as many as 7.1 channels of incredible surround sound.
Consumers can connect their PC to a home theater system. DTS Interactive is capable of
performing mult-channel encoding of DTS bitstreams on personal computers, and sending
encoded bitstreams out of a digital audio connection (such as S/PDIF or HDMI) designed to
deliver audio to an external decoder.

ErP Ready

The motherboard is European Union’s Energy-related Products (ErP) ready, and ErP requires
products to meet certain energy efficiency requirement in regards to energy consumptions.
This is in line with ASUS vision of creating environment-friendly and energy-efficient products
through product design and innovation to reduce carbon footprint of the product and thus
mitigate environmental impacts.

ASUS P8Z77-V DELUXE
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2.1 Before you proceed

Take note of the following precautions before you install motherboard components or change
any motherboard settings.

& *  Unplug the power cord from the wall socket before touching any component.

«  Before handling components, use a grounded wrist strap or touch a safely grounded
object or a metal object, such as the power supply case, to avoid damaging them due
to static electricity.

¢ Hold components by the edges to avoid touching the ICs on them.

*  Whenever you uninstall any component, place it on a grounded antistatic pad or in the
bag that came with the component.

«  Before you install or remove any component, ensure that the ATX power supply is
switched off or the power cord is detached from the power supply. Failure to do so
may cause severe damage to the motherboard, peripherals, or components.

ASUS P8Z77-V DELUXE
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2.2

22.1 Motherboard layout

Motherboard overview
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Refer to 2.2.7 Internal connectors and 2.3.10 Rear panel connection for more
information about rear panel connectors and internal connectors.
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Layout contents

Connectors/Jumpers/Slots Page

1. ATX power connectors (24-pin EATXPWR, 8-pin EATX12V) 2-34
2. LGA1155 CPU socket 2-4
3. CPU, chassis, and power fan connectors (4-pin CPU_FAN, 2-32
4-pin CPU_OPT, 4-pin CHA_FAN1-4)
4. DDR3 DIMM slots 2-5
5. MemOK! switch 2-17
6. TPU switch 2-18
7. USB 3.0 connector (20-1 pin USB3_12) 2-30
8. Marvell® Serial ATA 6.0 Gb/s connectors 2-29
(7-pin SATA6G_E1/E2 [navy blue])
9. Intel® Z77 Serial ATA 6.0 Gb/s connectors 2-27
(7-pin SATA6G_1/2 [gray])
10. Intel® Z77 Serial ATA 3.0 Gb/s connectors 2-28
(7-pin SATA3G_3-6 [blue])
11. System panel connector (20-8 pin PANEL) 2-34
12. Q-Code LED (LED1, LED2) 2-23
13. USB 2.0 connectors (10-1 pin USB1314, USB1112) 2-29
14. Clear CMOS button 2-20
15. Reset switch 2-16
16. Power-on switch 2-16
17. EPU switch 2-19
18. Front panel audio connector (10-1 pin AAFP) 2-35
19. Digital audio connector (4-1 pin SPDIF_OUT) 2-31
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Central Processing Unit (CPU)

The motherboard comes with a surface mount LGA1155 socket designed for the Intel®
3rd/2nd Generation Core™ i7 / Core™ i5 / Core™ i3 / Pentium / Celeron Processors.
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Ensure that all power cables are unplugged before installing the CPU.

*  The LGA1156 CPU is incompatible with the LGA1155 socket. DO NOT install a
LGA1156 CPU on the LGA1155 socket.

*  Upon purchase of the motherboard, ensure that the PnP cap is on the socket and
the socket contacts are not bent. Contact your retailer immediately if the PnP cap
is missing, or if you see any damage to the PnP cap/socket contacts/motherboard
components. ASUS will shoulder the cost of repair only if the damage is shipment/
transit-related.

*  Keep the cap after installing the motherboard. ASUS will process Return Merchandise
Authorization (RMA) requests only if the motherboard comes with the cap on the
LGA1155 socket.

»  The product warranty does not cover damage to the socket contacts resulting from
incorrect CPU installation/removal, or misplacement/loss/incorrect removal of the PnP
cap.
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2.2.3 System memory
The motherboard comes with four Double Data Rate 3 (DDR3) Dual Inline Memory Modules
(DIMM) slots.

/i ' E A DDR3 module is notched differently from a DDR or DDR2 module. DO NOT install a DDR
° or DDR2 memory module to the DDR3 slot.

DIMM_A1
DIMM_A2
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P8Z77-V DELUXE 240-pin DDR3 DIMM socket

Recommended memory configurations
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Memory configurations

You may install 1GB, 2GB, 4GB and 8GB unbuffered and non-ECC DDR3 DIMMs into the
DIMM sockets.

R *  You may install varying memory sizes in Channel A and Channel B. The system maps
the total size of the lower-sized channel for the dual-channel configuration. Any excess
memory from the higher-sized channel is then mapped for single-channel operation.

. Due to Intel® 2nd generation processors' behavior, DDR3 2200 and above, 2000/1800
MHz memory module will run at DDR3 2133/1866/1600 MHz frequency as default.

*  According to Intel CPU spec, DIMM voltage below 1.65V is recommended to protect
the CPU.

*  Always install DIMMs with the same CAS latency. For optimum compatibility, we
recommend that you obtain memory modules from the same vendor.

*  Due to the memory address limitation on 32-bit Windows OS, when you install 4GB

or more memory on the motherboard, the actual usable memory for the OS can be

about 3GB or less. For effective use of memory, we recommend that you do any of the

following:

- Use a maximum of 3GB system memory if you are using a 32-bit Windows OS.

- Install a 64-bit Windows OS when you want to install 4GB or more on the
motherboard.
For more details, refer to the Microsoft® support site at
http:/support.microsoft.com/kb/929605/en-us.
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*  This motherboard does not support DIMMs made up of 512Mb (64MB) chips or less
(Memory chip capacity counts in Megabit, 8 Megabit/Mb = 1 Megabyte/MB).

*  The default memory operation frequency is dependent on its Serial Presence Detect
(SPD), which is the standard way of accessing information from a memory module.
Under the default state, some memory modules for overclocking may operate at a
lower frequency than the vendor-marked value. To operate at the vendor-marked
or at a higher frequency, refer to section 3.4 Ai Tweaker menu for manual memory
frequency adjustment.

For system stability, use a more efficient memory cooling system to support a full
memory load (4 DIMMs) or overclocking condition.

P8Z77-V DELUXE Motherboard Qualified Vendors Lists (QVL)
DDR3 2600(0.C.) MHz capability

SS/ Chip  Chip DIMM socket support (Optional)
1DIMM 2DIMM 4 DIMM

Vendors  Part No. DS Brand NO. Timing Voltage

G.skil | F3-20800CL10-16GBZMD(XMP) | 16GB(4x4GB) DS - |10-12-12-28 | 1.65
Jream | TXD38192M2600HC10QDC-L(XMP) | 16GB(4x4GB) |DS | | |10-12-12-31 (165 |+ | | |
=== Q0CLC =

* The 2600MHz memory modules above are supported on Intel® 3rd generation processors by this
motherboard; however, the actual frequency support varied depending on the O.C. margin of the
installed CPU.

** Due to Intel 2nd generation processors' behavior, DDR3 2200 and above/2000/1800 MHz memory

module runs ay DDR3 2133/1866/1600 MHz frequency as default.
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P8Z77-V DELUXE Motherboard Qualified Vendors Lists (QVL)
DDR3 2500(0.C.) MHz capability

DIMM socket support
SS/ Chip - Chip Timing Voltage (Optional)

DS Brand NO.
1DIMM 2DIMM 4 DIMM
G.Skill \F3-200000L_10Q-1GGBZHD(><MP) | 16GB(4x4GB) | DS |- [- ‘10-L—11—31‘1.65 B . .
* The 2500MHz memory modules above are supported on Intel® 3rd generation processors by this
motherboard; however, the actual frequency support varied depending on the O.C. margin of the
installed CPU.

** Due to Intel 2nd generation processors' behavior, DDR3 2200 and above/2000/1800 MHz memory
module runs ay DDR3 2133/1866/1600 MHz frequency as default.

P8Z77-V DELUXE Motherboard Qualified Vendors Lists (QVL)
DDR3 2400(0.C.) MHz capability

Vendors  Part No.

DIMM socket support

SS/ Chip  Chip Timing Voltage (Optional)

Vendors Part No. Size

DS Brand NO.
1DIMM 2DIMM 4 DIMM
CORSAIR | CMGTX8(XMP) 8GB(4x2GB) |SS |- - 10-12-10-30 |1.65
CORSAIR | CMGTX3(XMP) 2GB DS |- - 9-11-9-27 1.65 N
G.skill F3-19200CL11Q-16GBZHD(XMP) | 16GB(4x4GB) DS |- - 11-11-11-31 | 1.65 —
G. Skill F3-19200CL9Q-16GBZMD(XMP) | 16GB(4x4GB) |DS |- - 9-11-11-31 1.65 GJ
G.SKILL F3-19200CLID-4GBPIS(XMP) 4G(2x2G) DS |- - 9-11-9-28 1.65 a
GEIL GOC316GB2400C10QC(XMP) 16GB(4x4GB) DS |- - 10-11-11-30 | 1.65 CG
GEIL GOC316GB2400C11QC(XMP) 16GB(4x4GB) | DS |- - 11-11-11-30 | 1.65 :
Kingston KHX2400C11D3K4/8GX(XMP) 8GB(4x2GB) |SS |- - 11-13-11-30 | 1.65 o
Transcend | TX2400KLU-4GK (381850)(XMP) | 2GB DS |- - 1.65
Transcend | TX2400KLU-4GK(374243)(XMP) | 2GB DS |- - - 1.65

* The 2400MHz memory modules above are supported on Intel® 3rd generation processors by this
motherboard; however, the actual frequency support varied depending on the O.C. margin of the
installed CPU.

** Due to Intel 2nd generation processors' behavior, DDR3 2200 and above/2000/1800 MHz memory

module runs ay DDR3 2133/1866/1600 MHz frequency as default.

P8Z77-V DELUXE Motherboard Qualified Vendors Lists (QVL)
DDR3 2200(0.C.) MHz capability

DIMM socket support
Timing Voltage (Optional)
1DIMM 2DIMM 4 DIMM

S8/ Chip Chip

Vendors Part No. Size DS Brand NO.

G.SKILL F3-17600CL7D-4GBFLS(XMP)  |4G(2x2G) DS |- - 7-10-10-28 | 1.65
G.SKILL F3-17600CL8D-4GBPS(XMP) 4GB(2x2GB) | DS |- - 8-8-8-24 165
GEIL GET34GB2200C9DC(XMP) 4GB(2x2GB) DS |- - 9-10-9-28 | 1.65
GEIL GET38GB2200C9ADC(XMP) 8GB(2x4GB) | DS |- - 9-11-9-28 |1.65
KINGMAX | FLKE8SF-B8KHA(XMP) 4G(2x2G) DS -

- - 15-1.7
KINGMAX FLKESF-BBKJAA-FEIS(XMP) 4GB(2x2GB) DS Kingmax N/A -

* The memory modules in 2200MHz and above are supported on Intel® 3rd generation processors
by this motherboard; however, the actual frequency support varies depending on the O.C. margin
of the installed CPU.

** Due to Intel 2nd generation processors' behavior, DDR3 2200 and above/2000/1800 MHz memory

module runs ay DDR3 2133/1866/1600 MHz frequency as default.

ASUS P8Z77-V DELUXE 2-7



Z Jerdeyd

2-8

P8Z77-V DELUXE Motherboard Qualified Vendors Lists (QVL)
DDR3 2133(0.C.) MHz capability

Vendors

Part No.

Chip
NO.

Timing Voltage

DIMM socket support

1DIMM

(Optional)
2DIMM 4 DIMM

A-DATA | 8154A 1044(XMP) 2GB ss |- - 99924 155175 |« . .
[A-DATA | AX3U2133C2G9B(XMP) 2GB ss |- - 9-11-9-27 |155~1.75 |+ .

A-DATA | AX3U2133GC2GIB(XMP) 2GB ss |- - 99924 155175 |« .

|Apacer 78.BAGE4.AFDOC(XMP) 8GB(2x4GB) (DS |- . 9-99-24 |- . . .
CORSAIR | CMT4GX3M2A2133C9(XMP) 4GB(2x2GB) (DS |- - 9-10-9-24 | 165 . .

CORSAIR | CMT4GX3M2B2133C9(Ver7.1)(XMP) | 4GB(2x2GB) |DS |- - 99924 |15 . . .
CORSAIR | CMT4GX3M2B2133C9(XMP) 4GB(2x2GB) |DS |- . 9-10-9-27 |15 . . .
G.SKILL  |F3-17000CL9Q-16GBXLD(XMP) | 16GB(4x4GB) [DS |- - 9-11-9-28 |165 . . .
G.SKILL | F3-17066CL9Q-16GBTDD(XMP) | 16GB(4x4GB) |DS |- - 99924 165 . .
G.SKILL | F3-17066CLID-8GBPID(XMP) 8GB(24GB) (DS |- - 9-9-9-24 165 . . .
GEIL GE34GB2133CIDC(XMP) 4GB(2x2GB) (DS |- - 99928 | 165 . . .
KINGSTON |KHX2133CIAD3TIK2/4GX(XMP)  |4GB(2x2GB) (DS |- - - 165 . .

KINGSTON |KHX2133C9AD3TIK2/AGX(XMP)  |4GB(2x2GB) (DS |- - 9 1.65 . . .
KINGSTON | KHX2133C9AD3WIK2/4GX(XMP) ~ |4GB(2x2GB) (DS |- - 9 165 . . .
KINGSTON |KHX2133C9AD3X2K2/4GX(XMP)  |4GB(2x2GB) (DS |- - 9 1.65 . . .
KINGSTON |KHX2133C9AD3X2K2/AGX(XMP)  |4GB(2x2GB) (DS |- - 9-9-9-24 165 . . .
KINGSTON | KHX2133CIAD3TIFK4/8GX(XMP)  |8GB(4x2GB) (DS |- - 9 165 . . .
Patriot PVV34G2133CIK(XMP) 4GB(2x2GB) |DS |- . 9-11-9-27 |1.66 . . .

P8Z77-V DELUXE Motherboard Qualified Vendors Lists (QVL)
DDR3 2000(0.C.) MHz capability

Vendors

Part No.

Chip
Brand

Chip NO. Timing

Voltage

DIMM socket support
(Optional)

1 2 4
DIMM DIMM DIMM

A-DATA AX3U2000GB2GIB(XMP) 2GB DS - 911-9-27 | 155~175 |« . .
[A-DATA AX3U2000GC4GIB(XMP) 4GB DS - 911-927 |155~175 |+ . .
Apacer 78 AAGD5.9KD(XMP) 6GB(3x2GB) | DS - 99-927 |- . . .
CORSAIR | CMT6GX3M3A2000C8(XMP) | 6GB(3x2GB) |DS |- - 8- 1.65 . . .
G.SKILL F3-16000CLID-4GBRH(XMP) | 4GB(2x2GB) |DS |- - 9-9-9- 165 . . .
G.SKILL F3-16000CLID-4GBTD(XMP) | 4GB(2x2GB) |DS |- - 9-9-9- 165 . . .
GEIL GUP34GB2000CIDC(XMP) 4GB(2x2GB) |DS |- . 9-9-9- 1.65 . . .
KINGSTON | KHX2000C9AD3TIK3/6GX(XMP) |6GB(3x2GB) |DS |- - 9 1.65 . . .
Transcend | TX2000KLN-8GK (388375)(XMP) | 4GB DS |- - - 16 . . .
AEXEA AXA3ES2G2000LG28V(XMP) | 2GB DS |- - . 1.65 . .

AEXEA AXASES4GK2000LG28V(XMP) | 4GB(2x2GB) |DS |- - - 1.65 . . .
Patriot PX7312G2000ELK(XMP) 12GB(3x4GB) | DS - 911-927 |165 . . .
Patriot PV736G2000ELK(XMP) 6GB(3x2GB) |DS |- - 77-720 165 . . .
Silicon Power | SPO02GBLYU200S02(XMP) 2GB DS |- - - - . . .
Team TXD32048M2000C9(XMP) 2GB DS |Team | T3D1288RT-20(9-99-24 |15 . . .
Team TXD32048M2000C9-L(XMP) | 2GB DS |Team | T3D1288LT-20 [9-9-9-24 |15 . . .
Team TXD32048M2000CO-LOXMP) | 2GB DS_Team | T3D1288RT-20 9-9-9-24 |16 . . .
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P8Z77-V DELUXE Motherboard Qualified Vendors Lists (QVL)
DDR3 1866(0.C.) MHz capability

DIMM socket support

Part No g:wa‘ﬁd Chip NO. Timing Voltage q (Opllzona\) a
DIMM DIMM DIMM
IA-DATA AX3U1866GC2GIB(XMP) 2GB SS |- - 9-11-9-27 |1.55~1.75 |« . .
IA-DATA AX3U1866GC4GIB(XMP) 4GB DS |- - 9-11-9-27 | 1.55~1.75 |« . .
CORSAIR | CMZ8GX3M2A1866CI(XMP) 8GB(2x4GB) | DS |- - 9-10-9-27 |15 . . .
G.SKILL | F3-14900CLOQ-16GBXL(XMP) |16GB(4x4GB) |DS |- - 9-10-9-28 |15 . . .
G.SKILL | F3-15000CLID-4GBTD(XMP) ~ |4GB(2x2GB) |DS |- - 9-9-924 | 1.65 . . .
G.SKILL  |F3-14900CL9D-8GBSR(XMP) | 8GB(2x4GB) DS |- - 9-10-9-28 |15 . . .
G.SKILL F3-14900CL9Q-8GBFLD(XMP) | 8GB(2x4GB) |DS - - 9-9-9-24 |16 . . .
KINGSTON | KHX1866C9D3T1K3/3GX(XMP) |3GB(3x1GB) |SS |- - - 1.65 . . .
Patriot PXD34G1866ELK(XMP) 4GB(2x2GB) |SS |- - 9-9-9-24 |1.65 . . .
Patriot PXD38G1866ELK(XMP) 8GB(2x4GB) DS |- - 9-11-9-27 |1.65 . . .
Team TXD32048M1866CI(XMP) 2GB DS Tefm T3D1288RT-16 | 9-9-9-24 1 1.65 . . .

P8Z77-V DELUXE Motherboard Qualified Vendors Lists (QVL)
DDR3 1800(0.C.) MHz capability

DIMM socket support

Vendors  Part No SS/ Chip ~ Chip Timing  Voltage (Optional)

DS Brand NO.

1DIMM 2DIMM 4 DIMM
G.SKILL | F3-14400CLID-4GBRL(XMP) |4GB(2x2GB) |DS |- [- |9-9-924 |16 | B B

Chapter 2

P8Z77-V DELUXE Motherboard Qualified Vendors Lists (QVL)
DDR3 1600 MHz capability

DIMM socket
Vendors Part No. Ship  chipNo.  Timing  Voltage support (Zommil)
DIMM DIMM DIMM

A-DATA | AM2U16BC2P1 268 SS |ADATA |3CCD-1509A - - BB
ADATA | AM2U16BCAP2 re) DS |ADATA |3CCD-1509A - - E
ADATA | AX3U1600GCAGI(XMP) 468 DS |- - - 155175 |+ e |
ADATA | AX3U1600PCAGS(XMP) 468 DS |- - 155175 |+ e |
CORSAIR | HX3X12G1600C9(XMP) 12GB(6x2GB) |DS |- - 16 BEOENE
CORSAIR | CMZ16GX3M4AL600C9(XMP) | 16GB(4xdGB) |DS - - 15 BB
CORSAR | CMGAGX3M2A1600C6 4GB(2x2GB) |DS - - 165 < |- |
CORSAR | CMDAGX3M2B1600C8 4GB(2x2GB) |DS - - 165 BEOEE
CORSAIR | CMX4GX3M2A1600C8(XMP) 4GB(2x2GB) |DS |- - 165 L
CORSAIR | CMP6GX3M3AL600C8(XMP) 6GB(3x2GB) |DS |- - 165 ERE
CORSAIR | CMP6GX3M3A1600C3(XMP) 6GB(3x2GB) |DS - - 165 A
CORSAIR | CMX6GX3M3C1600C7(XMP) 6GB(3x2GB) |DS |- - 165 B
CORSAIR | CMZB8GX3M2A1600C8(XMP) 8GB(2x4GB) |DS - - 15 D
Crucial BL12864BN1608 8FF(XMP) 2GB(2x1GB) |SS - - 165 A
Crucial BL25664BN1608.16FF(X\MP) 268 DS |- - 165 A
G.SKILL | F3-12800CL7Q-16GBXH(XMP) | 16GB(4xdGB) |DS - - 16 . .
G.SKILL | F3-12800CL9Q-16GBXL(XMP) | 16GB(4xdGB) |DS |- - 15 . .
G.SKILL | F3-12800CL7D-4GBECO(XMP) | 4GB(2x2GB) |DS |- - 78724 - BB
G.SKILL | F3-12800CL8D-4GBRM(XMP) | 4GB(2x2GB) |DS |- - 16 e
G.SKILL | F3-12800CLOD-4GBECO(XMP) | 4GB(2x2GB) |DS |- - 135 L
G.SKILL | F3-12800CLID-8GBRL(XMP) 8GB(2x4GB) |DS - - 15 < |- |
GSKILL | F3-12800CLID-8GBSR2(XMP) | 8GB(2x4GB) |DS - - 125 BEOEE
G.SKILL | F3-12800CLBD-8GBECO(XMP) | 8GB(2x4GB) |DS |- - 135 S
GEIL GET316GB1600CIQC(XMP) 16GB(4x4GB) |DS - - 16 |
ceiL GUP34GBL600CTDC(XMP) 4GB(2x2GB) |DS |- - 16 e
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P8Z77-V DELUXE Motherboard Qualified Vendors Lists (QVL)
DDR3 1600 MHz capability (continued)

DIMM socket
Vendors Part No. Ss/ Bcrglnpd Chip NO. Timing  Voltage support (ZOptloni\)
DIMM DIMM DIMM
KINGSTON | KHX1600C9D3K3/12GX(XMP) 12GB(3x4GB) |DS |- - 9 1.65 . . .
KINGSTON | KHX1600C9D3T1BK3/12GX(XMP) |12GB(3x4GB) |DS |- - 9 1.65 . .
KINGSTON | KHX1600C9D3K3/12GX(XMP) 12GB(3x4GB) (DS |- - - 1.65 . . .
KINGSTON | KHX1600C9D3K6/24GX(XMP) 24GB(6x4GB) | DS 9 1.65 . . .
KINGSTON | KHX1600C8D3K2/4GX(XMP) 4GB(2x2GB) |DS |- - 8 1.65 . .
KINGSTON | KHX1600C9D3K2/4GX(XMP) 4GB(2x2GB) |DS |- - - 1.65 . . .
KINGSTON | KHX1600C9D3LK2/4GX(XMP) 4GB(2x2GB) |DS |- - - 1.65 . . .
KINGSTON | KHX1600C9D3X2K2/4GX(XMP) | 4GB(2x2GB) |DS |- - 9 1.65 . . .
KINGSTON | KHX1600C9D3K3/6GX(XMP) 6GB(3x2GB) (DS |- - 9 1.65 . . .
KINGSTON | KHX1600C9D3K3/6GX(XMP) 6GB(3x2GB) | DS 9 1.65 . . .
KINGSTON | KHX1600C9D3T1K3/6GX(XMP) 6GB(3x2GB) DS |- - - 1.65 . . .
KINGSTON | KHX1600C9D3T1K3/6GX(XMP) 6GB(3x2GB) |DS |- - 9 1.65 . . .
KINGSTON | KHX1600C9D3P1K2/8G 8GB(2x4GB) |DS |- - 9 15 . . .
O 0CZ OCZ3BE1600C8LV4GK 4GB(2x2GB) |DS | - - 8-8-8 1.65 . .
:- 0CZ OCZ3X1600LV6GK(XMP) 6GB(3x2GB) |DS |- - 8-8-8 1.65 . . .
QJ 0CZ OCZ3X1600LV6GK(XMP) 6GB(3x2GB) |DS |- - 8-8-8 1.65 . . .
© Super Talent | WP160UX4GI(XMP) 4GB(2x2GB) |DS |- - 9 - . . .
a Super Talent | WB160UX6G8(XMP) 6GB(3x2GB) |DS |- - - - . . .
- Super Talent | WB160UX6G8(XMP) 6GB(3x2GB) |DS |- - 8 - . . .
N Transcend JM1600KLN-8GK 8GB(2x4GB) |DS |Transcend 1(;!\%1383P - - . . .
AEXEA AXA3PS4GK1600S18V(XMP) 4GB(2x2GB) |DS |- - - 1.65 . .
Asint SLZ3128M8-EGJ1D(XMP) 2GB DS |Asint 3128M8 - - . . .
-GJ1D
EK Memory | EKM324L.28BP8-116(XMP) 4GB(2x2GB) |DS |- - 9 - . . .
EK Memory | EKM324L28BP8-116(XMP) 4GB(2x2GB) |DS |- - 9 - . . .
GoodRam GR1600D364L9/2G 2GB DS | GoodRam | GF1008 - - . . .
KC-JN
KINGTIGER | KTG2G1600PG3(XMP) 2GB DS - - . . .
i 996805(XMP) 4GB(2x2GB) |DS |- - 6-8-6-24 |1.65 . . .
Mushkin 998805(XMP) 6GB(3x2GB) |DS |- - 6-8-6-24 |1.65 . . .
Patriot PX7312G1600LLK(XMP) 12GB(3x4GB) (DS |- - 8-9-8-24 |1.65 . . .
Patriot PGS34G1600LLKA2 4GB(2x2GB) |DS | - - 8-8-8-24 1.7 . . .
Patriot PGS34G1600LLKA 4GB(2x2GB) |DS |- - 7-7-7-20 (1.7 . . .
PATRIOT PGS34G1600LLKA 4GB(2x2GB) |DS |- - 7-7-7-20 1.7 . .
Patriot PVV38G1600LLK(XMP) 8GB(2x4GB) |DS |- - 8-9-8-24 |1.65 . .
Patriot PX538G1600LLK(XMP) 8GB(2x4GB) |DS |- - 8-9-8-24 |1.65 . .
SanMax SMD-4G68HP-16KZ 4GB DS | Hynix H5TQ2G8 - 15 . . .
3BFRPBC
Team TXD31024M1600C8-D(XMP) 1GB SS | Team 131%1288'? 8-8-8-24 |1.65 . . .
Team TXD32048M1600C7-L(XMP) 2GB DS |Team 131%128& 7-7-7-24 |1.65 . .
Team TXD32048M1600HC8-D(XMP) 2GB DS |Team $31[%1288R 8-8-8-24 |1.65 . . .
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P8Z77-V DELUXE Motherboard Qualified Vendors Lists (QVL)
DDR3 1333 MHz capability

DIMM socket
support (Optional)
Vendors Part No Chip Brand  Chip NO. Timing  Voltage 2 4
DIMM DIMM DIMM
A-DATA AD6311B0823EV 2GB SS |A-DATA 3CCA-1509A - - . . .
A-DATA AXDU1333GC2G9(XMP) 2GB SS |- - 9-9-9-24 |1.25~1.35 |« . .
A-DATA ADG63I1C1624EV 4GB DS |A-DATA 3CCA-1509A - - . . .
A-DATA SU3U1333W8G9(XMP) 8GB DS |ELPIDA J4208BASE-DJ-F - - . . .
Apacer 78.01GC6.9L0 1GB SS | Apacer AMSD5808DEJSBG |9 - . . .
Apacer 78.A1GC6.9L1 2GB DS | Apacer AMS5D5808FEQSBG |9 - . . .
Apacer 78.B1GDE.9L10C 4GB DS | Apacer AMSD5908CEHSBG |9 - . . .
CORSAIR | TW3X4G1333C9A 4GB (2x2GB) DS |- - 15 . .
CORSAIR | CMX8GX3M2A1333C9(XMP) '8GB (2x4GB) DS |- - 15 . . .
CORSAIR | CMX8GX3M4A1333C9 8GB(4x2GB) DS |- - 15 . . .
Crucial BL25664BN1337.16FF(XMP) | 2GB DS |- - 1.65 . . .
G.SKILL F3-10600CLID-4GBNT 4GB (2x2GB) |DS | G.SKILL D3 128M8CE9 2GB 15 . . .
G.SKILL F3-10666CL7D-4GBRH(XMP) 4GB(2 x 2GB) |DS |- - 7-7-7-21 |15 . . .
G.SKILL F3-10666CL8D- 4GB(2x2GB) DS |- - 8-8-8-24 |1.35 . . .
4GBECO(XMP)

G.SKILL F3-10666CLID-8GBRL 8GB (2x4GB) DS |- - 9-9-9-24 |15 . . .
G.SKILL F3-10666CLID-8GBRL 8GB (2x4GB) |DS |- - 9-9-9-24 |15 . . .
G.SKILL F3-10666CLID-8GBXL 8GB (2x4GB) DS |- - 9-9-9-24 |15 . .

GEIL GET316GB1333C9QC )16GB (4x 4GB|DS |- - 9-9-9-24 |15 . . .
GEIL GG34GB1333C9DC 4GB (2x2GB) DS | GEIL (FBVLVILHBMBBBAMS 9-9-9-24 |13 . . .
GEIL GG34GB1333C9DC 4GB (2x2GB) DS | GEIL GL1L128M88BBA15B |9-9-9-24 [1.3 . . .
GEIL GVP34GB1333C9DC 4GB (2x2GB) |DS |- - 9-9-9-24 |15 . .

GEIL GB34GB1333C7DC 4GB(2 x 2GB) DS |GEIL GL1L128M88BALSFW | 7-7-7-24 |15 . . .
GEIL GG34GB1333C9DC 4GB(2 x 2GB) DS |GEIL GL1L128M88BA12N 9-9-9-24 |13 . . .
GEIL GVP38GB1333C9DC 8GB (2x4GB) DS 9-9-9-24 |15 . . .
GEIL GVP38GB1333C7QC 8GB (4x2GB) |DS - 7-7-7-24 |15 . . .
Hynix HMT112U6TFRBA-H9 1GB SS | Hynix H5TC1G83TFR - - . . .
Hynix HMT325U6BFR8C-H9 2GB SS | Hynix H5TQ2G83BFR - - . . .
Hynix HMT125U6BFR8C-H9 2GB DS | Hynix H5TQ1G83BFRHIC 9 - . . .
KINGMAX FLFEB5F-C8KL9 2GB SS | KINGMAX KFC8FNLXF-DXX-15A | - - . . .
KINGMAX FLFEB5F-C8KM9 2GB SS | Kingmax KFCBFNMXF-BXX-15A |- - . . .
KINGMAX FLFE85F-B8KLY 2GB DS | KINGMAX KFBBFNLXL-BNF-15A | - - . . .
KINGMAX FLFF65F-C8KL9 4GB DS |KINGMAX | KFC8FNLXF-DXX-15A |- - . . .
KINGMAX FLFF65F-C8KM9 4GB DS | Kingmax KFC8FNMXF-BXX-15A | - - . .
KINGSTON | KVR1333D3N9/1G 1GB SS | Elpida J1108BDSE-DJ-F 9 15 . . .
KINGSTON | KVR1333D3S8N9/2G 2GB SS | Micron IFD77 DILGK - 15 . . .
KINGSTON | KVR1333D3N9/2G 2GB DS |Kingston D1288JPNDPLDOU 9 15 . . .
KINGSTON | KHX1333C9D3UK2/4GX(XMP) 4GB (2x2GB) |DS |- - 9 125 . .
KINGSTON | KVR1333D3N9K2/4G 4GB (2x2GB) |DS |KINGSTON | D1288JEMFPGDOU - 15 . . .
KINGSTON | KVR1333D3E9S/4G 4GB DS |Elpida J2108ECSE-DJ-F 9 15 . . .
MICRON MT4JTF12864AZ-1G4AD1 1GB SS | Micron DILGQ - - . .
MICRON MT8JTF25664AZ-1G4D1 2GB SS | Micron DILGK - - . . .
MICRON MT8JTF25664AZ-1G4D1 2GB SS | Micron DILGK - - . . .
MICRON MT8JTF25664AZ-1GAM1 2GB SS | MICRON D9PFJ - - . . .
MICRON MT16JTF51264AZ-1G4AD1 4GB DS | Micron DILGK - - . . .
0Cz 0CZ3P1333LV3GK 3GB(3x1GB) SS 777 165 . . .
0ocz OCZ3G1333LV4GK 4GB (2x2GB) DS 9-9-9 1.65 . . .
0Cz 0CZ3P1333LV4AGK 4GB(2 x 2GB) DS 777 165 . . .
0ocz 0CZ3G1333LV8GK 8GB (2x4GB) DS 9-9-9 1.65 . . .
0Cz OCZ3RPR1333C9ILV8GK 8GB (2x4GB) |DS - 9-9-9 165 . . .
PSC PC310600U-9-10-A0 1GB SS |PSC A3P1GF3FGF - - . . .
PSC PC310600U-9-10-B0 2GB DS |PsC A3P1GF3FGF - - . . .
SAMSUNG | M378B2873EH1-CH9 1GB SS | SAMSUNG | K4B1G0846E - - . . .
SAMSUNG | M378B2873FHS-CHI 1GB SS | SAMSUNG | K4B1G0846F - - . . .
SAMSUNG | M378B5773DH0-CH9 2GB SS | SAMSUNG | K4B2G08460 - - . .
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P8Z77-V DELUXE Motherboard Qualified Vendors Lists (QVL)
DDR3 1333 MHz capability (continued)

DIMM socket
support (Optional)
Part No, Chip Brand  Chip NO Timing  Voltage h p "
DIMM DIMM DIMM

[SAMSUNG | M378B5673FHO-CH9 2GB DS |SAMSUNG | K4B1G0846F - - . . .
SAMSUNG | M378B5273BH1-CH9 4GB DS |SAMSUNG | K4B2G0846B-HCH9 9 - . . .
SAMSUNG | M378B5273CHO0-CH9 4GB DS |SAMSUNG | K4B2G0846C OKQEGZE - . . .
[SAMSUNG | M378B5273DH0-CHI 4GB DS |SAMSUNG | K4B2G08460 - - . . .
SAMSUNG | M378B1G73AH0-CH9 8GB DS |SAMSUNG | K4B4GO0846A-HCH9 - - . . .
Transcend | JM1333KLN-2G 2GB SS |Transcend | TK483PCW3 - - . . .
Transcend TS256MLK64V3N (585541 ) 2GB SS | Micron ICD77 DILGK 9 - . . .
Transcend TS256MLK64V3N (566577) 2GB SS  |Hynix H5TQ2G83BFR 9 - . . .
Transcend TS256MLK64V3N (574206) 2GB SS | Micron DILGK 9 - . . .
Transcend JM1333KLN-4G (583782 ) 4GB DS | Transcend | TK483PCW3 9 . . .
Transcend | JM1333KLN-4G 4GB DS | Transcend | TK483PCW3 - - . . .
Transcend TS512MLK64V3N (585538 ) 4GB DS | Micron |IED27 DOLGK 9 . . .
Transcend | TS512MLK64V3N (574831) 4GB DS | Micron DILGK 9 - . . .
IACTICA ACT1GHU64B8F1333S 1GB SS | SAMSUNG | K4B1G0846F - - . . .
O ACTICA ACT1GHU72C8G1333S 1GB SS |SAMSUNG | K4B1G0846F(ECC) - - . . .
:— IACTICA ACT2GHU64B8G1333M 2GB DS | Micron DO9KPT - - . . .
QJ ACTICA ACT2GHU64B8G1333S 2GB DS |SAMSUNG | K4B1G0846F - - . . .
-O IACTICA ACT2GHU72D8G1333M 2GB DS | Micron DOKPT(ECC) - - . . .
~+ ACTICA ACT2GHU72D8G1333S 2GB DS |SAMSUNG | K4B1G0846F(ECC) - - . . .
(D ACTICA ACT4GHUG4B8H1333H 4GB DS | Hynix H5TQ2G83AFR - - . . .
= ACTICA ACTAGHU72D8H1333H 4GB DS | Hynix H5TQ2G83AFR(ECC) |- - . . .
N ATP AQ56M72E8BIHIS 2GB DS |SAMSUNG |K4BIGOB46F(ECC) |- - . . .
ATP AQ12M72E8BKHIS 4GB DS |SAMSUNG | K4B2G0846C(ECC) - - . . .
BUFFALO D3U1333-1G 1GB SS | Elpida J1108BFBG-DJ-F - - . . .
BUFFALO D3U1333-2G 2GB DS | Elpida J1108BFBG-DJ-F - . . .
BUFFALO D3U1333-4G 4GB DS |NANYA NTSCB256M8BN-CG - . . .

EK Memory | EKM324L28BP8-113 4GB(2 x 2GB) DS |- - 9 . .
Elixir M2F2G64CB88B7N-CG 2GB SS | Elixir N2CB2G808N-CG - - . . .
Elixir M2F2G64CB88D7N-CG 2GB SS | Elixir M2CB2G8BDN-CG - - . . .
Elixir M2F4G64CB8HB5N-CG 4GB DS | Elixir N2CB2G808N-CG - - . . .
Elixir M2F4G64CB8HDSN-CG 4GB DS | Elixir M2CB2G8BDN-CG - - . . .
GoodRam GR1333D364L9/2G 2GB DS | Qimonda I(!:D?;E‘.G-DSAlFl - - . . .
KINGTIGER | F10DA2T1680 2GB DS | KINGTIGER |KTG1333PS1208 - - . . .

NST-C9
KINGTIGER | KTG2G1333PG3 2GB DS |- - - - . . .
Patriot PSD32G13332 2GB DS | Prtriot PM128M8D3BU-15 9 - . . .
Patriot PGS34G1333LLKA 4GB(2x2GB) DS |- - 77720 |17 . . .
Patriot PG38G1333EL(XMP) 8GB DS |- - 15 . . .
SanMax SMD4G68H1P-13HZ 4GB DS | Hynix H5TQ2G83BFRHIC - 15 . . .
RIDATA C304627CB1AG22Fe 2GB DS |RIiDATA ;.‘,204627C51AG2 9 - . . .
e

RIDATA E304459CB1AG32Cf 4GB DS | RIDATA 5&04459CBU—\G3 9 - . . .
Silicon Power | SPO01GBLTE133S01 1GB SS |NANYA NT5CB128M8AN-CG |- - . . .
Silicon Power | SPO01GBLTU1333S01 1GB SS |NANYA NTSCB128MBAN-CG |- - . . .
Silicon Power | SPO01GBLTU133502 1GB SS |S-POWER 10YT3ES 9 - . . .
Silicon Power | SPO02GBLTE133S01 2GB DS |NANYA NTSCB128MBAN-CG |- - . . .

Silicon Power | SP002GBLTU133502 2GB DS |S-POWER I0YT3EO 9 - . .

Team TXD31024M1333C7(XMP) 1GB SS | Team T3D1288LT-13 7-7-7-21 |1.75 . .
Team TXD31048M1333C7-D(XMP) 1GB SS | Team T3D1288LT-13 7-7-7-21 |1.75 . .
Team TXD32048M1333C7-D(XMP) 2GB DS | Team T3D1288LT-13 7-7-7-21 |1.5-1.6 . .
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Z&\\ Side(s): SS - Single-sided DS - Double-sided
DIMM support:
*  1DIMM: Supports one (1) module inserted into any slot as Single-channel memory
configuration. We suggest that you install the module into A2 slot.

¢ 2DIMMs: Supports two (2) modules inserted into either the blue slots or the black
slots as one pair of Dual-channel memory configuration. We suggest that
you install the modules into slots A2 and B2 for better compatibility.

¢ 4 DIMMs: Supports four (4) modules inserted into both the blue and black slots as
two pairs of Dual-channel memory configuration.

Z\§\\ e ASUS exclusively provides hyper DIMM support function.

*  Hyper DIMM support is subject to the physical characteristics of individual CPUs. Load
the X.M.P. or D.O.C.P. settings in the BIOS for the hyper DIMM support.

¢ Visit the ASUS website for the latest QVL.

ASUS P8Z77-V DELUXE
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2.2.4 Expansion slots

/ Ensure to unplug the power cord before adding or removing expansion cards. Failure to do
{ s0 may cause you physical injury and damage motherboard components.

83330 o) h
] O

(i 19

O

Z 1eadeyd

???;???m

I =

® EE Er |

-

Slot No.  Slot Description

PCle 2.0 x1_1 slot

PCle 3.0/2.0 x16_1 slot (single at x16 or dual at x8/x8 mode)

PCle 2.0 x1_2 slot

PCle 2.0 x1_3 slot

PCle 3.0/2.0 x16_2 slot (at X8 mode)

PCle 2.0 x1_4 slot

PCle 2.0 x16=3 slot [black] (at x4 mode, compatible with PCle x1 and x4 devices)

~N o g W N

PCI Express operating mode

VGA configuration

x16

(Recommend for single VGA) NIA

Single VGA/PCle card

Dual VGA/PCle card x8 X8
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R * Insingle VGA card mode, use the PCle 3.0/2.0 x16_1 slot (navy blue) for a PCI
Express x16 graphics card to get better performance.

¢ In CrossFireX™ or SLI™ mode, use the PCle 3.0/2.0 x16_1 and PCle 3.0/2.0 x16_2

slots for PCI Express x16 graphics cards to get better performance.
+ We recommend that you provide sufficient power when running CrossFireX™ or SLI™

mode. Refer to page 2-31 for details.

«  Connect a chassis fan to the motherboard connector labeled CHA_FAN1/2 when using

multiple graphics cards for better thermal environment. See page 2-30 for details.

«  The PCle 3.0 speed is supported by Intel® 3rd generation Core™ processors.

¢ The PClex1_2 shares bandwidth with SATA6G_E12. SATA6G_E12 is enabled by

default for system resource optimization.

IRQ assignments for this motherboard

Intel PCH SATA
Controller #0

A

B

C

D

shared

Intel PCH SATA
Controller #1

shared

SMBUS Controller

shared

Thermal Controller

shared

EHCI #0

EHCI #1

shared

PCIE x16_1

shared

PCIE x16_2

shared

PCIE x16_3

shared

ASMedia USB 3.0 #0

shared

ASMedia USB 3.0 #1

shared

Intel 82579V LAN

shared

PEX 8608 PCIE Bridge

shared

ASMedia SATA
Controller

shared

Marvell 9128 Hardware
RAID Controller

shared

ASUS P8Z77-V DELUXE
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2.25 Onboard switches

Onboard switches allow you to fine-tune performance when working on a bare or open-
case system. This is ideal for overclockers and gamers who continually change settings to
enhance system performance.

1. Power-on switch

The motherboard comes with a power-on switch that allows you to power up or wake
up the system. The switch also lights up when the system is plugged to a power source
indicating that you should shut down the system and unplug the power cable before
removing or plugging in any motherboard component. The illustration below shows the
location of the onboard power-on switch.

O

0

Q 0

= =R

D U c—
- o 3

N o &

[—] 0
O .

B = WSLIN[0)

P8277-V DELUXE Power on switch

2. Reset switch
Press the reset switch to reboot the system.

o = 0O
—

a

| —
O rez7rvoeone

— OG

o [ —— RESET|
ER a5 |}

P8Z77-V DELUXE Reset switch
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3. MemOK! switch
Installing DIMMs that are incompatible with the motherboard may cause system
boot failure, and the DRAM_LED near the MemOK! switch lights continuously. Press
and hold the MemOK! switch until the DRAM_LED starts blinking to begin automatic
memory compatibility tuning for successful boot.

MemOK!

I

| —
PaZ77V DELUXE
— o 0
| —] d

it SO

P8Z77-V DELUXE MemOK! switch

@ 1] oo

R ¢ Refer to section 2.2.6 Onboard LEDs for the exact location of the DRAM_LED.

¢ The DRAM_LED also lights when the DIMM is not properly installed. Turn off the
system and reinstall the DIMM before using the MemOK! function.

*  The MemOK! switch does not function under Windows™ OS environment.

«  During the tuning process, the system loads and tests failsafe memory settings. It
takes about 30 seconds for the system to test one set of failsafe settings. If the test
fails, the system reboots and test the next set of failsafe settings. The blinking speed
of the DRAM_LED increases, indicating different test processes.

¢ Due to memory tuning requirement, the system automatically reboots when each
timing set is tested. If the installed DIMMSs still fail to boot after the whole tuning
process, the DRAM_LED lights continuously. Replace the DIMMs with ones
recommended in the Memory QVL (Qualified Vendors Lists) in this user manual or on
the ASUS website at www.asus.com.

« Ifyou turn off the computer and replace DIMMs during the tuning process, the system
continues memory tuning after turning on the computer. To stop memory tuning, turn
off the computer and unplug the power cord for about 5-10 seconds.

* If your system fail to boot due to BIOS overclocking, press the MemOK! switch to boot
and load BIOS default settings. A messgae will appear during POST reminding you
that the BIOS has been restored to its default settings.

¢ We recommend that you download and update to the latest BIOS version from the
ASUS website at www.asus.com after using the MemOK! function.

ASUS P8Z77-V DELUXE
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4, TPU switch

Turning this switch to Enable will automatically optimize the system for fast, yet stable
clock speeds.

k For ensuring the system performance, turn the switch setting to Enable when the system is
powered off.

99

Disable Enable
(Default)

P8Z77-V DELUXE TPU switch

*  The TPU LED (O2LED2) near the TPU switch lights when the switch setting is turned
/ to Enable. Refer to section 2.2.6 Onboard LEDs for the exact location of the TPU

LED.

+  If you change the switch setting to Enable under the OS environment, the TPU
function will be activated after the next system bootup.

*  You may use the TurboV and Auto Tuning feature in the TurboV EVO application,
adjust the BIOS setup program, or enable the TPU switch at the same time. However,
the system will use the last setting you have made.
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5. EPU switch

Turning this switch to Enable will automatically detect the current PC loadings and
intelligently moderate the power consumption.

k For ensuring the system performance, turn the switch setting to Enable when the system is
powered off.

O
O EPU

. [
a
O pezrrvoEioxe Ny

=

Ug Disable Enable
H edc] o (Default)

P8Z77-V DELUXE EPU switch

to Enable. Refer to section 2.2.6 Onboard LEDs for the exact location of the EPU
LED.

% *  The EPU LED (O2LED3) near the EPU switch lights when the switch setting is turned

«  If you change the switch setting to Enable under the OS environment, the EPU
function will be activated after the next system bootup.

*  You may change the EPU settings in the software application or BIOS setup program,
and enable the EPU function at the same time. However, the system will use the last
setting you have made.

ASUS P8Z77-V DELUXE
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6.

Clear CMOS switch

Turning this switch to clear the BIOS setup information, only when the systems hangs

due to overclocking.

T -

o — 0O
—

a

—
O rezrrvoELUXE
e

CLR_CMOS

P8Z77-V DELUXE CLR_CMOS switch
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2.2.6 Onboard LEDs

1.  POST State LEDs

The POST State LEDs of CPU, DRAM, VGA card, and HDD indicate key components
status during POST (Power-on Self Test). If an error is found , the LED next to the
error device will continue lighting until the problem is solved. This user-friendly design
provides an intuitional way to locate the root problem within a second.

fi—> DRAM_LED

1 —> CPU_LED

VGA_LED
s &

=10
O resrvoeione
— @)=
g

O
@ 0000 oo

BOOT_DEVICE_LED

it SO
P8Z77-V DELUXE CPU/ DRAM/
BOOT_DEVICE/ VGA LED

Chapter 2

2. ID LEDs
The ID LEDs provide an elegant embellishment to the motherboard design.

= bl
[}
[}
= 0 ID_LED1
g 3 ID_LED2
O rervomoe ~o - ID_LED3
o _
O  — O D 0

Fewd @ 1 o] omm

P8Z77-V DELUXE ID_LED
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3.

Z 1erdeyd

4.

TPU LED
The TPU LED lights when the TPU switch is turned to Enable.

—> O2LED2

o = J

i -:ZGD--DE

| ——
O  psz77-v DELUXE -
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O

Fewd ® 1 o] ommy

P8Z77-V DELUXE TPU LED

EPU LED
The EPU LED lights when the EPU switch is turned to Enable.

— OE DD

ojg g iy g v

O2LED3

E

~

P8Z77-V DELUXE EPU LED
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5. Q-Code LEDs

The Q-Code LED design provides you the 2-digit display, allowing you to know the
system status. Refer to the Q-Code table below for details.

Ooopg o

 — OE D o
Fans s L @mam:@—m—> LED1 LEDO
P8Z77-V DELUXE Q-Code LED

Q-Code table

Description
Not used

Chapter 2

Power on. Reset type detection (soft/hard).

AP initialization before microcode loading

System Agent initialization before microcode loading

PCH initialization before microcode loading

Microcode loading

AP initialization after microcode loading

System Agent initialization after microcode loading

PCH initialization after microcode loading

Cache initialization

Reserved for future AMI SEC error codes

Microcode not found

Microcode not loaded

PEI Core is started

Pre-memory CPU initialization is started

Pre-memory System Agent initialization is started

Pre-memory PCH initialization is started

Memory initialization

Reserved for ASL (see ASL Status Codes section below)
Memory Installed

CPU post-memory initialization

Post-Memory System Agent initialization is started

ASUS P8Z77-V DELUXE



Q-Code table (continued)

Code | Description
3B - 3E Post-Memory PCH initialization is started

4F DXE IPL is started

Memory initialization error. Invalid memory type or incompatible memory

50 - 53
speed

54 Unspecified memory initialization error

55 Memory not installed

56 Invalid CPU type or Speed

57 CPU mismatch

58 CPU self test failed or possible CPU cache error

59 CPU micro-code is not found or micro-code update is failed

5A Internal CPU error

5B Reset PPl is not available

Reserved for future AMI error codes

EO S3 Resume is stared (S3 Resume PPl is called by the DXE IPL)

El S3 Boot Script execution

E2 Video repost

E3 OS S3 wake vector call

O
-
Q
ie
—+
@
=
N

Reserved for future AMI progress codes

E8 S3 Resume Failed

E9 S3 Resume PPI not Found

EA S3 Resume Boot Script Error

EB S3 OS Wake Error

Reserved for future AMI error codes

FO Recovery condition triggered by firmware (Auto recovery)

F1 Recovery condition triggered by user (Forced recovery)

F2 Recovery process started

F3 Recovery firmware image is found

F4 Recovery firmware image is loaded

Reserved for future AMI progress codes

F8 Recovery PPI is not available

F9 Recovery capsule is not found

FA Invalid recovery capsule

Reserved for future AMI error codes

60 DXE Core is started

61 NVRAM initialization

62 Installation of the PCH Runtime Services
CPU DXE initialization is started

68 PCI host bridge initialization

69 System Agent DXE initialization is started

6A System Agent DXE SMM initialization is started
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Q-Code table (continued)

Code
6B — 6F
70

71

72

78
79

90
91
92
93
Lz
95
96
97
98
99
9A
9B
9C
9D

A0
Al
A2
A3
A4
A5
A6
A7
A8
A9
AA
AB
AC
AD
AE
AF
BO

Description
System Agent DXE initialization (System Agent module specific)

PCH DXE initialization is started

PCH DXE SMM initialization is started

PCH devices initialization

PCH DXE Initialization (PCH module specific)

ACPI module initialization

CSM initialization

Reserved for future AMI DXE codes

Boot Device Selection (BDS) phase is started

Driver connecting is started

PCI Bus initialization is started

PCI Bus Hot Plug Controller Initialization

PCI Bus Enumeration

PCI Bus Request Resources

PCI Bus Assign Resources

Console Output devices connect

Console input devices connect

Super 10 Initialization

USB initialization is started

USB Reset

USB Detect

USB Enable

Reserved for future AMI codes

IDE initialization is started

IDE Reset

IDE Detect

IDE Enable

SCSl initialization is started

SCSI Reset

SCSI Detect

SCSI Enable

Setup Verifying Password

Start of Setup

Reserved for ASL (see ASL Status Codes section below)

Setup Input Wait
Reserved for ASL (see ASL Status Codes section below)

Ready To Boot event

Legacy Boot event

Exit Boot Services event

Runtime Set Virtual Address MAP Begin

ASUS P8Z77-V DELUXE
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Q-Code table (continued)

| Description
Runtime Set Virtual Address MAP End

Legacy Option ROM Initialization
System Reset

USB hot plug

PCI bus hot plug

Clean-up of N\VRAM

Configuration Reset (reset of NVRAM settings)

Reserved for future AMI codes

CPU initialization error

System Agent initialization error

PCH initialization error

Some of the Architectural Protocols are not available

PCI resource allocation error. Out of Resources

No Space for Legacy Option ROM

No Console Output Devices are found

No Console Input Devices are found

Invalid password

O
-
Q
ie
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Error loading Boot Option (LoadImage returned error)

Boot Option is failed (Startimage returned error)

Flash update is failed

Reset protocol is not available

ACPI/ASL Checkpoints

Description
System is entering S1 sleep state

System is entering S2 sleep state

System is entering S3 sleep state

System is entering S4 sleep state

System is entering S5 sleep state

System is waking up from the S1 sleep state

System is waking up from the S2 sleep state

System is waking up from the S3 sleep state

System is waking up from the S4 sleep state

System has transitioned into ACPI mode. Interrupt controller is in PIC mode.

System has transitioned into ACPI mode. Interrupt controller is in APIC mode.
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2.2.7 Internal connectors

1. Intel® Z77 Serial ATA 6.0 Gb/s connectors (7-pin SATA6G_1/2 [gray])
These connectors connect to Serial ATA 6.0 Gb/s hard disk drives via Serial ATA 6.0
Gb/s signal cables.
If you installed Serial ATA hard disk drives, you can create a RAID 0, 1, 5, and 10
configuration with the Intel® Rapid Storage Technology through the onboard Intel® 277
chipset.

GND.
RSATA_RXN1
RSATA_RXP1
GND.
RSATA_TXN1
RSATA_TXP1
GND.

GND.
RSATA_RXN2
RSATA_RXP2
GND.
RSATA_TXN2
RSATA_TXP2
GND.

T
I
I

SATA6G_1 SATA6G_2

(/ right-angle side  NOTE: Connect the right-angle side of

SATA signal cable to SATA device.

Or you may connect the right-angle side of
SATA cable to the onboard SATA port to
avoid mechanical conflict with

huge graphics cards.

R *  These connectors are set to [AHCI Mode] by default. If you intend to create a Serial
ATA RAID set using these connectors, set the SATA Mode item in the BIOS to [RAID
Mode]. Refer to section 3.5.3 SATA Configuration for details.

«  Before creating a RAID set, refer to section 4.4 RAID configurations or the manual
bundled in the motherboard support DVD.

«  When using NCQ, set the SATA Mode in the BIOS to [AHCI Mode]. Refer to section
3.5.3 SATA Configuration for details.

«  You must install Windows® XP Service Pack 3 or later versions before using Serial
ATA hard disk drives. The Serial ATA RAID feature is available only if you are using
Windows® XP SP3 or later versions.

ASUS P8Z77-V DELUXE 2-27
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2. Intel® Z77 Serial ATA 3.0 Gb/s connectors (7-pin SATA3G_3-6 [blue])

These connectors connect to Serial ATA 3.0 Gb/s hard disk drives and optical disc
drives via Serial ATA 3.0 Gb/s signal cables.

If you installed Serial ATA hard disk drives, you can create a RAID 0, 1, 5, and 10
configuration with the Intel® Rapid Storage Technology through the onboard Intel® 277

chipset.
7 O
o SATA3G_3 SATA3G_4
28 g¢ T T
gg g¢ 2 32
£ 2¢ £, 22
) 9559550 oikssio
3 8228223 goggsig
0 1 ==
-
e — g8 2¢ g¢ ¢
g¢ B¢ & 55
o = s55235s  oBfelie
i 8238288  34284i%
o o - =] =
— 3]
i} SATA3G_5 SATA3G_6

i SIE

P8277-V DELUXE Intel® SATA 3.0 Gb/s connectors

R e These connectors are set to [AHCI Mode] by default. If you intend to create a Serial
ATA RAID set using these connectors, set the SATA Mode item in the BIOS to [RAID
Mode]. Refer to section 3.5.3 SATA Configuration for details.

+  Before creating a RAID set, refer to section 4.4 RAID configurations or the manual
bundled in the motherboard support DVD.

*  When using NCQ, set the SATA Mode in the BIOS to [AHCI Mode]. Refer to section
3.5.3 SATA Configuration for details.

+  You must install Windows® XP Service Pack 3 or later versions before using Serial
ATA hard disk drives. The Serial ATA RAID feature is available only if you are using
Windows® XP SP3 or later versions.
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3. Marvell® Serial ATA 6.0 Gb/s connectors (7-pin SATA6G_E1/E2 [navy blue])

These connectors connect to Serial ATA 6.0 Gb/s hard disk drives via Serial ATA 6.0
Gbl/s signal cables.

o e 5
mm [ o
u]
=8
0 = 5 E@ i §§
) 3328332 3823328
~ s
= > =
o = J D 0o
o SATA6G_E1 SATA6G_E2
| ——
O poz77-v DELUXE -
— ]
5 (O
ol ® (11000 oo

P8277-V DELUXE Marvell® SATA 6.0 Gb/s connectors

A& «  You must install Windows® XP Service Pack 3 or later versions before using Serial ATA
hard disk drives.

*  When using NCQ, set the Marvell Storage Controller item in the BIOS to [Enabled)].
Refer to section 3.5.6 Onboard Devices Configuration for details.

¢ Press <Ctrl> + <M> during POST to enter the Marvell RAID utility to create or delete a
RAID configuration.

If you want to install a Windows operating system to a RAID configuration created
using the Marvell SATA controller, you have to create a RAID driver disk using the
motherboard support DVD and load the driver during OS installation. For 32/64bit
Windows XP OS, load first the Marvell shared library driver, and then load Marvell
91xx SATA Controller Driver. For Windows Vista / Windows 7 OS, load only the
Marvell 91xx SATA Controller Driver.

«  Connect one HDD and one SSD to Marvell® SATA6G_E1/E2 connectors for a high
performance of ASUS SSD Caching.

*  The SATA6G_E1/E2 connectors are recommended for regular use.

ASUS P8Z77-V DELUXE
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4. USB 3.0 connector (20-1 pin USB3_12)
This connector is for the additional USB 3.0 ports, and complies with the USB 3.0
specificaton that supports up to 480 MBps connection speed. If the USB 3.0 front panel
cable is available from your system chassis, with this USB 3.0 connector, you can have
a front panel USB 3.0 solution.

> USB3_12
s
Vbus
Vbus IntA_P1_SSRX-
IntA_P2_SSRX- IntA_P1_SSRX+
IntA_P2_SSRX+ GND
GND IntA_P1_SSTX-
IntA_P2_SSTX-~ =—IntA_P1_SSTX+
IntA P2 SSTX+ GND
GND IntA P1 D-
IntA P2 D- IntA P1 D+
IntA P2 D+ D

P8277-V DELUXE USB3.0 connector

4& ¢ The USB 3.0 box is purchased separately.
+  Due to Intel® limitations, the USB3_12 only supports Windows® 7 operating system.
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5. USB 2.0 connectors (10-1 pin USB1112; USB1314)

These connectors are for USB 2.0 ports. Connect the USB module cable to any of
these connectors, then install the module to a slot opening at the back of the system
chassis. These USB connectors comply with USB 2.0 specification that supports up to
48 MBps connection speed.

- GND
- NC

£

=

USB_P11+ —= =1 USB_P12+
-

-GND

I USB+5V
t-USB_P12-
[-NC

<
>3
D&
2
o o
oD
535
[

-
-
-
-

USB1314|_H

P8277-V DELUXE USB2.0 connectors

TJUSB1112

GND

USB+5V
USB_P13-
USB4+5V
USB_P11-

USB_P13+ —= #-USB_P14+

/ '\ Never connect a 1394 cable to the USB connectors. Doing so will damage the motherboard!

R You can connect the front panel USB cable to the ASUS Q-Connector (USB, blue) first, and
then install the Q-Connector (USB) to the USB connector onboard if your chassis supports
front panel USB ports.

% The USB 2.0 module is purchased separately.
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6. Digital audio connector (4-1 pin SPDIF_OUT)
This connector is for an additional Sony/Philips Digital Interface (S/PDIF) port(s).
Connect the S/PDIF Out module cable to this connector, then install the module to a
slot opening at the back of the system chassis.

D . éé SPDIF_OUT
- I

U —= O =

o — O D E 3 H
— w

o > I} o

o ) [o4

+ »nO

| —
O = OE DD

(21025 [ g g o 771

P8277-V DELUXE Digital audio connector

% The S/PDIF module is purchased separately.
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7. CPU, chassis, and power fan connectors
(4-pin CPU_FAN; 4-pin CPU_OPT; 4-pin CHA_FAN1-4)
Connect the fan cables to the fan connectors on the motherboard, ensuring that the
black wire of each cable matches the ground pin of the connector.

(~)
E» O CPU_FAN @ CPU_OPT ® CHA_FAN3

CPU FAN PWM
CPUFAN IN
CPU FAN PWR
GND

CHA_FAN1 @® CHA_FAN4 @ CHA_FAN2

GND CPU FAN PWM
CPU FAN PWR CPUFAN IN
CPUFAN IN CPU FAN PWR

G CPU FAN PWM GND

i
i

GND
GND

CPU FAN PWM
CPU FAN IN
CPU FAN PWR
CPU FAN PWM
CPU FAN IN
CPU FAN PWR

FEO0 = 1 Cmpd

P8277-V DELUXEFan connectors

CPU FAN PWR
CPU FAN IN
CPU FAN PWM

GND

Ii

O
-
)
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~

Do not forget to connect the fan cables to the fan connectors. Insufficient air flow inside the
) system may damage the motherboard components. These are not jumpers! Do not place
jumper caps on the fan connectors!

[

ﬂ *  The CPU_FAN connector supports the CPU fan of maximum 1A (12 W) fan power.

*  Only the CPU_FAN, CHA_FAN 1/2/3/4 connectors support the ASUS FAN Xpert 2
feature.

* Ifyou install two VGA cards, we recommend that you plug the rear chassis fan cable
to the motherboard connector labeled CHA_FAN1 or CHA_FAN2 for better thermal
environment.
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8. Front panel audio connector (10-1 pin AAFP)

This connector is for a chassis-mounted front panel audio I/O module that supports
either HD Audio or legacy AC 97 audio standard. Connect one end of the front panel
audio I/0 module cable to this connector.

SENSE2_RETUR

PRESENCE#
SENSE1_RETUR

MIC2 @ =) AGND
(a =-NC
(a =t-NC
(m o)
Line out_L —t=_®-NC

Line out_R

O PN

PIN1

NC

>
>
M
o
PORT1L (@ =} GND
(=)
(=)
(a o

PORT2L (= =

[m]
O
o

o

PORT1R
PORT2R
ENSE_SEND
MICPWR

| —— R
PeZ77V DELUXE C
© ]
O O @»
FK] HD-audio-compliant Legacy AC'97
=I5, e — e pin definition compliant definition

P8Z77-V DELUXE Analog front panel connector

Chapter 2

R + We recommend that you connect a high-definition front panel audio module to this
connector to avail of the motherboard’s high-definition audio capability.

If you want to connect a high-definition front panel audio module to this connector, set
the Front Panel Type item in the BIOS setup to [HD]; if you want to connect an AC'97
front panel audio module to this connector, set the item to [AC97]. By default, this
connector is set to [HD].

9.  ATX power connectors (24-pin EATXPWR; 8-pin EATX12V)

These connectors are for ATX power supply plugs. The power supply plugs are
designed to fit these connectors in only one orientation. Find the proper orientation and
push down firmly until the connectors completely fit.

(~)
—>
OEATX12V  @EATXPWR
% % % % -3 Volt: = GND
+3 Volts
i Q900 +12 Volts +5 Volts
+12 Volts +5 Volts
+5V Standby +5 Volts
Power OK -5 Volts
2888 GND GND
>>>> +5 Volts GND
P GND GND
+5 Volts PSON#
GND GND
+3 Volts -12 Volts
+3 Volts +3 Volts
PIN1

P8Z77-V DELUXE ATX power connectors
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For a fully configured system, we recommend that you use a power supply unit
(PSU) that complies with ATX 12 V Specification 2.0 (or later version) and provides a
minimum power of 350 W.

Do not forget to connect the 4-pin/8-pin EATX12 V power plug; otherwise, the system
will not boot.

Use of a PSU with a higher power output is recommended when configuring a system
with more power-consuming devices. The system may become unstable or may not
boot up if the power is inadequate.

If you want to use two or more high-end PCI Express x16 cards, use a PSU with
1000W power or above to ensure the system stability.

If you are uncertain about the minimum power supply requirement for your system,
refer to the Recommended Power Supply Wattage Calculator at http://support.asus.
com/PowerSupplyCalculator/PSCalculator.aspx?SLanguage=en-us for details.
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10.

System panel connector (20-8 pin PANEL)

This connector supports several chassis-mounted functions.

[m}
[m}
o

o

| —— R
PaZ77V DELUXE
— o
o g

it SO

@ 1 a0

PLED [SPEAKER

+

PANEL

PIN1

IDE_LED+
IDE_LED.

5]
m
—

(= =} PLED.
round (& = +5V
(2 =
(a =)
ta =)

PLED-
Ground
Ground
Speaker

PWR
Reset
Ground

G

P8Z77-V DELUXE System panel connector

System power LED (2-pin PLED)

This 2-pin connector is for the system power LED. Connect the chassis power LED
cable to this connector. The system power LED lights up when you turn on the system

power, and blinks when the system is in sleep mode.

Hard disk drive activity LED (2-pin IDE_LED)

This 2-pin connector is for the HDD Activity LED. Connect the HDD Activity LED cable
to this connector. The IDE LED lights up or flashes when data is read from or written to

the HDD.

System warning speaker (4-pin SPEAKER)

This 4-pin connector is for the chassis-mounted system warning speaker. The speaker

allows you to hear system beeps and warnings.

ATX power button/soft-off button (2-pin PWRSW)

This connector is for the system power button. Pressing the power button turns the
system on or puts the system in sleep or soft-off mode depending on the BIOS settings.
Pressing the power switch for more than four seconds while the system is ON turns the

system OFF.
Reset button (2-pin RESET)

This 2-pin connector is for the chassis-mounted reset button for system reboot without

turning off the system power.

ASUS P8Z77-V DELUXE
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2.3 Building your computer system

23.1 Additional tools and components to build a PC system

1 bag of screws

Philips (cross) screwdriver

PC chassis Power supply unit
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Intel LGA 1155 CPU

Graphics card (optional)

SATA optical disc drive (optional)

The tools and components in the table above are not included in the motherboard package.

N
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2.3.2 CPU installation

/ ' The LGA1156 CPU is incompatible with the LGA1155 socket. DO NOT install a LGA1156
Lo CPU on the LGA1155 socket.
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2.3.3 CPU heatsink and fan assembly installation

i'i Apply the Thermal Interface Material
[ to the CPU heatsink and CPU

efore you install the heatsink and
if necessary.

Chapter 2
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2.3.4 DIMM installation
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2.35 Motherboard installation

% The diagrams in this section are for reference only. The motherboard layout may vary with

models, but the installation steps remain the same.
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ATX Power connection

2.3.6

Chapter 2
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2.3.7 SATA device connection

OR

ASUS P8Z77-V DELUXE
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2.3.8 Front 1/0 Connector

To install ASUS Q-Connector

To install front panel audio
connector
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To install USB 2.0 Connector
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239 Expansion Card installation

To install PCle x16 cards

ASUS P8Z77-V DELUXE
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2.3.10 Wireless and Bluetooth Module Installation
Wi-Fi 802.11a/b/g/n, Bluetooth v4.0/3.0 + HS

' Ensure to disconnect the power supply unit from the motherboard before installing/
. uninstalling the Wireless and Bluetooth Module.

1.  Unfasten screw B from the Wireless & Bluetooth
Module.

2. Align the Module to the BT4 connector (the second item at the motherboard's back
10 area). Connect the pins and make sure the screw hole matches the hole on the

motherboard.
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3. Be sure to secure the Module to the motherboard
by properly fastening screw B from underneath the
motherboard.

2. Handle the screwdriver with care to avoid scratching the motherboard and causing
defects.

i 'i 1. The module MUST be screwed to the motherboard to avoid loosening during use.
L]
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Attach the |0 shield onto the computer chassis, and place the motherboard flatly into
the chassis.
Fasten the screws onto the motherboard.

Locate the connecting jacks of the Module from the exterior IO area of the computer
chassis, and attach the Wi-Fi Bluetooth Ring Moving Antenna. When you hear the
clicking sound, the antenna connectors are properly inserted. Give a slight pull to
determine that the installation is complete.

10 Shield

Be sure to install the BT4 driver before installing the Wi-Fi GO! software.

N
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2.3.11 USB BIOS Flashback

USB BIOS Flashback offers the most convenient way to flash the BIOS. It allows overclockers
to try new BIOS versions easily without having to enter their existing BIOS or operating
system. Just plug in USB storage and push the dedicated button for 3 seconds, and the
BIOS is automatically flashed using standby power. Worry-free overclocking for the ultimate
convenience!

1 Download the BIOS Flashback program from the ASUS service website (www.asus.com).
Save it to a USB portable disk, and place it in the root directory.

Plug the USB flash drive to the bottom port LAN1_USB3_34 connector in the back 1/0.

Press the BIOS Flashback button for 3 seconds, and the light will begin to flash (on the
third second).

The Flashback function is enabled once the light starts to flash.
The flashing rate of the light signal accelerates along with the updating speed.
6.  BIOS update is complete once the light signal goes out.

(@)
>
g ==
@ = —
N == e
[—| = [(—)
USB BIOS Flashback port
//'\\ 1. Do not unplug portable disk, power system, or press the CLR_CMOS button while
v\ BIOS update is ongoing, otherwise update will be interrupted. In case of interruption,

please follow the recommended procedures again to complete BIOS update.

2. If the light flashes for five seconds and turns into a stable lighting, this means that
the BIOS Flashback is not operating properly. This may be caused by:1. Improper
installation of the portable disk.2. Error in file name or incompatibility in file format.If
this is the case, please restart the system to turn off the light.

3. Updating BIOS may have risks. If the BIOS program is damaged during the process
causing the system unable to reboot, please contact the local service station for help.
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2.3.12

Rear panel connection

Rear panel connectors

1. USB2.0ports5,6,7and8 8. DisplayPort
2. ASMedia USB 3.0 ports 3 and 4,
support ASUS USB 3.0 Boost UASP 9. HDMI port
Mode
10. ASMedia USB 3.0 ports 1 and 2,
3. Optical S/PDIF Out port support ASUS USB 3.0 Boost UASP
Mode
4. Realtek® LAN (RJ-45) port** 11. USB BIOS Flashback button
12. Intel USB 3.0 ports 3 and 4, support
5. Intel® LAN (RJ-45) port** ASUS USB 3.0 Boost UASP Mode.
(Recommended for single LAN usage) Bottom port supports USB BIOS
Flashback and USB Charger+
6. ASUS Wi-Fi GO! card (Wi-Fi 802.11 ) -
and Bluetooth v4.0/30.+HS)* 13. Audio I/G ports
7. External SATA ports 1 and 2

*, ** and ***: Refer to the tables on the next page for LAN port LED, and audio port definitions.

i

Due to Intel® limitations, the USB3_1-2 only support Windows® 7 operating system.

ASUS P8Z77-V DELUXE
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R *  Press the Clear CMOS switch to clear BIOS setup information only when the system
hangs due to overclocking.

+ DO NOT insert a different connector to the external SATA port.

. Due to USB 3.0 controller limitation, USB 3.0 devices can only be used under
Windows® OS environment and after the USB 3.0 driver installation.

*  USB 3.0 devices can only be used as data storage only.

*  We strongly recommend that you connect USB 3.0 devices to USB 3.0 ports for faster
and better performance for your USB 3.0 devices.

*  Ifyou want to use the hot-plug function of the external SATA ports, you have to set the
ASMedia” 1061 SATA controllers item in the BIOS setting to [Enabled] and install
the ASMedia® 1061 SATA controllers from the motherboard support DVD. Refer to
section 3.5.6 Onboard Devices Configuration for detalils.

* Bluetooth module LED indications *Wi-Fi LED indications

Status Description Status Description

off No link Off No fink
|BIue Linked |Green Linked
IBIinking Data activity

% ASUS Wi-Fi GO! card automatically sets itself to the country's available Wi-Fi channels,

** LAN ports LED indications

Activity Link LED Speed LED ACT/LINK SPEED

LEP LIED
OFF No link OFF 10 Mbps connection & &
ORANGE Linked ORANGE | 100 Mbps connection I:l—l
BLINKING Data activity GREEN 1 Gbps connection LAN port

*** Audio 2, 4, 6, or 8-channel configuration
Port Headset 4-channel 6-channel 8-channel
2-channel

Light Blue |Line In Line In Line In Line In
Lime Line Out Front Speaker Out  |Front Speaker Out  |Front Speaker Out
Pink Mic In Mic In Mic In Mic In
Orange - - Center/Subwoofer  |Center/Subwoofer
Black - Rear Speaker Out  |Rear Speaker Out  |Rear Speaker Out
Gray - - - Side Speaker Out
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2.3.13 Audio I/O connections

Audio I/O ports

. @ orange O
. @ black ®
®® | =@

light blue

lime

pink

Connect to Headphone and Mic

Connect to Stereo Speakers

® =[m
© ©
© ©
[ [

Connect to 2.1 channel Speakers

{1 [T}

@ =[Tm

AUDIO
INPUTS

i B,

ASUS P8Z77-V DELUXE
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Connect to 4.1 channel Speakers
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AUDIO  AUDIO  AUDIO
INPUTS INPUTS INPUTS

feoe)
@ @
[©] ©
l l

Connect to 7.1 channel Speakers
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% When the DTS UltraPC Il function is enabled, ensure to connect the rear speaker to the
gray port.
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2.4

SARE T A I

7.

2.5

While the system is ON, pressing the power switch for less than four seconds puts the system
on sleep mode or soft-off mode, depending on the BIOS setting. Pressing the power switch
for more than four seconds lets the system enter the soft-off mode regardless of the BIOS

Starting up for the first time

After making all the connections, replace the system case cover.

Be sure that all switches are off.

Connect the power cord to the power connector at the back of the system chassis.
Connect the power cord to a power outlet that is equipped with a surge protector.

Turn on the devices in the following order:
a.  Monitor

b.  External SCSI devices (starting with the last device on the chain)

c. System power

After applying power, the system power LED on the system front panel case lights up.
For systems with ATX power supplies, the system LED lights up when you press the
ATX power button. If your monitor complies with the “green” standards or if it has a
“power standby” feature, the monitor LED may light up or change from orange to green

after the system LED turns on.

The system then runs the power-on self tests or POST. While the tests are running, the
BIOS beeps (refer to the BIOS beep codes table below) or additional messages appear
on the screen. If you do not see anything within 30 seconds from the time you turned
on the power, the system may have failed a power-on test. Check the jumper settings

and connections or call your retailer for assistance.

BIOS Beep Description

One short beep

VGA detected
Quick boot set to disabled
No keyboard detected

One continuous beep followed by two
short beeps then a pause (repeated)

No memory detected

One continuous beep followed by three
short beeps

No VGA detected

One continuous beep followed by four
short beeps

Hardware component failure

At power on, hold down the <Delete> key to enter the BIOS Setup. Follow the

instructions in Chapter 3.

Turning off the computer

setting.

ASUS P8Z77-V DELUXE
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Knowing B10S

3.1
The new ASUS UEFI BIOS is a Unified Extensible Interface that complies with UEFI
architecture, offering a user-friendly interface that goes beyond the traditional keyboard-
V only BIOS controls to enable a more flexible and convenient mouse input. Users can easily
navigate the new UEFI BIOS with the same smoothness as their operating system. The
term “BIOS” in this user manual refers to “UEFI BIOS” unless otherwise specified.

BIOS (Basic Input and Output System) stores system hardware settings such as storage
device configuration, overclocking settings, advanced power management, and boot device
configuration that are needed for system startup in the motherboard CMOS. In normal
circumstances, the default BIOS settings apply to most conditions to ensure optimum
performance. We recommend that you not change the default BIOS settings except in
the following circumstances:

*  An error message appears on the screen during the system bootup and requests you to
run the BIOS Setup.

*  You have installed a new system component that requires further BIOS settings or
update.

' Inappropriate settings of the BIOS may result to instability or failure to boot. We strongly
H recommend that you change the BIOS settings only with the help of a trained service
personnel.

3.2 BI1OS setup program

A BIOS setup program is provided for BIOS item modification. When you start up the
computer, the system provides you with the opportunity to run this program. Press <Del>
during the Power-On Self-Test (POST) to enter the Setup utility. Otherwise, POST continues
with its test routines.

If you wish to enter Setup after POST, press <Ctrl> + <Alt> + <Delete>, or press the reset
button on the system chassis to restart the system. You can also turn the system off and then
turn it back on to restart the system. Do this last option only if the first two failed.

z\§\\ *  The BIOS setup screens shown in this section are for reference purposes only, and
may not exactly match what you see on your screen.

¢ Ensure that a USB mouse is connected to your motherboard if you want to use the
mouse to control the BIOS setup program.

«  If the system becomes unstable after changing any BIOS setting, load the default
settings to ensure system compatibility and stability. Select the Load Optimized
Defaults item under the Exit menu. See section 3.9 Exit Menu for details.

«  Ifthe system fails to boot after changing any BIOS setting, try to clear the CMOS and
reset the motherboard to the default value. See section 2.2.5 Onboard switches for
information on how to erase the RTC RAM.

¢ The BIOS setup program does not support the bluetooth devices.

The BIOS setup program is designed to make it as easy to use as possible. Being a
menu-driven program, it lets you scroll through the various submenus and select from the
available options using a keyboard or a USB mouse.

The BIOS setup program can be used under two modes: EZ Mode and Advanced Mode.
You can change modes from the Exit menu or from the Exit/Advanced Mode button in the
EZ Mode/Advanced Mode screen.
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3.2.1 EZ Mode

By default, the EZ Mode screen appears when you enter the BIOS setup program. The EZ
Mode provides you an overview of the basic system information, and allows you to select
the display language, system performance mode and boot device priority. To access the
Advanced Mode, click Exit/Advanced Mode, then select Advanced Mode or press F7 hot
key for the advanced BIOS settings.

The default screen for entering the BIOS setup program can be changed. Refer to the
Setup Mode item in section 3.7 Boot memu for details.

Clicks to display all fan

Selects the display language of speeds if available

the BIOS setup program

Displays the CPU/motherboard temperature, Exits the BIOS setup program without saving
CPU/5V/3.3V/12V voltage output, the changes, saves the changes and resets the
CPU/chassis/power fan speed system, or enters the Advanced Mode

xit/Advanced Mode

P8Z77-V Deluxe English v
BIOS Version : 0306 Build Date : 11/08/2012
CPU Type : Genuine Intel(R) CPU 0 @ 3.10GHz Speed : 3400 MHz

Monday [12/01/2012] Total Memory : 1024 MB (DDR3 1333MHz)

2 !
I' Temperature f Voltage w%* Fan Speed i

CPU +113.0°F/+45.0° CPU 8V 5.160V CPU_FAN M  CPU_OPT_FAN N/A
[ [

3.3V 3.3 2: CHA_FAN1 /A CHA_FAN2 N/A
i
i

Gl system Performance

Quiet

T

Performance Energy Saving
Normal

Y Boot Priority

Use tlie mouse to drag or keyboard to navigate to dec|de the Hoot priority.

Shortcut (F3) Advanced Mode (F7) Boot Menu(F8) Default(F5)

Displays the Advanced
mode menus

Selects the boot device priority

Power Saving mode Loads optimized default

Normal mode ASUS Optimal mode

Displays the system properties of the ~ Selects the boot device priority
Selects the Advanced mode functions  selected mode on the right hand side

% »  The boot device options vary depending on the devices you installed to the system.

*  The Boot Menu(F8) button is available only when the boot device is installed to the
system.
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3.2.2 Advanced Mode

The Advanced Mode provides advanced options for experienced end-users to configure
the BIOS settings. The figure below shows an example of the Advanced Mode. Refer to the
following sections for the detailed configurations.

% To access the Advanced Mode, click Exit, then select Advanced Mode or press F7 hotkey.

Back button Menu items Menu bar Configuration fields General help

i eaker Advanced

Advahced\ Onboard Devices Configuration >

bled/Disabled Bluetooth Control
HD Audio Controller Enabled

Front Panel Type HD

SPDIF Out Type SPDIF

Bluetooth Controller Enabled

Express X1_2 Slot (Blu uTO
3luetooth Cc

ASM1061 Storage Controller Disabled Enabled

Enabled
ASM1061 Storage OPROM Enabled

ASM1061 Storage Controller (Rear) Enabled
ASM1061 Storage OPROM Enabled

Realtek LAN Controller Enabled
Change Opt

Realtek PXE OPROM Disabled General Help

ASMedia USB 3.0 Controller Enabled ) Default

ASMedia USB 3.0 Battery Charging Support Enabled

Submenu item Pop-up window Scroll bar Navigation keys

(90]
1
Q
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o
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Menu bar
The menu bar on top of the screen has the following main items:

For changing the basic system configuration
Ai Tweaker For changing the overclocking settings
Advanced For changing the advanced system settings

For displaying the system temperature, power status, and changing the
fan settings.

Monitor

For changing the system boot configuration
For configuring options for special functions
For selecting the exit options and loading default settings

ASUS P8Z77-V DELUXE 33



Menu items
The highlighted item on the menu bar displays the specific items for that menu. For example,
selecting Main shows the Main menu items.

The other items (Ai Tweaker, Advanced, Monitor, Boot, Tool, and Exit) on the menu bar have
their respective menu items.

Back button

This button appears when entering a submenu. Press <Esc> or use the USB mouse to click
this button to return to the previous menu screen.

Submenu items

A greater than sign (>) before each item on any menu screen means that the item has a
submenu. To display the submenu, select the item and press <Enter>.

Pop-up window
Select a menu item and press <Enter> to display a pop-up window with the configuration
options for that item.

Scroll bar

A scroll bar appears on the right side of a menu screen when there are items that do not fit on
the screen. Press the Up/Down arrow keys or <Page Up> / <Page Down> keys to display the
other items on the screen.

Navigation keys

At the bottom right corner of the menu screen are the navigation keys for the BIOS setup
program. Use the navigation keys to select items in the menu and change the settings.

General help

At the top right corner of the menu screen is a brief description of the selected item. Use
<F12> key to capture the BIOS screen and save it to the removable storage device.
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Configuration fields

These fields show the values for the menu items. If an item is user-configurable, you can
change the value of the field opposite the item. You cannot select an item that is not
user-configurable.

A configurable field is highlighted when selected. To change the value of a field, select it and
press <Enter> to display a list of options.
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3.3 Main menu

The Main menu screen appears when you enter the Advanced Mode of the BIOS Setup
program. The Main menu provides you an overview of the basic system information, and
allows you to set the system date, time, language, and security settings.

System Language English
Fri 11/08/2012]

System Date
16:46:15]

System Time

> Security

Security
The Security menu items allow you to change the system security settings.

jain\ Security >
To clear the administrator pa
key in the current pa:

Chapter 3

Administrator Password
User Password

/ « Ifyou have forgotten your BIOS password, erase the CMOS Real Time Clock
(RTC) RAM to clear the BIOS password. See section 2.3.5 Onboard switches for

- information on how to erase the RTC RAM.

The Administrator or User Password items on top of the screen show the default
Not Installed. After you set a password, these items show Installed.
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Administrator Password

If you have set an administrator password, we recommend that you enter the administrator
password for accessing the system. Otherwise, you might be able to see or change only
selected fields in the BIOS setup program.

To set an administrator password:

1. Select the Administrator Password item and press <Enter>.

2. From the Create New Password box, key in a password, then press <Enter>.
3. Confirm the password when prompted.

To change an administrator password:
1. Select the Administrator Password item and press <Enter>.

2. From the Enter Current Password box, key in the current password, then press
<Enter>.

3. From the Create New Password box, key in a new password, then press <Enter>.
4.  Confirm the password when prompted.
To clear the administrator password, follow the same steps as in changing an administrator

password, but press <Enter> when prompted to create/confirm the password. After you clear
the password, the Administrator Password item on top of the screen shows Not Installed.

User Password

If you have set a user password, you must enter the user password for accessing the system.
The User Password item on top of the screen shows the default Not Installed. After you set
a password, this item shows Installed.

To set a user password:

1. Select the User Password item and press <Enter>.

2. From the Create New Password box, key in a password, then press <Enter>.
3. Confirm the password when prompted.
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To change a user password:
1. Select the User Password item and press <Enter>.

2. From the Enter Current Password box, key in the current password, then press
<Enter>.

3. From the Create New Password box, key in a new password, then press <Enter>.
4. Confirm the password when prompted.

To clear the user password, follow the same steps as in changing a user password, but press
<Enter> when prompted to create/confirm the password. After you clear the password, the
User Password item on top of the screen shows Not Installed.
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3.4 Ai Tweaker menu

The Ai Tweaker menu items allow you to configure overclocking-related items.

2\
/ '\ Be cautious when changing the settings of the Ai Tweaker menu items. Incorrect field
L e values can cause the system to malfunction.

% The configuration options for this section vary depending on the CPU and DIMM model you
installed on the motherboard.

Ai Tweaker

Target CPU Speed : 3700MHz
M.P.] When XMP is enabled BLC

frequency, CPU ratio and memor

Target DRAM Speed : 1333MHz

parameters w uto optimizec

Ai Overclock Tuner

Turbo Ratio

Internal PLL Overvoltage

CPU Bus speed : DRAM speed ratio mode
Memory Frequency

EPU Power Saving Mode

> OC Tuner

Select Scree
> DRAM Timing Control Select Iter \‘
elect

> CPU Power Management nge Opt

> DIGI+ Power Control

CPU Voltage Offset Mode

Scroll down to display the following items:

Offset Mode Sign
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CPU Offset Voltage

3 HE HH H3HE
H H B H B B B B
N

DRAM Voltage

VCCSA Voltage

VCCIO Voltage

CPU PLL Voltage
PCH Voltage

DRAM DATA REF Voltage on CHA +/-: Change O

DRAM CTRL REF Voltage on CHA

DRAM DATA REF Voltage on CHB

F12: Print Screen

DRAM CTRL REF Voltage on CHB

CPU Spread Spectrum
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Ai Overclock Tuner [Auto]

Allows you to select the CPU overclocking options to achieve the desired CPU internal
frequency. Select any of these preset overclocking configuration options:

[Auto] Loads the optimal settings for the system.
[Manual] Allows you to individually set overclocking parameters.
[X:-M.P] If you install memory modules supporting the eXtreme Memory Profile

(X.M.P.) Technology, choose this item to set the profiles supported by your
memory modules for optimizing the system performance.

% The following two items appear only when you set the Ai Overclocking Tuner to [Manual].

BCLK/PCIE Frequency [XXX]

Allows you to adjust the CPU and VGA frequency to enhance the system performance. Use
the <+> and <-> keys to adjust the value. You can also key in the desired value using the
numeric keypad. The values range from 80.0MHz to 300.0MHz.

eXtreme Memory Profile
This item appears only when you set the Ai Overclocking Tuner item to [X.M.P.] and
allows you to select the X.M.P. mode supported by your memory module.

Configuration options: [Profile #1] [ Profile #2]

Turbo Ratio [Auto]
Allows you to set the CPU ratio automatically or manually.

[Auto] Sets all Turbo Ratio to Intel® CPU default settings automatically.
[Manual]  Sets the Turbo Ratio for every core-activation condition of a full unlocked
CPU manually.

% When the Turbo Ratio is set to [Manual], the following item appears:

Ratio Synchronizing Control [Enabled]
[Enabled] Allows you to set an individual Turbo Ratio for every core-activation condition
[Disabled] Allows you to set one single Turbo Ratio for all core-activation conditions.

1-Core Ratio Limit [Auto]

Allows you to set the 1-Core Ratio Limit

[Auto] Select to apply the CPU default Turbo Ratio setting

[Manual]  Select to to manually assign a 1-Core Ration Limit value that is higher
than or equal to the 2-Core Ratio Limit.
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2-Core Ratio Limit [Auto]

Allows you to set the 2-Core Ratio Limit

[Auto] Select to apply the CPU default Turbo Ratio setting

[Manual]  Select to to manually assign a 2-Core Ratio Limit value that is higher than
or equal to the 3-Core Ratio Limit. 1-Core Limit must not be set to [Auto]
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3-Core Ratio Limit [Auto]

Allows you to set the 3-Core Ratio Limit

[Auto] Select to apply the CPU default Turbo Ratio setting

[Manual]  Select to to manually assign a 3-Core Ratio Limit value that is higher than
or equal to the 4-Core Ratio Limit. 1-Core/2-Core Ratio Limit must not be
set to [Auto]

4-Core Ratio Limit [Auto]

Allows you to set the 4 Core Ratio Limit

[Auto] Select to apply the CPU default Turbo Ratio setting

[Manual]  Select to to manually assign a 4-Core Ratio Limit value that is higher than
or equal to the 3-Core Ratio Limit. 1-Core/2-Core/3-Core Limit must not
be set to [Auto]

Internal PLL Overvoltage [Auto]

Allows you to set the internal PLL voltage.
Configuration options: [Auto] [Enabled] [Disabled]

Memory Frequency [Auto]

Allows you to set the memory operating frequency. The configuration options vary with the
BCLK/PCIE Frequency item settings.

iGPU Max. Frequency [Auto]

Use the <+> and <-> keys to adjust the value. The values range from 900MHz to 3000MHz
with a 50MHz interval.

CPU bus speed : DRAM speed ratio mode [Auto]

Allows you to set the CPU bus speed to DRAM speed ratio mode.

[Auto] DRAM speed is set to the optimized settings.

[100:133] The CPU bus speed to DRAM speed ratio is set to 100:133.
[100:100} The CPU bus speed to DRAM speed ratio is set to 100:100.

EPU Power Saving Mode [Disabled]

Allows you to enable or disable the EPU power saving function.
Configuration options: [Disabled] [Enabled]
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EPU Setting [Auto]

This item appears only when you set the EPU Power Saving MODE item to [Enabled.] and
allows you to select the EPU power saving mode.

Configuration options: [Auto] [Light Power Saving Mode] [Medium Power Saving Mode] [Max
Power Saving Mode]

OC Tuner

OC Tuner automatically overclocks the frequency and voltage of CPU and DRAM for
enhancing the system performance. Configuration options: [OK] [Cancel]
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DRAM Timing Control

The sub-items in this menu allow you to set the DRAM timing control features. Use the <+>
and <-> keys to adjust the value. To restore the default setting, type [auto] using the keyboard
and press the <Enter> key.

\ Changing the values in this menu may cause the system to become unstable! If this
e happens, revert to the default settings.

Al Tweaker
er\ DRAM Timing Control >
M.P.] When XMP is enabled BLC
DRAM CAS# Latency g frequency, CPU ratio and memor
>arameters will be auto optimizec
DRAM RAS# to CAS# Dela y
DRAM RAS# PRE Time

DRAM RAS# ACT Time

DRAM COMMAND Mode

DRAM RAS# to RAS# Delay
DRAM REF Cycle Time
DRAM Refresh Interval
DRAM WRITE Recovery Time
DRAM READ to PRE Time
DRAM FOUR ACT WIN Time
DRAM WRITE to READ Time
: Print Screen

DRAM CKE Minimum pulse width

DRAM CAS# Write Latency

> > N> >z N>
& B e B3 B
51 - K S @S §s

>

Megatrend:

DRAM RTL (CHA) CHADO: 32, CHADI:

DRAM RTL (CHB)

tWRDR (DD)
tRWDR (DD)
tRWSR

tRR (DD)

tRR (DR)

tRRSR

tWW (DD)

tWW (DR)

> > > > > > > > > > >
A BB B AE 4 B
HE BEE BEH 3 E 4 B

tWWSR

MRC fast Boot Enabled
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Primary Timings

DRAM CAS# Latency [Auto]
Configuration options: [Auto] [3 DRAM Clock] — [15 DRAM Clock]

DRAM RAS# to CAS# Delay [Auto]
Configuration options: [Auto] [4 DRAM Clock] — [15 DRAM Clock]

DRAM RAS# PRE Time [Auto]
Configuration options: [Auto] [4 DRAM Clock] — [15 DRAM Clock]

DRAM RAS# ACT Time [Auto]
Configuration options: [Auto] [4 DRAM Clock] — [40 DRAM Clock]

DRAM COMMAND Mode [Auto]
Configuration options: [Auto] [1 DRAM Clock] [2 DRAM Clock] [3 DRAM Clock]

Secondary Timings

DRAM RAS# to RAS# Delay [Auto]
Configuration options: [Auto] [4 DRAM Clock] — [7 DRAM Clock]

DRAM REF Cycle Time [Auto]
Configuration options: [Auto] [48 DRAM Clock] — [511 DRAM Clock]

DRAM Refresh Interval [Auto]
Configuration options: [Auto] [48 DRAM Clock] — [511 DRAM Clock]

DRAM WRITE Recovery Time [Auto]
Configuration options: [Auto] [5 DRAM Clock] — [31 DRAM Clock]

DRAM READ to PRE Time [Auto]
Configuration options: [Auto] [4 DRAM Clock] — [15 DRAM Clock]

DRAM FOUR ACT WIN Time [Auto]
Configuration options: [Auto] [16 DRAM Clock] — [63 DRAM Clock]

DRAM WRITE to READ Delay [Auto]
Configuration options: [Auto] [4 DRAM Clock] — [15 DRAM Clock]

DRAM CKE Minimum pulse width [Auto]

Configuration options: [Auto] [4 DRAM Clock] — [15 DRAM Clock]
DRAM CAS# Write to Latency [Auto]

Configuration options: [Auto] [1 DRAM Clock] — [15 DRAM Clock]

Chapter 3

DRAM RTL (CHA) [Auto]

Configuration options: [Auto] [1 DRAM Clock] — [15 DRAM Clock]
DRAM RTL (CHB) [Auto]

Configuration options: [Auto] [1 DRAM Clock] — [15 DRAM Clock]
Third Timings

tWRDR (DD) [Auto]
Configuration options: [Auto] [0 DRAM Clock] — [7 DRAM Clock]
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IRWDR (DD) [Auto]
Configuration options: [Auto] [0 DRAM Clock] — [15 DRAM Clock]

IRWSR [Auto]
Configuration options: [Auto] [0 DRAM Clock] — [15 DRAM Clock]

IRR (DD) [Auto]
Configuration options: [Auto] [0 DRAM Clock] — [7 DRAM Clock]

tRR (DR) [Auto]
Configuration options: [Auto] [0 DRAM Clock] — [7 DRAM Clock]

IRRSR [Auto]
Configuration options: [Auto] [0 DRAM Clock] — [15 DRAM Clock]

tWW (DD) [Auto]
Configuration options: [Auto] [0 DRAM Clock] — [7 DRAM Clock]

tWW (DR) [Auto]
Configuration options: [Auto] [0 DRAM Clock] — [7 DRAM Clock]

IWWSR [Auto]
Configuration options: [Auto] [0 DRAM Clock] — [15 DRAM Clock]

MRC Fast Boot

Allows you to enable or disable the MRC fast boot.

[Enabled] Enables the MRC fast boot.
[Disable] Disables the function.CPU Power Management

CPU Power Management
The sub-items in this menu allow you to set the CPU ratio and features.

CPU Ratio [Auto]

Allows you to manually adjust the maximum non-turbo CPU ratio. Use <+> and <-> keys to
adjust the value. The valid value ranges vary according to your CPU model.

Enhanced Intel SpeedStep Technology [Enabled]
Allows you to enable or disable the Enhanced Intel® SpeedStep Technology (EIST).

[Disabled] Disables this function.

[Enabled] The operating system dynamically adjusts the processor voltage and
core frequency which may result in decreased average consumption and
decreased average heat production.

Turbo Mode [Enabled]

Allows you to enable your core processor’s speed to run faster than the marked
frequency in a specific condition.

Configuration options: [Disabled] [Enabled]

% The following items appears only when you set the Turbo Mode to [Enabled].
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Long Duration Power Limit [Auto]
Allows you to limit the turbo ratio’s long duration power.
Use the <+> and <-> keys to adjust the value.

Long Duration Maintained [Auto]
Allows you to maintain the turbo ratio’s long duration power.
Use the <+> and <-> keys to adjust the value.

Short Duration Power Limit [Auto]
Allows you to limit the turbo ratio’s long duration power.
Use the <+> and <-> keys to adjust the value.

Primary Plane Current Limit [Auto]
Maximum instantaneous current allowed at any given time for CPU cores
Use <+> and <-> key to adjust the value at 0.125A increment. .

Secondary Plane Current Limit [Auto]
Maximum instantaneous current allowed at any given time for Internal Graphics cores.
Use <+> and <-> key to adjust the value at 0.125A increment.

DIGI+ Power Control

CPU Load-Line Calibration [Auto]

Load-line is defined by Intel VRM spec and affects CPU voltage. The CPU working voltage
will decrease proportionally to CPU loading. Higher value gets a higher voltage and better
overclocking performance, but increases the CPU and VRM thermal. This item allows you to
adjust the voltage range from the following percentages to boost the system performance:
0% (Regular), 25% (Medium), 50% (High), 75% (Ultra High) and 100% (Extreme).
Configuration options: [Auto] [Regular] [Medium] [High] [Ultra High] [Extreme]

% The actual performance boost may vary depending on your CPU specification.

CPU Voltage Frequency [Auto]

Frequency switching affects the VRM transient response, and the thermal component. Higher
frequency gets quicker transient response.
Configuration options: [Auto] [Manual]

/a\
/ '\ DO NOT remove the thermal module when switching to Manual Mode. The thermal
Lo \ conditions should be monitored.

VRM Spread Spectrum [Disabled]

This item appears only when you set the Frequency item to [Auto] and allows you to enable
the spread spectrum to enhance system stability.

VRM Fixed Frequency Mode [XXX]

This item appears only when you set the VRM Frequency item to [Manual] and allows you to
set a fixed VRM frequency. Use the <+> and <-> keys to adjust the value. The values range
from 300k Hz to 500k Hz with a 10k Hz interval.

ASUS P8Z77-V DELUXE
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CPU Power Phase Control [Auto]

Allows you to control the power phase based on the CPU’s demands.
Configuration options: [Auto] [Standard] [Optimized] [Extreme] [Manual Adjustment]

)
/ ' i DO NOT remove the thermal module when switching to Extreme and Manual Mode. The
(e thermal conditions should be monitored.

CPU Power Duty Control [T.Probe]

DIGI + VRM Duty control adjusts the current and thermal conditions of every component’s
phase.
Configuration options: [T. Probe] - Select to maintain the VRM thermal balance.

[Extreme] - Select to maintain the current VRM balance.

CPU Current Capability [100%)]

Allows you to configure the total power range, and extends the overclocking frequency range
simultaneously.

Configuration options: [100%)] [110%] [120%] [130%] [140%]

% Choose a higher value when overclocking, or under a high CPU loading for extra power
support.

CPU Power Thermal Control [130]

A higher temperature brings a wider CPU power thermal range and extends the overclocking
tolerance to enlarge the O.C. potential. Use the <+> and <-> keys to adjust the value. The
values range from 130 to 151.

/
/ ' DO NOT remove the thermal module. The thermal conditions should be monitored.

CPU Power Response Control [Auto]

The DIG+ VRM controller provides a faster, and precise power response rate for the CPU.
Apply a higher value for an extreme overclocking.
Configuration options: [Auto] [Regular: 100%] [Medium: 150%)] [Fast: 200%)]

[Ultra Fast: 250%]

ﬂ The actual performance boost may vary depending on your CPU configuration.

iEPU Load-line Calibration [Auto]

Allows you to set the iGPU Load-line Calibration.
Configuration options: [Auto] [Regular] [High] [Extreme]

iGPU Current Capability [100%)]

Allows you to set the iGPU Current Capability.
Configuration options: [100%)] [110%)] [120%)] [130%] [140%)]

)
/ ' DO NOT remove the thermal module while changing the DIGI+ VRM related parrameters .
. The thermal conditions should be monitored.
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% Some of the following items are adjusted by typing the desired values using the numeric

keypad and press the <Enter> key. You can also use the <+> and <-> keys to adjust the
value. To restore the default setting, type [auto] using the keyboard and press the <Enter>
key.

DRAM Current Capability [Auto]

A higher value brings a wider total power range, and extends the overclocking range
simultaneously.
Configuration options: [100%)] [110%)] [120%] [130%]

DRAM Voltage Frequency [Auto]

Allows you to adjust the DRAM switching frequency. Assign a fixed high DRAM frequency to
increase the O.C. range, or a low DRAM frequency for a better system stability.
Configuration options: [Auto] [Manual]

DRAM Fixed Frequency Mode [300]

This item only appears when you set the DRAM Frequency Mode item to [Manual], and
allows you to set a fixed DRAM frequency. Use the <+> and <-> keys to adjust the value. The
values range from 300k Hz to 500k Hz with a 10k Hz interval.

DRAM Power Phase Control [Auto]

[Auto] Allows you to set the Auto mode.
[Optimized] Allows you to set the ASUS optimized phase tuning profile.
[Extreme] Allows you to set the full phase mode.

DRAM Power Thermal Control [110]

A higher temperature brings a wider DRAM power thermal range, and extends the
overclocking tolerance to enlarge the O.C. potential. Use the <+> and <-> keys to adjust the
value. The values range from 110 to 131.

)
/ '\ DO NOT remove the thermal module. The thermal conditions must be monitored.
( L

CPU Voltage [Offset Mode]
[Manual Mode]  Allows you to set a fixed CPU voltage.
[Offset Mode]  Allows you to set the Offset voltage.

Offset Mode Sign [+]
This item appears only when you set the CPU Voltage item to [Offset Mode].
[+] To offset the voltage by a positive value.
[-] To offset the voltage by a negative value.
CPU Offset Voltage [Auto]
This item appears only when you set the CPU Voltage item to [Offset Mode] and

allows you to set the Offset voltage. The values range from 0.005V to 0.635V with a
0.005V interval.
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CPU Manual Voltage [Auto]

This item appears only when you set the CPU Voltage item to [Manual Mode] and
allows you to set a fixed CPU voltage. The values range from 0.800V to 1.990V with a
0.005V interval.

)
/ ' Refer to the CPU documentation before setting the CPU voltage. Setting a high voltage
. may damage the CPU permanently, and setting a low voltage may make the system

unstable.

iGPU Voltage [Offset Mode]

[Manual Mode] Allows you to set a fixed iGPU voltage.
[Offset Mode] Allows you to set the offset voltage.
IGPU Offset Mode Sign [+]

[+]  To offset the voltage by a positive value.
[] To offset the voltage by a negative value.

IGPU Offset Voltage [Auto]
Allows you to set the iGPU Offset voltage. The values range from 0.005V to 0.635V
with a 0.005V interval.

iGPU Manual Voltage [Auto]

This item appears only when you set the iGPU Voltage to [Manual Mode], and allows you to
set a fixed iGPU voltage. The values range from 0.800V to 1.990V with a 0.005V interval.

DRAM Voltage [Auto]

Allows you to set the DRAM voltage. The values range from 1.20V to 1.99V with a 0.005V
interval.

//' According to Intel CPU specifications, DIMMs with voltage requirement over 1.65V may
N damage the CPU permanently. We recommend you install the DIMMs with the voltage
requirement below 1.65V.

VCCSA Voltage [Auto]

Allows you to set the VCCSA voltage. The values range from 0.80V to 1.70V with a 0.00625V
interval.

VCCIO Voltage [Auto]

Allows you to set the VCCIO voltage. The values range from 0.80V to 1.70V with a 0.00625V
interval.

CPU PLL Voltage [Auto]

Allows you to set the CPU and PCH PLL voltage. The values range from 1.20V to 2.20V with
a 0.00625V interval.

PCH Voltage [Auto]

Allows you to set the Platform Controller Hub voltage. The values range from 0.80V to 1.70V
with a 0.01V interval.
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The values of the CPU PLL Voltage, CPU Manual Voltage, CPU Offset Voltage,

iGPU Manual Voltage, iGPU Offset Voltage, DRAM Voltage, VCCSA Voltage, VCCIO
Voltage, and PCH Voltage items are labeled in different color, indicating the risk levels
of high voltage settings.

Vﬁ .

¢ The system may need better cooling system to work stably under high voltage

settings.
White Yellow Pink Red
CPU Manual 0.8V-1.04V | 1.045V-1.09V | 1.095V-1.14V | 1.145V-1.99V
Voltage
CPU Offset 0.155V—
Voltage 0.005V-005V | 0.055V-0.1V | 0.105V-0.18V | sy
IGPU Manual 0.8V-1.04V | 1.045V-109V | 1.095V-114V | 1.145V-1.99
Votlage
iGPU Offset 0.105V—
Voltage 0.005V-005V | 055V-0.V | '\ 2 0.16V-0.635V
DRAM Voltage | 1.2V-1575V | 1.58V-1.65V 1322&‘ 1.73V-1.99V
0.80000V— 0.97500V— 1.01875V— 1.06875V—
VCCSAVoltage | ) g6g75y 1.01250V 1.06250V 1.70000V
VCCIO Voltage | 0-80000V— 110625V~ 1.15625V— 1.21250V—
g 1.10000V 1.15000V 1.20625V 1.70000V
1.20000V— 1.89375V— 1.98125V— 2.07500V—
CPUPLL Voltage | 3"ga750y 1.97500V 2.06875V 2.20000V
oCH Voltage 0.80000V~— 1.11000V- 1.16000V— 1.21000V—
9 1.10000V 1.15000V 1.20000V 1.70000V

DRAM DATA REF Voltage on CHA/B [Auto]

Allows you to set the DRAM DATA Reference Voltage on Channel A/B. The values
range from 0.395x to 0.630x with a 0.005x interval. Different ratio might enhance DRAM
overclocking ability.

DRAM CTRL REF Voltage on CHA/B [Auto]

Allows you to set the DRAM Control Reference Voltage on Channel A/B. The values
range from 0.395x to 0.630x with a 0.005x interval. Different ratio might enhance DRAM
overclocking ability.

CPU Spread Spectrum [Auto]

[Auto] Automatic configuration.
[Disabled] Enhances the BCLK overclocking ability.
[Enabled] Sets to [Enabled] for EMI control.
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3.5 Advanced menu

The Advanced menu items allow you to change the settings for the CPU and other system
devices.

.
/ '\\ Be cautious when changing the settings of the Advanced menu items. Incorrect field values
(@ can cause the system to malfunction.

Advanced

juration Parameters
> CPU Configuration

> PCH Configuration
> SATA Configuration
> System Agent Configuration

> USB Configuration

- Onboard Devices Configuration

> APM

> Network Stack

5: Optimized Def:
F10: ESC
F12: Print Screen

C) 2012 American Megatrends, Inc
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3.5.1 CPU Configuration

The items in this menu show the CPU-related information that the BIOS automatically
detects.

R The items shown in this screen may be different due to the CPU you installed.

Ai Tweaker Advanced

dvanced\ CPU Configuration >

Intel Adaptive Thermal Monitor
Active Processor Cores
Limit CPUID Maximum

Execute Disable Bit

Intel Virtualization Technology

Hardware Prefetcher

™
Intel Adaptive Thermal Monitor [Enabled] ot
[Enabled] Enables the overheated CPU to throttle its clock speed to cool down. %
[Disabled] Disables the CPU thermal monitor function. c
(@)

Active Processor Cores [All]

Allows you to choose the number of CPU cores to activate in each processor package.
Configuration options: [All] [1] [2] [3]

Limit CPUID Maximum [Disabled]

[Enabled] Allows legacy operating systems to boot even without support for CPUs
with extended CPUID functions.

[Disabled] Disables this function.

Execute Disable Bit [Enabled]

[Enabled] Enables the No-Execution Page Protection Technology.
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[Disabled] Forces the XD feature flag to always return to zero (0).

Intel® Virtualization Technology [Disabled]

[Enabled] Allows a hardware platform to run multiple operating systems separately
and simultaneously, enabling one system to virtually function as several
systems.

[Disabled] Disables this function.

Hardware Prefetcher [Enabled]

[Enabled] Allows a hardware platform to run multiple operating systems separately
and simultaneously, enabling one system to virtually function as several
systems.

[Disabled] Disables this function.

Adjacent Cache Line Prefetch [Enabled]

[Enabled] Allows a hardware platform to perform adjacent cache line prefetching.

[Disabled] Disables this function.

CPU Power Management Configuration
This item allows you to manage and configure the CPU’s power.

CPU Ratio [Auto]

Allows you to set the ratio between the CPU Core Clock and the BCLK Frequency. Use
<+>and <-> keys to adjust the ratio. The valid value ranges vary according to your
CPU model.

Enhanced Intel SpeedStep Technology [Enabled]

Allows you to enable or disable the Enhanced Intel® SpeedStep Technology (EIST).
[Disabled] The CPU runs at its default speed.

[Enabled} The operating system controls the CPU speed.

Turbo Mode [Enabled]

Allows you to set the processor cores to run faster than the marked frequency in a
specific condition.

Configuration options: [Enabled] [Disabled]

% This item appears only when you set the EIST to [Enabled], and allows you to enable or
disable the Intel® Turbo Mode Technology.

CPU CIE [Auto]

[Enabled] Enables the C1E support function. This function must be enabled to
enable or disable the Intel® Turbo Mode Technology.
[Disabled]  Disables the function.

CPU C3 Report [Auto]
Allows you to disable or enable the CPU C3 report to OS.

CPU C6 Report [Auto]
Allows you to disable or enable the CPU C6 report to OS.
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3.5.2 PCH Configuration

Tweaker Advanced

dvanced\ PCH Configuration >

bled/Disabled the High Precisi
ent Timer

High Precision Timer Enabled

> Intel (R) Rapid Start Technology

> Intel (R) Smart Connect Technology

High Precision Timer [Enabled]

Allows you to enable or disable the High Precision Event Timer.
Configuration options: [Enabled] [Disabled]

Intel Smart Connect Technology [Disabled]
Allow you to enable or disable Intel Smart Connect Technology.
Configuration options: [Enabled] [Disabled]

Intel Rapid Start Technology [Disabled]
Allows you to enable or disable Intel Rapid Start Technology.

Configuration options: [Enabled] [Disabled]

ASUS P8Z77-V DELUXE
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3.5.3 SATA Configuration

While entering Setup, the BIOS automatically detects the presence of SATA devices. The SATA
Port items show Not Present if no SATA device is installed to the corresponding SATA port.

(=%

i T ke Advanced

anced\ SATA Configuration >

SATA Mode AHCI Mode

S.M.A.R.T. Status Check Enablec

Hot Plug
Hot Plug
Hot Plug
Hot Plug

Hot Plug

Scroll down to display the following items:

Hot Plug

SATA Mode Selection [AHCI Mode]
Allows you to set the SATA configuration.

[Disabled] Disables the SATA function.

[IDE Mode] Set to [IDE Mode] when you want to use the Serial ATA hard disk drives as
Parallel ATA physical storage devices.

[AHCI Mode] Set to [AHCI Mode] when you want the SATA hard disk drives to use the
AHCI (Advanced Host Controller Interface). The AHCI allows the onboard
storage driver to enable advanced Serial ATA features that increases
storage performance on random workloads by allowing the drive to
internally optimize the order of commands.

[RAID Mode] Set to [RAID Mode] when you want to create a RAID configuration from the
SATA hard disk drives.
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S.M.A.R.T. Status Check [Enabled]

S.M.A.R.T. (Self-Monitoring, Analysis and Reporting Technology) is a monitor system. When
read/write of your hard disk errors occur, this feature allows the hard disk to report warning
messages during the POST.

Configuration options: [Enabled] [Disabled]

Hot Plug [Disabled]

These items appear only when you set the SATA mode item to [AHCI Mode] or [RAID Mode],
and allow you to enable/disable SATA Hot Plug Support.
Configuration options: [Disabled] [Enabled]

3.5.4 System Agent Configuration
(=

i eaker Advanced

Advanced\ System Agent Configuration >

Memory Remap Feature Enabled

> Graphics Configuration

> NB PCle Configuration

Memory Remap Feature [Enabled]

Allows you to enable remapping the memory above 4GB.
[Enabled] Enables the function.

[Disabled] Disables this function.

Graphics Configuration [Auto]

Allows you to select a primary display from iGPU, and PCle graphical devices.

Chapter 3

Primary Display [Auto]
Allows you to select which of the iGPU/PCIE Graphics device should be the Primary Display.
Configuration options: [Auto] [IGPU] [PCIE]

iGPU Memory [64M]

Allows you to select the amount of system memory allocated to DVMT 5.0 used by the iGPU.

Render Standby [Enabled]

Allows you to enable the Intel Graphics Render Standby support to reduce the iGPU power
use when idle.
Configuration options: [Disabled] [Enabled]

ASUS P8Z77-V DELUXE 3-23



O
-
)
o
—+
@
=
w

iGPU Multi-Monitor [Disabled]

Allows you to enable the iGPU Multi-Monitor. For Lucid Virtu MVP function supports, set this
item to [Enabled] to empower both integrated and discrete graphics. iGPU shared system

memory size is fixed in 64MB.
Configuration options: [Disabled] [Enabled]

NB PCle Configuration
Allows you to configure the NB PCI Express settings.

PCIEX16 1 Link Speed [Auto]

Allows you to configure the PCIEX16_1 speed.
Configuration options: [Auto] [Gen1] [Gen2] [Gen3]

PCIEX16 2 Link Speed [Auto]

Allows you to configure PCIEX16_2 speed.
Configuration options: [Auto] [Gen1] [Gen2] [Gen3]
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3.5.5 USB Configuration

The items in this menu allow you to change the USB-related features.

Tweaker Advanced

dvanced\ USB Configuration >

opt k ic

Legacy USB Support Enabled
Legacy USB3.0 Support
Intel xHCI Mode

EHCI Hand-off

% The USB Devices item shows the auto-detected values. If no USB device is detected, the
item shows None.

Legacy USB Support [Enabled]

[Enabled] Enables the support for USB devices on legacy operating systems (OS).
[Disabled] The USB devices can be used only for the BIOS setup program.
[Auto] Allows the system to detect the presence of USB devices at startup. If

detected, the USB controller legacy mode is enabled. If no USB device is
detected, the legacy USB support is disabled.

Legacy USB3.0 Support [Enabled]

[Enabled] Enables the support for USB 3.0 devices on legacy operating systems (2
(0S). Q
[Disabled] Disables the function. %
Intel xHCI Mode [Smart Auto] c
[Auto] Keeps the last operation of xHCI controller in OS during bootup. ©
[Smart Auto] Enables the operation of xHCI controller.
[Disabled] Disables the function.
EHCI Hand-off [Disabled]
[Enabled] Enables the support for operating systems without an EHCI hand-off
feature.
[Disabled] Disables the function.

ASUS P8Z77-V DELUXE 3-25



3.5.6 Onboard Devices Configuration

Advanced

anced\ Onboard Devices Configuration >

Enabled/Disabled Azalia HD Audio
HD Audio controller Enabled

Front Panel Type

SPDIF Out Type

Bluetooth Controller

PCI Express X1_2 Slot (Blue) bandwidth

ASM1061 Storage Controller (Front)
ASM1061 Storage OPROM
ASM1061 Storage Controller (Rear)
ASM1061 Storage OPROM

Realtek LAN Controller

Realtek PXE OPROM

ASmedia USB 3.0 Controller

ASmedia USB 3.0 Battery Charging Support

Scroll down to display the following items:

ASmedia USB 3.0 Controller 2

ASmedia USB 3.0 Battery Charging Support

(@)

=y Intel LAN controller

m Intel PXE OPROM

=

D

=

w HD Audio Controller [Enabled]
[Enabled] Enables the High Definition Audio Controller.
[Disabled] Disables the controller.

% The following two items appear only when you set the Azalia HD Audio item to [Enabled].

Front Panel Type [HD]

Allows you to set the front panel audio connector (AAFP) mode to legacy AC'97 or high-
definition audio depending on the audio standard that the front panel audio module supports.

[HD] Sets the front panel audio connector (AAFP) mode to high definition audio.
[AC97] Sets the front panel audio connector (AAFP) mode to legacy AC'97
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SPDIF Out Type [SPDIF]
[SPDIF] Sets to [SPDIF] for SPDIF audio output.
[HDMI] Sets to [HDMI] for HDMI audio output.

Bluetooth Controller [Enabled]
[Enabled] Enables the onboard bluetooth controller.
[Disabled] Disables the controller.

Wi-Fi Controller [Enabled]
[Enabled] Enables the onboard Wi-Fi controller.
[Disabled] Disables the controller.

PCl Express X1_2 Slot (Blue) bandwidth
[Auto] SATA6G_E1/E2 is enabled.
(PCleX1_2 slot is disabled for system resource optimization.)
[X1] PCleX1_2 slot runs at X1 mode.
(SATA6G_E1/E2 is disabled for system resource optimization.)

Marvell Storage Controller [Enabled]

Allows you to select the Marvell storage controller operating mode.
[Disabled] Disables the controller.

[Enabled] Enables the controller.

Marvell Storage OPROM [Enabled]

This item appears only when you set the previous item to [Enabled] and allows you to enable
or disable the OptionRom of the Marvell storage controller.
Configuration options: [Enabled] [Disabled]

Marvell Storage Firmware Check and Update [Disabled]
[Disabled] Disables firmware check and update.
[Enabled] Enables firmware check and update.

ASM1061 Storage Controller (Rear) [Enabled]

Allows you to select the ASM1061 storage controller operating mode.
[Disabled] Disables the controller.

[Enabled] Enables the controller.

ASM1061 Storage OPROM [Enabled]

This item appears only when you set the previous item to [Enabled] and allows you to enable
or disable the OptionRom of the ASM1061storage controller.
Configuration options: [Enabled] [Disabled]

ASUS P8Z77-V DELUXE
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Realtek LAN Controller [Enabled]
[Enabled] Enables the Realtek LAN controller.
[Disabled] Disables the controller.

Realtek PXE OPROM [Disabled]

This item appears only when you set the previous item to [Enabled] and allows you to enable
or disable the PXE OptionRom of the Realtek LAN controller.
Configuration options: [Enabled)] [Disabled]

ASmedia USB 3.0 Controller (USB3_E12) [Enabled]
[Enabled] Enables the USB 3.0 controller.
[Disabled] Disables the controller.

ASmedia USB 3.0 Battery Charging Support [Disabled]

[Enabled] Enables Asmedia USB 3.0 fast battery charging support for USB 3.0
devices complying with the BC 1.1 regulation.
[Disabled] Disables battery charging support.

ASmedia USB 3.0 Controller (USB3_E34) [Enabled]
[Enabled] Enables the second USB 3.0 controller.
[Disabled] Disables the controller 2.

Intel LAN Controller [Enabled]
[Enabled] Enables the Intel LAN controller.
[Disabled] Disables the controller.

Intel PXE OPROM [Disabled]

This item appears only when you set the previous item to [Enabled] and allows you to enable
or disable the PXE OptionRom of the Intel LAN controller.
Configuration options: [Enabled)] [Disabled]

Chapter 3: BIOS setup



3.5.7 APM

eaker Advanced

Advanced\ APM >

ErP Ready Disabled Alloy OS tc itch off some powe

t the system ready for ErP
Restore AC Power Loss >ower C lirement n set to Enabled, all
r PME option: b hec
Power On By PCIE/PCI

Power On By RTC

ErP Ready [Disabled]

This item allows user to switch off some power at S5 to get the system ready for ErP
requirement. When set enabled to Enabled, all other PME options will be switched off.
Configuration options: [Disabled] [Enabled]

Restore AC Power Loss [Power Off]

[Power On] The system goes into on state after an AC power loss.
[Power Off] The system goes into off state after an AC power loss.
[Last State] The system goes into either off or on state, whatever the system state was

before the AC power loss.

Power On By PCIE/PCI [Disabled]

[Disabled] Disables the PCIE/PCI devices to generate a wake-on-LAN feature of the
Intel/Realtek LAN device.

[Enabled] Enables the PCIE/PCI devices to generate a wake-on-LAN feature of the
Intel/Realtek LAN device.

Power On By RTC [Disabled]

[Disabled] Disables RTC to generate a wake event.

[Enabled] When set to [Enabled)], the items RTC Alarm Date (Days) and Hour/

Minute/Second will become user-configurable with set values.

ASUS P8Z77-V DELUXE
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3.5.8 Network Stack

=]
i Tweakel Advanced

i\ Network Stack >

Network Stack Disabled Link

Network Stack [Disable Link]

This item allows user to disable or enable the UEFI network stack.
Configuration options: [Disable Link] [Enable]
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3.6 Monitor menu

The Monitor menu displays the system temperature/power status, and allows you to change
the fan settings.

Monitor

CPU Temperature

MB Temperature

CPU Fan Speed

CPU OPT Speed
Chassis Fan 1 Speed
Chassis Fan 2 Speed
Chassis Fan 3 Speed

Chassis Fan 4 Speed

Enable Select Screen
Select Item

CPU Q-Fan Control

CPU Fan Speed Low Limit 600 RPM E
Change Opt
CPU Fan Profile Standard F1: General Help
F2: Previou: alue:
[SHEL] F5: O mizt PEETIS
10: Sa t
0 RPM F12: Print Scre

Chassis1 Q-Fan Control
Chassis1 Fan Speed Low Limit

Standard

Chassis1 Fan Profile

Scroll down to display the following items:

Chassis2 Q-Fan Control [SHEGIES]

Chassis2 Fan Speed Low Limit 0 RPM

standard

Chassis2 Fan Profile

Chassis3 Q-Fan Control Enable

0 RPM

Chassis3 Fan Speed Low Limit

Standard
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Chassis3 Fan Profile

Chassis4 Q-Fan Control [SHED]

Chassis4 Fan Speed Low Limit 0 RPM

standard

Chassis4 Fan Profile

+1.18€

CPU Voltage

3.3V Voltage
5V Voltage

12V Voltage

Anti Surge Support
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CPU Temperature / MB Temperature [XxXX°C/Xxx°F]

The onboard hardware monitor automatically detects and displays the CPU and motherboard
temperatures. Select Ignore if you do not wish to display the detected temperatures.

CPU Fan Speed [xxxx RPM] or [Ignore] / [N/A]
CPU OPT Speed [xxxx RPM] or [Ignore] / [N/A]

Chassis Fan 1/4 Speed [xxxx RPM] or [Ignore] / [N/A]

The onboard hardware monitor automatically detects and displays the CPU, chassis,

and power fan speed in rotations per minute (RPM). If the fan is not connected to the
motherboard, the field shows N/A. Select Ignore if you do not wish to display the detected
speed.

CPU Q-Fan Control [Enabled]

[Disabled] Disables the CPU Q-Fan control feature.
[Enabled] Enables the CPU Q-Fan control feature.

CPU Fan Speed Low Limit [600 RPM]

This item appears only when you enable the CPU Q-Fan Control feature and allows you to
disable or set the CPU fan warning speed.
Configuration options: [Ignore] [200 RPM] [300 RPM] [400 RPM] [500 RPM] [600 RPM]

CPU Fan Profile [Standard]

This item appears only when you enable the CPU Q-Fan Control feature and allows
you to set the appropriate performance level of the CPU fan.

[Standard] Sets to [Standard] to make the CPU fan automatically adjust depending on
the CPU temperature.

[Silent] Sets to [Silent] to minimize the fan speed for quiet CPU fan operation.
[Turbo] Sets to [Turbo] to achieve maximum CPU fan speed.
[Manual]  Sets to [Manual] to assign detailed fan speed control parameters.

% The following four items appear only when you set CPU Fan Profile to [Manual].

CPU Upper Temperature [70]
Use the <+> and <-> keys to adjust the upper limit of the CPU temperature. The values range
from 40°C to 90°C.

CPU Fan Max. Duty Cycle(%) [100]

Use the <+> and <-> keys to adjust the maximum CPU fan duty cycle. The values range from
20% to 100%. When the CPU temperature reaches the upper limit, the CPU fan will operate at
the maximum duty cycle.

CPU Lower Temperature [20]
Displays the lower limit of the CPU temperature.
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CPU Fan Min. Duty Cycle(%) [20]

Use the <+> and <-> keys to adjust the minimum CPU fan duty cycle. The values range from 0%
to 100%. When the CPU temperature is under 40°C, the CPU fan will operate at the minimum
duty cycle.

Chassis Q-Fan Control 1/4 [Enabled]
[Disabled] Disables the Chassis Q-Fan control feature.
[Enabled] Enables the Chassis Q-Fan control feature.

Chassis Fan Speed Low Limit 1/4 [600 RPM]

This item appears only when you enable the Chassis Q-Fan Control feature and allows you
to disable or set the chassis fan warning speed.
Configuration options: [Ignore] [200 RPM] [300 RPM] [400 RPM] [500 RPM] [600 RPM]

Chassis Fan 1/4 Profile [Standard]

This item appears only when you enable the Chassis Q-Fan Control feature and
allows you to set the appropriate performance level of the chassis fan.

[Standard] Sets to [Standard] to make the chassis fan automatically adjust depending
on the chassis temperature.

[Silent] Sets to [Silent] to minimize the fan speed for quiet chassis fan operation.
[Turbo] Sets to [Turbo] to achieve maximum chassis fan speed.
[Manual]  Sets to [Manual] to assign detailed fan speed control parameters.

% The following four items appear only when you set Chassis Fan Profile to [Manual].

Chassis Upper Temperature [70]
Use the <+> and <-> keys to adjust the upper limit of the CPU temperature. The values range
from 40°C to 90°C.

Chassis Fan Max. Duty Cycle(%) [100]

Use the <+> and <-> keys to adjust the maximum chassis fan duty cycle. The values range
from 20% to 100%. When the chassis temperature reaches the upper limit, the chassis fan will
operate at the maximum duty cycle.
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Chassis Lower Temperature [40]
Displays the lower limit of the chassis temperature.

CPU Fan Min. Duty Cycle(%) [60]

Use the <+> and <-> keys to adjust the minimum chassis fan duty cycle. The values range from
0% to 100%. When the chassis temperature is under 40°C, the chassis fan will operate at the
minimum duty cycle.
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CPU Voltage, 3.3V Voltage, 5V Voltage, 12V Voltage
The onboard hardware monitor automatically detects the voltage output through the onboard
voltage regulators. Select Ignore if you do not want to detect this item.

Anti Surge Support [Enabled]

This item allows you to enable or disable the Anti Surge function.
Configuration options: [Disabled] [Enabled]
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3.7 Boot menu

The Boot menu items allow you to change the system boot options.

Bootup NumLock State
Full Screen Logo

Wait for ‘F1" If Error
Fast Boot

Option ROM Messages
Setup Mode

UEFI/Legacy Boot

au
F10: Sa =
F12: Print Screen

Bootup NumLock State [On]

[On] Sets the power-on state of the NumLock to [On].

[Off] Sets the power-on state of the NumLock to [Off]. (2
Full Screen Logo [Enabled] i
[Enabled] Enables the full screen logo display feature. %
[Disabled] Disables the full screen logo display feature. 6

% Set this item to [Enabled] to use the ASUS MyLogo 2™ feature.

Wait For ‘F1' If Error [Enabled]

[Disabled] Disables this function.

[Enabled] The system waits for the <F1> key to be pressed when error occurs.

Option ROM Messages [Force BIOS]

[Force BIOS] The third-party ROM messages will be forced to display during the boot
sequence.

[Keep Current]  The third-party ROM messages will be displayed only if the third-party
manufacturer had set the add-on device to do so.
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Setup Mode [EZ Mode]

[Advanced Mode] Sets Advanced Mode as the default screen for entering the BIOS setup
program.

[EZ Mode] Sets EZ Mode as the default screen for entering the BIOS setup program.

UEFI/Legacy Boot [Enable both UEFI and Legacy]

[Enable both UEFI and Legacy] Enables both UEFI and Legacy boot.

[Disable UEFI] Enables the Legacy boot, and disables the UEFI
boot.

[Disable Legacy] Enables the UEFI booth, and disables the Legacy
boot.

PCI ROM Priority [Legacy ROM]

[Legacy ROM] Launch Legacy ROM
[EFI Compatibe ROM] Launch UEFI Compatible ROM

Boot Option Priorities

These items specify the boot device priority sequence from the available devices. The
number of device items that appears on the screen depends on the number of devices
installed in the system.

+  To select the boot device during system startup, press <F8> when ASUS Logo appears.

% *  To access Windows OS in Safe Mode, do any of the following:
- Press <F5> when ASUS Logo appears.
- Press <F8> after POST.

Boot Override

These items displays the available devices. The number of device items that appears on
the screen depends on the number of devices installed in the system. Click an item to start
booting from the selected device.
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3.8 Tools menu

The Tools menu items allow you to configure options for special functions. Select an item
then press <Enter> to display the submenu.

> ASUS EZ Flash 2 Utility

> ASUS O.C. Profile
> ASUS SPD Information

> ASUS Drive Xpert

3.8.1 ASUS EZ Flash 2 Utility

Allows you to run ASUS EZ Flash 2. When you press <Enter>, a confirmation message
appears. Use the left/right arrow key to select between [Yes] or [No], then press <Enter> to
confirm your choice.

/ For more details, refer to section 3.10.2 ASUS EZ Flash 2 utility.

3.8.2. ASUS 0.C. Profile

This item allows you to store or load multiple BIOS settings.

Tooll ASUS O.C. Profile >
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Label

Save to Profile

Load from Profile

/ The Setup Profile Status items show Not Installed if no profile is created.
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Save to Profile

Allows you to save the current BIOS settings to the BIOS Flash, and create a profile. Key in a
profile number from one to eight, press <Enter>, and then select Yes.

Load from Profile

Allows you to load the previous BIOS settings saved in the BIOS Flash. Key in the profile
number that saved your BIOS settings, press <Enter>, and then select Yes.

% .

system boot failure!

DO NOT shut down or reset the system while updating the BIOS to prevent the

We recommend that you update the BIOS file only coming from the same memory/CPU

configuration and BIOS version.

3.8.3. ASUS SPD Information
Allows you to view the DRAM SPD information.

Tool\ ASUS SPD Information >
DIMM Silot #

Manufacturer
Module Size
Maximum Bandwidth
Part Number

Serial Number
Product Week/Year
SPD Ext.

JEDEC ID

Frequency(Mhz)
Voltage (V)

CAS# Lantency (tCL)
RAS# to CAS# (tRCD)
RAS# Precharge(tRP)
tRAS

tRC

tWR
tRRD
tRFC
tWTR
tRTP
tFAW

Slot 1

Samsung
1024 MBytes
1333 Mhz

M391B2873DZ1-CH9

060369f9
50/2012
XMP

DIMN
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3.8.4. ASUS Drive Xpert

Tool\ ASUS Drive Xpert >

Drive Xpert Mode Normal Mode

> SATA6G E1 (Gray)

> SATA6G E2 (Gray)

% «  Before using the Drive Xpert function, ensure that you have connected the SATA
signal cables and installed SATA hard disk drives to the SATA6G_E1 and SATA6G_E2
connectors.

*  You can only make one Drive Xpert change a time before you save BIOS settings and
restart the computer.

Drive Xpert Mode

[Normal Mode]  Allows you to use the SATA6G_E1 and SATA6G_E?2 connectors as normal
SATA connectors.

[Super Speed]  Allows you to use the Super Speed function that combines two hard drives
as one single drive partition.

[EZ Backup] Allows you to use the EZ Backup function that copies and maintains an
identical image of data from the SATA6G_E1 drive to the SATA6G_E2
drive.

%‘\ When using only one hard disk in Normal Mode, connect the hard disk to the SATA6G_E1
connector on the motherboard.

Chapter 3

VA A * Al original data of the two hard drives will be erased for Super Speed setup.

* Al original data of the SATA6G_E?2 hard disk will be erased for EZ Backup setup.

Drive Xpert Device(s) List:

SATA 6G E1 (Gray) / SATA 6G E2 (Gray)
Press <Enter> to display the information of the hard disks which are connected to the
SATA6G_E1 and SATA6G_E?2 connectors on the motherboard.
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3.9 Exit menu

The Exit menu items allow you to load the optimal default values for the BIOS items, and
save or discard your changes to the BIOS items. You can access the EZ Mode from the Exit

menu.

Load Optimized Defaults

This option allows you to load the default values for each of the parameters on the Setup
menus. When you select this option or if you press <F5>, a confirmation window appears.
Select Yes to load the default values.

Save Changes & Reset

Once you are finished making your selections, choose this option from the Exit menu to
ensure the values you selected are saved. When you select this option or if you press <F10>,
a confirmation window appears. Select Yes to save changes and exit.

Discard Changes & Exit

This option allows you to exit the Setup program without saving your changes. When you
select this option or if you press <Esc>, a confirmation window appears. Select Yes to
discard changes and exit.

ASUS EZ Mode
This option allows you to enter the EZ Mode screen.

Launch EFI Shell from filesystem device

This option allows you to attempt to launch the EFI Shell application (shellx64.efi) from one of
the available filesystem devices.
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3.10 Updating BIOS

The ASUS website publishes the latest BIOS versions to provide enhancements on system
stability, compatibility, or performance. However, BIOS updating is potentially risky. If there
is no problem using the current version of BIOS, DO NOT manually update the BIOS.
Inappropriate BIOS updating may result in the system’s failure to boot. Carefully follow the
instructions of this chapter to update your BIOS if necessary.

R Visit the ASUS website (www.asus.com) to download the latest BIOS file for this
motherboard.

The following utilities allow you to manage and update the motherboard BIOS setup program.

ASUS Update: Updates the BIOS in Windows® environment.
ASUS EZ Flash 2: Updates the BIOS using a USB flash drive.

ASUS CrashFree BIOS 3: Restores the BIOS using the motherboard support DVD or
a USB flash drive when the BIOS file fails or gets corrupted.

4. ASUS BIOS Updater: Updates and backups the BIOS in DOS environment using the
motherboard support DVD and a USB flash disk drive.

Refer to the corresponding sections for details on these utilities.

R Save a copy of the original motherboard BIOS file to a USB flash disk in case you need
to restore the BIOS in the future. Copy the original motherboard BIOS using the ASUS
Update or BIOS Updater utilities.

3.10.1  ASUS Update utility

The ASUS Update is a utility that allows you to manage, save, and update the motherboard
BIOS in Windows® environment. The ASUS Update utility allows you to:
*  Update the BIOS directly from the Internet
+ Download the latest BIOS file from the Internet
+  Update the BIOS from an updated BIOS file
Save the current BIOS file
»  View the BIOS version information
This utility is available in the support DVD that comes with the motherboard package.
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/ ASUS Update requires an Internet connection either through a network or an Internet
Service Provider (ISP).

Launching ASUS Update

After installing Al Suite Il from the motherboard support DVD, launch ASUS Update by
clicking Update > ASUS Update on the Al Suite II main menu bar.

% Quit all Windows® applications before you update the BIOS using this utility.
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Updating the BIOS through the Internet

To update the BIOS through the Internet:

1. From the ASUS Update screen, select
Update BIOS from Internet, and
then click Next.

2. Select the ASUS FTP site nearest
you to avoid network traffic.

If you want to enable the BIOS
downgradable function and auto
BIOS backup function, check the
checkboxs before the two items on
the screen.

3. Select the BIOS version that you
want to download. Click Next.

4. You can decide whether to change
the BIOS boot logo, which is the
image appearing on screen during
the Power-On Self-Tests (POST).
Click Yes if you want to change the
boot logo or No to continue.

5. Follow the onscreen instructions to
complete the update process.
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Updating the BIOS through a BIOS file

To update the BIOS through a BIOS file:

1. From the ASUS Update screen,
select Update BIOS from file, and
then click Next.

2. Locate the BIOS file from the Open
window, click Open, and click Next.

3. You can decide whether to change
the BIOS boot logo. Click Yes if you
want to change the boot logo or No to
continue.

4. Follow the onscreen instructions to
complete the update process.
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/ ¢ The screenshots in this section are for reference only. The actual BIOS information
vary by models.

*  Refer to the software manual in the support DVD or visit the ASUS website at
www.asus.com for detailed software configuration.
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3.10.2  ASUS EZ Flash 2 utility

The ASUS EZ Flash 2 feature allows you to update the BIOS without having to use a
bootable floppy disk or an OS-based utility.

% Before you start using this utility, download the latest BIOS from the ASUS website
at www.asus.com.

To update the BIOS using EZ Flash 2:
1. Insert the USB flash disk that contains the latest BIOS file to the USB port.

2. Enter the Advanced Mode of the BIOS setup program. Go to the Tool menu to select
ASUS EZ Flash Utility and press <Enter> to enable it.

ASUSTek EZ Flash BIOS ROM Utili

IODEL: P8Z77-V Deluxe

B fs0:\
Drive Folder Info

f50:\ 11/08/11  10:23p 4194304 P8Z77VD.ROM
fs1:\

d File Infor

MODEL:

@ Help Info

[Enter] Selector Load  [Tab] Switch  [Up/Down/PageUp/PageDown/Home/End] Move  [Esc] Exit  [F2] Backup

O
)
Q
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Press <Tab> to switch to the Drive field.

Press the Up/Down arrow keys to find the USB flash disk that contains the latest BIOS,
and then press <Enter>.

Press <Tab> to switch to the Folder Info field.

Press the Up/Down arrow keys to find the BIOS file, and then press <Enter> to perform
the BIOS update process. Reboot the system when the update process is done.
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+  This function can support devices such as a USB flash disk with FAT 32/16 format and
single partition only.

* DO NOT shut down or reset the system while updating the BIOS to prevent system
boot failure!

k Ensure to load the BIOS default settings to ensure system compatibility and stability. Select

the Load Optimized Defaults item under the Exit menu. See section 3.9 Exit Menu for
details.

3.10.3  ASUS CrashFree BIOS 3 utility

The ASUS CrashFree BIOS 3 utility is an auto recovery tool that allows you to restore the
BIOS file when it fails or gets corrupted during the updating process. You can restore a

corrup

ted BIOS file using the motherboard support DVD or a USB flash drive that contains

the BIOS file.

Z&\\ The BIOS file in the motherboard support DVD may be older than the BIOS file published

on the ASUS official website. If you want to use the newer BIOS file, download the file at
support.asus.com and save it to a USB flash drive.

Recovering the BIOS
To recover the BIOS:

1. Turnon the system.

2. Insert the motherboard support DVD to the optical drive, or the USB flash drive 02
containing the BIOS file to the USB port. )

3. The utility automatically checks the devices for the BIOS file. When found, the utility '5'_
reads the BIOS file and enters ASUS EZ Flash 2 utility automatically. @®

4. The system requires you to enter BIOS Setup to recover BIOS setting. To ensure 6
system compatibility and stability, we recommend that you press <F5> to load default
BIOS values.

/ '\ DO NOT shut down or reset the system while updating the BIOS! Doing so can cause

[ system boot failure!
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3.10.4  ASUS BIOS Updater

The ASUS BIOS Updater allows you to update BIOS in DOS environment. This utility also
allows you to copy the current BIOS file that you can use as a backup when the BIOS fails or
gets corrupted during the updating process.

% The succeeding utility screens are for reference only. The actual utility screen displays may
not be same as shown.

Before updating BIOS

1. Prepare the motherboard support DVD and a USB flash drive in FAT32/16 format and
single partition.

2. Download the latest BIOS file and BIOS Updater from the ASUS website at http://
support.asus.com and save them on the USB flash drive.
R + NTFS is not supported under DOS environment. Do not save the BIOS file and BIOS
Updater to a hard disk drive or USB flash drive in NTFS format.

Do not save the BIOS file to a floppy disk due to low disk capacity.

3. Turn off the computer and disconnect all SATA hard disk drives (optional).

Booting the system in DOS environment

1. Insert the USB flash drive with the latest BIOS file and BIOS Updater to the USB port.

2. Boot your computer. When the ASUS Logo appears, press <F8> to show the BIOS
Boot Device Select Menu. Insert the support DVD into the optical drive and select the
optical drive as the boot device.

Please select boot device

SATA: XXXXXXXXXXXXXXXX
USB  XXXXXXXXXXXXXXXXX
UEFI: XXXXXXXXXXXXXXXX
Enter Setup
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3. When the Make Disk menu appears, select the FreeDOS command prompt item by
pressing the item number.

4. Atthe FreeDOS prompt, type d: and press <Enter> to switch the disk from
Drive C (optical drive) to Drive D (USB flash drive).

Welcome to FreeDOS (http://ww.freedos.org)!
C:\>d:

D:\>
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Updating the BIOS file
To update the BIOS file using BIOS Updater

1.

2.

At the FreeDOS prompt, type bupdater /pc /g and press <Enter>.

>bupdater /pc /g

The BIOS Updater screen appears as below.

ASUSTek BIOS Updater for DOS V1.30 [2012/12/22]
FLASH TYPE : Il NICH2SINIDGEA
Current ROM Update ROl

BOARD: P8Z77-V Deluxe BOARD: URKROWH
VER: 0204 VER: junknown

DATE: 080172012 DATE: [Unknown

PATH: AN
A: P8Z77VD.CAP 2097152 2012-01-06 17:30:48

[ r] Select or Load [Tab] Switch [V] Drive Info
[Up/Down/Home/End] Move  [B] Backup [Esc] Exit

3. Press <Tab> to switch between screen fields and use the <Up/Down/Home/End> keys

4. Select Yes and press <Enter>. When BIOS update is done, press <ESC> to exit BIOS

to select the BIOS file and press <Enter>. BIOS Updater checks the selected BIOS file
and prompts you to confirm BIOS update.

Are you sure to update BI10S?

No

Chapter 3

Updater. Restart your computer.

/ ' i DO NOT shut down or reset the system while updating the BIOS to prevent system boot
LJ

( failure!

Z&\\ «  For BIOS Updater version 1.04 or later, the utility automatically exits to the DOS
prompt after updating BIOS.

«  Ensure to load the BIOS default settings to ensure system compatibility and stability.
Select the Load Optimized Defaults item under the Exit BIOS menu. See Chaper 3
of your motherboard user manual for details.

Ensure to connect all SATA hard disk drives after updating the BIOS file if you have
disconnected them.
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Chapter 4

4.1 Installing an operating system

This motherboard supports Windows® XP/ 64-hit XP/ 7 / 64-bit 7 operating systems (OS).
Always install the latest OS version and corresponding updates to maximize the features of
your hardware.

% *  Motherboard settings and hardware options vary. Use the setup procedures presented
in this chapter for reference only. Refer to your OS documentation for detailed
information.

«  Ensure that you install the Windows® XP Service Pack 3 or later versions before
installing the drivers for better compatibility and system stability.

4.2 Support DVD information

The support DVD that comes with the motherboard package contains the drivers, software
applications, and utilities that you can install to avail all motherboard features.

ﬁ The contents of the support DVD are subject to change at any time without notice. Visit the
ASUS website at www.asus.com for updates.

4.2.1 Running the support DVD

Place the support DVD into the optical drive. The DVD automatically displays the Drivers menu if
Autorun is enabled in your computer. Click each menu tab and select the items you want to install.

The Drivers menu shows the available The Make Disk menu The Manual menu contains

device drivers if the system detects contains items to the list of supplementary user
installed devices. Install the necessary create the RAID/AHCI  manuals. Click an item to open
drivers to use the devices. driver disk. the folder of the user manual.

The Utilities Click the Contact
menu shows the i~ tab to display the
applications and ASUS contact

other software that information.
the motherboard . | e R
supports. Click anicon
to display DVD/
motherboard
information
il Engin Inle
Click an item
to install Mo
Hiuwtool
% If Autorun is NOT enabled in your computer, browse the contents of the support DVD to
/ locate the file ASSETUP.EXE from the BIN folder. Double-click the ASSETUP.EXE to run

the DVD.
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422 Obtaining the software manuals

The software manuals are included in the support DVD. Follow the instructions below to get

the necessary software manuals.

Acrobat® Reader from the Utilities menu before opening the files.

% The software manual files are in Portable Document Format (PDF). Install the Adobe®

1.  Click the Manual tab. Click ASUS
Motherboard Utility Guide from
the manual list on the left.

2. The Manual folder of the support

DVD appears. Double-click the
folder of your selected software. v 8=
’J Parapent
3. Some software manuals are B
. . . L]
provided in different languages.
Double-click the language to Y Qe
show the software manual. (] s
_.J .
_._J Tradme s e
The screenshots in this section are for reference only. The actual software manuals
containing in the support DVD vary by models.
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4.3 Software information

Most of the applications in the support DVD have wizards that will conveniently guide you
through the installation. View the online help or readme file that came with the software
application for more information.

431 Al Suite Il

Al Suite Il is an all-in-one interface that integrates several ASUS utilities and allows users to
launch and operate these utilities simultaneously.

Installing Al Suite Il

To install Al Suite Il on your computer

1. Place the support DVD to the optical drive. The Drivers installation tab appears if your
computer has enabled the Autorun feature.

2. Click the Utilities tab, then click Al Suite 1.
3. Follow the onscreen instructions to complete installation.

Using Al Suite Il

Al Suite Il automatically starts when you enter the Windows® operating system (OS). The Al
Suite Il icon appears in the Windows® notification area. Click the icon to open the Al Suite I
main menu bar.

Click each button to select and launch a utility, to monitor the system, to update the motherboard
BIOS, to display the system information, and to customize the settings of Al Suite II.

Update

Click to customize the
interface settings
Click to show the
system information
Click to update the motherboard BIOS
Click to monitor sensors
or CPU frequency
——Click to select a utility

—Shortcut to the Auto Tuning
Mode under TurboV EVO

k ¢ The Auto Tuning button appears only on models with the TurboV EVO function.
e The applications in the Tool menu vary with models.

*  The screeshots of Al Suite Il in this user manual are for reference only. The actual
screenshots vary with models.

*  Refer to the software manual in the support DVD or visit the ASUS website
at www.asus.com for detailed software configuration.

ASUS P8Z77-V DELUXE
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43.2 TurboV EVO

ASUS TurboV EVO introduces TurboV that allows you to manually adjust the CPU frequency
and related voltages as well as Auto Tuning function that offers automatic and easy
overclocking and system level up. After installing Al Suite Il from the motherboard support
DVD, launch TurboV EVO by clicking Tool > TurboV EVO on the Al Suite Il main menu bar.

% Refer to the software manual in the support DVD or visit the ASUS website at
www.asus.com for detailed software configuration.

TurboV

TurboV allows you to overclock the BCLK frequency, CPU voltage, IMC voltage, and DRAM
Bus voltage in Windows® environment and takes effect in real-time without exiting and
rebooting the OS.

'\\ Refer to the CPU documentation before adjusting CPU voltage settings. Setting a high
) voltage may damage the CPU permanently, and setting a low voltage may make the
system unstable.

R For system stability, all changes made in TurboV will not be saved to BIOS settings and
will not be kept on the next system boot. Use the Save Profile function to save your
customized overclocking settings and manually load the profile after Windows starts.

Click to
select mode

Load profile
Target values

Save the current
settings as a new
profile

Current values Voltage
Click to show Adjustment
. bars
settings

Undoes all changes
without applying
Applies all changes
immediately

Click to restore
all start-up
settings

(@]
>
)
©
-+
]
-
IN
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Using Advanced Mode
Click on the Advanced Mode tab to adjust the advanced voltage settings.

\oltage
Adjustment
bars

Undoes all changes
without applying
Applies all changes
immediately

Current values

Click to restore
all start-up
settings

CPU Ratio
Allows you to manually adjust the CPU ratio.

R The first time you use CPU Ratio, go to Al Tweaker > CPU Power Management in BIOS
and set the Turbo Ratio item to [Maximum Turbo Ratio setting in OS].
1.  Click on the CPU Ratio tab.

2. Drag the adjustment bar upwards or downwards to the desired value.
3. Click on Apply to make the change take effect.

Undoes all changes
without applying

Click to restore Applies all changes <
all start-up immediately P
settings 8

o

R *  Setthe CPU Ratio Setting item in BIOS to [Auto] before using the CPU Ratio function _CCU
in TurboV. Refer to Chapter 3 of your motherboard user manual for details. O

*  The CPU Ratio bars show the status of the CPU cores, which vary with your CPU
model.
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GPU Boost
GPU Boost overclocks the integrated iGPU for the best graphics performance.

Click More Settings, and then click the GPU Boost tab.
Adjust the iGPU Max Frequency and iGPU Voltage.
Click Yes to make the change takes effect.

GPU Boost
Target values

Adjustment bars

Current values Undoes all

changes without
applying
Click to restore
all start-up
settings

Applies all changes

Auto Tuning

ASUS TurboV EVO includes two auto tuning modes, providing the most flexible auto-tuning
options.

R +  The overclocking result varies with the CPU model and the system configuration.

+  To prevent overheating from damaging the motherboard, a better thermal environment
is strongly recommended.

*  Fast Tuning: fast CPU overclocking
*  Extreme Tuning: extreme overclocking for CPU and memory

Using Fast Tuning

1.  Click the Auto Tuning tab and
then click Fast.

2. Read through the warning
messages and click OK to start
auto-overclocking.

O
>
Q
o
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D
=
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3. TurboV automatically overclocks " At Tuning Successiul
the CPU, saves BIOS settings
and restarts the system. After

- i i 2575 un
re-entering Windows, a message s elll%

appears indicating auto tuning
success. Click OK to exit.

Using Extreme Tuning

1.  Click the Auto Tuning tab and then
click Extreme.

2. Read through the warning :
messages and click OK to start ¢ vt
auto-overclocking. Tk e £

3. TurboV automatically overclocks
the CPU and memory and restarts
the system. After re-entering
Windows, a message appears
indicating the current overclocking
result. To keep the result, click
Stop.

4. Ifyou did not click Stop in
the previous step, TurboV
automatically starts further system
overclocking and stability test.
An animation appears indicating
the overclocking process. Click
Stop if you want to cancel the
Overclocking process.

5. TurboV automatically adjusts and [ Se—
saves BIOS settings and restarts
the system. After re-entering
Windows, a message appears 2507 un ‘-
indicating auto tuning success. S 1 03 %
Click OK to exit.

ASUS P8Z77-V DELUXE
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43.3 DIGI+ Power Control

DIGI+ PowerControl allows you to adjust the VRM voltage and frequency modulation to
enhance reliability and stability. It also provides profile settings to achieve the highest power
efficiency, generating less heat to prolong component lifespan, and minimize power loss.
After installing Al Suite Il from the motherboard support DVD, launch DIGI+ Power Control
by clicking Tool > DIGI+ Power Control on the Al Suite Il main menu bar.

Select CPU Power or DRAM Power to adjust the power control settings.

Smart DIGI+

Function no.  Function description

1 Smart DIGI+ Key
Quickly delivers a higher VRM frequency, voltage, and current for superior
CPU/IGPU/DRAM overclocking performance with one switch.

2 Smart CPU Power Level - 45W
CPU power usage is limited to 45W to achieve the best digital power
saving conditions.

3 Smart CPU Power Level - 35W
CPU power usage is limited to 35W to achieve the best digital power
saving mode.
4 OC Now!
Adjusts the CPU ratio in TurboV EVO.
5 Default (Smart DIGI+ Setting)
Sets your CPU/IGPU/DRAM power to default settings.
6 Default (Smart CPU Power Level)

Sets your power consumption to CPU default setting.

R . Enabling the Smart CPU Power Level may decrease the total power delivery
to the CPU, and affect the CPU performance under a heavy system load. The
system restores to its default settings on the next startup.

. Only Intel® 3rd generation processors support the Smart DIGI+ Technology
feature.

Chapter 4: Software support



CPU Power

Application aids

Apply all changes
immediately

Undo all changes
without applying

DIGI+ Power Control

Application aids

Apply all changes
immediately

Undo all changes
without applying

Function no.  Function description

1

CPU Load-line Calibration

It allows you to adjust the voltage settings and control the system
temperature. Higher load-line calibration could get higher voltage and
good overclocking performance but increases the CPU and VRM thermal.

CPU Current Capability
CPU Current Capability provides wider total power range for overclocking.
A higher value setting gets higher VRM power consumption delivery.

CPU Voltage Frequency
Switching frequency will affect the VRM transient response and
component thermal. Higher frequency gets quicker transient response.

ASUS P8Z77-V DELUXE
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Function no. Function description

4

iGPU Load-line Calibration

Load-line is defined by Intel VRM specifications, and affects the iGPU
voltage. The iGPU working voltage decreases proportionally to integrated
graphics loading. A higher value can get a higher iGPU voltage, and a
good performance, but decreases the CPU and VRM thermal conditions.

iGPU Current Capability

A higher value brings wider total iGPU power range, and extends the
overclocking frequency range simultaneously to enhance the iGPU
performance.

CPU Power Phase Control

Increase phase number under heavy system loading to get more transient
and better thermal performance. Reduce phase number under light
system loading to increase VRM efficiency.

* The system automatically set the default to [Extreme] when using the Intel®
iGPU.

CPU Power Thermal Control
A higher temperature brings a wider CPU power thermal range, and
extends the overclocking tolerance to enlarge overclocking potential.

CPU Power Response Control
The DIGI+ VRM controller provides a faster and precise power response
rate for CPU. Apply a higher value for an extreme overclocking.

CPU Power Duty Control
CPU Power Duty Control adjusts the current of every VRM phase and the
thermal of every phase component.

Chapter 4: Software support



DRAM Power

Application aids

Apply all changes
immediately
Undo all changes
without applying

Function no.  Function descripti

1 DRAM Current Capability
A higher value brings a wider total power range and extends the
overclocking frequency range simultaneously.

2 DRAM Voltage Frequency
Allows you to adjust the DRAM switching frequency for system stability or
to increase OC Range.

3 DRAM Power Phase Control

Select Extreme for full phase mode to increase system performance or
select Optimized for ASUS optimized phase tuning profile to increase
DRAM power efficiency.

4 DRAM Power Thermal Control
A higher temperature brings a wider DRAM power thermal range, and
extends the overclocking tolerance to enlarge overclocking potential.

) '\\ +  The actual performance boost may vary depending on your CPU specification.
° . Do not remove the thermal module. The thermal conditions must be monitored.

ASUS P8Z77-V DELUXE
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434 EPU

EPU is an energy-efficient tool that satisfies different computing needs. This utility provides
several modes that you can select to save system power. Selecting Auto mode will have the
system shift modes automatically according to current system status. You can also customize
each mode by configuring settings like CPU frequency, GPU frequency, vCore Voltage, and
Fan Control.

Launching EPU

After installing Al Suite Il from the motherboard support DVD, launch EPU by clicking
Tool > EPU on the Al Suite I main menu bar.

Displays the following
message if no VGA power
saving engine is detected.

Multiple system
operating modes

FPU Status

The items lighting up
means power saving
engine is activated

Displays the amount of
CO2 reduced

*Shifts between the
display of Total and
Current CO2 reduced

Displays the
current CPU power

Advanced settings for each mode

Displays the system
properties of each
mode

Select From EPU Installation to show the CO2 that has been reduced since you
installed EPU.

Select From the Last Reset to show the total CO2 that has been reduced since you
click the Clear button [ .

Refer to the software manual in the support DVD or visit the ASUS website at
www.asus.com for detailed software configuration.
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4.3.5 USB 3.0 Boost

The ASUS exclusive USB 3.0 Boost provides speed boost for USB 3.0 devices and the
up-to-date support of USB Attached SCSI Protocol (UASP). With USB 3.0 Boost, you can
accelerate the transfer speed of your USB 3.0 devices with ease.

Launching USB 3.0 Boost

After installing Al Suite Il from the motherboard support DVD, launch USB 3.0 Boost by
clicking Tool > USB 3.0 Boost on the Al Suite Il main menu bar.

Configuring USB 3.0 Boost

1. Connect a USB 3.0 device to the USB 3.0 port.

2. USB 3.0 Boost automatically detects the property of the connected device and
switches to Turbo mode or UASP mode (if UASP is supported by the connected
device).

3. You can manually switch the USB 3.0 mode back to Normal mode at any time.

/ *  Refer to the software manual in the support DVD or visit the ASUS website at

www.asus.com for detailed software configuration.

*  Due to Intel® chipset limitation, Intel® USB 3.0 ports do not support ASUS 3.0 Boost in
Windows XP operating system.

*  Use the USB 3.0 devices for high performance. The data transfer speed varies with
USB devices.

ASUS P8Z77-V DELUXE
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4.3.6 USB BIOS Flashback Wizard

This utility allows you to check and save the latest BIOS version to a USB storage device.
With ASUS USB BIOS Flashback hardware feature, the system BIOS is conveniently
updated without booting your system.

Current BIOS

Sets the schedule information

for BIOS Update
download

Click to check for
an update BIO:
firmware available

for download Cancels all changes

Applies all changes

Scheduling the latest BIOS download

1. Inthe Download Setting field, tick Schedule (days) and select the number of days for
the next download update available.

2. Click Apply to save the BIOS download schedule. Click Cancel to cancel the changes
made.

Downloading the updated BIOS

R Plug the flash drive before you start downloading.

1.  Click Check for New BIOS Update to look for an updated BIOS firmware.

2. Wait for the system to check the latest
BIOS firmware.
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3. After the utility detects a new BIOS
firmware, save the BIOS firmware by
clicking [l from the Save to field,
select the USB flashdrive, and click
Download.

4.  After the download is complete,
click OK.

After you download the BIOS file to your flash drive, you can update the motherboard’s BIOS.
Refer to 2.3.11 USB BIOS Flashback for details.

Chapter 4
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4.3.7 ASUS SSD Caching

This feature boosts system performance by using an installed SSD with no capacity
limitations as a cache for frequently accessed data. Harness a combination of SSD-like
performance and response and hard drive capacity with just one click. No rebooting is
needed with instant activation for complete ease of use.

Launching ASUS SSD Caching

After installing Al Suite Il from the motherboard support DVD, launch ASUS SSD Caching
by clicking Tool > ASUS SSD Caching on the Al Suite Il main menu bar.

Configuring ASUS SSD Caching

1. Connect one HDD and one SSD to the
the Marvell® SATA ports (SATA6G_E1/
E2). ASUS SSD Caching automatically
detects the HDD and SSD.

2. Click on Caching Now! to initialize the
connected disks. Initialization status is
shown on the program interface.

3. Caching function will be activated once
initialization is complete.

4. Click on Disable when deactivating SSD
caching.

% +  During initialization, you can proceed with doing any system operations. You can
check the caching status later or wait for a pop-up message notifying that initialization
is completed.

+  Forregular usage, the SATA6G_E1/E2 connectors are recommended for data drives.

+  After disabling SSD Caching, the SSD will become a non-configurable disk in
Windows OS. To use the SSD again for normal functions, go to Disk Management to
reconfigure the SSD.
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4.3.8 Probe Il

Probe Il is a utility that monitors the computer’s vital components, and detects and alerts you
of any problem with these components. Probe Il senses fan rotations, CPU temperature,
and system voltages, among others. With this utility, you are assured that your computer is
always at a healthy operating condition.

Launching Probe Il

After installing Al Suite Il from the motherboard support DVD, launch Probe Il by clicking
Tool > Probe Il on the Al Suite Il main menu bar.

Configuring Probe II

Click the Voltage/Temperature/Fan Speed tabs to activate the sensors or to adjust the
sensor threshold values. The Preference tab allows you to customize the time interval of
sensor alerts, or change the temperature unit.

Saves your
configuration

Loads your saved Loads the default Applies your
configuration threshold values changes
for each sensor

/ Refer to the software manual in the support DVD or visit the ASUS website at
/[ www.asus.com for detailed software configuration.

ASUS P8Z77-V DELUXE
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439 Sensor Recorder

Sensor Recorder monitors the changes in the system voltage, temperature, and fan speed on
a timeline. The History Record function allows you to designate specific time spans on record
to keep track of the three system statuses for certain purposes.

Launching Sensor Recorder

After installing Al Suite Il from the motherboard support DVD, launch Sensor Recorder by
clicking Tool > Sensor Recorder on the Al Suite Il main menu bar.

Using Sensor Recorder

Click on Voltage/ Temperature/ Fan Speed tabs for the status you want to monitor. Colored
lines will automatically appear on the diagram to indicate the immediate changes in the
system status.

Using History Record

1.  Click on the History Record tab and adjust the settings on the left for Record Interval
and Record Duration according to need.

2. Click on Start Recording to start measurement and recording of each sensor.

To stop recording, click on Recording again.

4. To track the recorded contents, set Type/ Date/ Select display items to display the
history details.

w
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Click on Monitor > Sensor on the Al Suite Il main menu bar and a highlight of the system
statuses will appear on the right panel.
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4.3.10  ASUS Update

ASUS Update lays out the options for updating BIOS on your system. Update BIOS utility
on your system or simply save the utility for later use just by following the directions on this
convenient updating feature.

Launching ASUS Update

After installing Al Suite Il from the motherboard support DVD, launch ASUS Update by
clicking Update> ASUS Update on the Al Suite Il main menu bar.

Using ASUS Update

Select the way you would like to do with the BIOS utility. Click on Next and follow the
instructions to complete your request.

. Update BIOS from Internet
Download the latest BIOS utility from the ASUS service website (www.asus.com) and
follow the suggested procedures to update the BIOS version on your system.

. Download BIOS from Internet
Download the latest BIOS utility from the ASUS service website (www.asus.com) and
save for later use.

. Update BIOS from file
Use the BIOS utility demanded from a source file to update the BIOS version on your
system.

. Save BIOS to file

Back up the current BIOS utility on your system to another file or USB disk to save for
later use.

/R There may be risks of system crash when updating BIOS. Backing up the original BIOS
/ e utility is recommended before updating.

ASUS P8Z77-V DELUXE
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4311 MyLogo?2

This MyLogo utility lets you customize the boot logo. The boot logo is the image that appears
on screen during the Power-On-Self-Tests (POST). Personalize your computer from the very
beginning!

Launching ASUS Update

After installing Al Suite I from the motherboard support DVD, launch MyLogo by clicking
Update> MyLogo on the Al Suite [l main menu bar.

yy— i o s

Using MyLogo
Select the way you would like to do update your boot logo. Then click Next and follow the
given instructions.

Change the BIOS boot logo of my motherboard

1. Under Current BIOS, click Browse and choose the desired image for your boot logo.
Then click on Next.
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Click on Auto Tune to adjust image size compatibility or adjust the resolution bar.
You can click on Booting Preview to preview the boot image. Then click Next.
Click on Flash to start updating the image to the boot logo.

g~ W

Click on Yes to reboot or you can also see the new logo next time you restart your
computer.

Change the boot logo of a downloaded BIOS file and update (or do not update) this
BIOS to the motherboard

1.  AtBIOS File, Browse to download the requested BIOS file to your system. This utility
will help you detect the compatibility of the BIOS version.

Then at Picture File, Browse to select the desired image for boot logo. Click Next.

Follow steps 2-5 in Change the BIOS boot logo of my motherboard to complete
logo update.

Chapter 4

/ The fullscreen logo application in BIOS utility must be enabled for MyLogo to take effect.
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4.3.12  Audio configurations

The Realtek® audio CODEC provides 8-channel audio capability to deliver the ultimate audio
experience on your computer. The software provides Jack-Sensing function, S/PDIF Out
support, and interrupt capability. The CODEC also includes the Realtek® proprietary UAJ®
(Universal Audio Jack) technology for all audio ports, eliminating cable connection errors, and
giving users plug and play convenience.

Follow the installation wizard to install the Realtek® Audio Driver from the support DVD that
came with the motherboard package.

If the Realtek audio software is correctly installed, you will find 08 EI"”;"" Clatilz e
the Realtek HD Audio Manager icon on the taskbar. Double- )
click on the icon to display the Realtek HD Audio Manager. Realtek HD Audio Manager

A. Realtek HD Audio Manager with DTS UltraPC Il for Windows® 7™

Configuration option tabs (vary with the audio devices connected)
1

Device advanced
settings
Information button

Exit button
Minimize button

Control settings

Set default device buttons

Connector settings

Analog and digital connector status

B. Realtek HD Audio Manager for Windows XP

Exit button

N ==
Configuration -
options

Minimize button
Control settings
window

Information button
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% *  Refer to the software manual in the support DVD or visit the ASUS website at

www.asus.com for detailed software configuration.

«  Due to Intel® 277 platform does not support Windows® Vista™, Realtek HD Audio
driver is only supported by Windows® 7™/Windows® XP™.

«  To play Blu-Ray disc, make sure to use an HDCP compliant monitor.
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4.4 RAID configurations

The motherboard supports the following SATA RAID solutions:

. Intel® Rapid Storage Technology with RAID 0, RAID 1, RAID 10 and RAID 5 support.
. Marvell® RAID utility with RAID 0 and RAID 1 support.

R *  You must install Windows® XP Service Pack 3 or later versions before using Serial
ATA hard disk drives. The Serial ATA RAID feature is available only if you are using
Windows® XP SP3 or later versions.

*  Due to Windows® XP / Vista limitation, a RAID array with the total capacity over 2TB
cannot be set as a boot disk. A RAID array over 2TB can only be set as a data disk
only.

«  If you want to install a Windows® operating system to a hard disk drive included in a
RAID set, you have to create a RAID driver disk and load the RAID driver during OS
installation. Refer to section 4.5 Creating a RAID driver disk for details.

441 RAID definitions

RAID 0 (Data striping) optimizes two identical hard disk drives to read and write data in
parallel, interleaved stacks. Two hard disks perform the same work as a single drive but at a
sustained data transfer rate, double that of a single disk alone, thus improving data access
and storage. Use of two new identical hard disk drives is required for this setup.

RAID 1 (Data mirroring) copies and maintains an identical image of data from one drive to
a second drive. If one drive falils, the disk array management software directs all applications
to the surviving drive as it contains a complete copy of the data in the other drive. This RAID
configuration provides data protection and increases fault tolerance to the entire system. Use
two new drives or use an existing drive and a new drive for this setup. The new drive must be
of the same size or larger than the existing drive.

RAID 5 stripes both data and parity information across three or more hard disk drives. Among
the advantages of RAID 5 configuration include better HDD performance, fault tolerance, and
higher storage capacity. The RAID 5 configuration is best suited for transaction processing,
relational database applications, enterprise resource planning, and other business systems.
Use a minimum of three identical hard disk drives for this setup.

RAID 10 is data striping and data mirroring combined without parity (redundancy data) having
to be calculated and written. With the RAID 10 configuration you get all the benefits of both
RAID 0 and RAID 1 configurations. Use four new hard disk drives or use an existing drive
and three new drives for this setup.

ASUS P8Z77-V DELUXE
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442 Installing Serial ATA hard disks

The motherboard supports Serial ATA hard disk drives. For optimal performance, install
identical drives of the same model and capacity when creating a disk array.

To install the SATA hard disks for a RAID configuration:

1. Install the SATA hard disks into the drive bays.

2. Connect the SATA signal cables.

3. Connect a SATA power cable to the power connector on each drive.

443 Setting the RAID item in BIOS

You must enable the RAID function in the BIOS Setup before creating RAID set(s) using
SATA HDDs. To do this:

1.  Enterthe BIOS Setup during POST.

2. Gotothe Advanced menu > SATA Configuration, and then press <Enter>.

3. Setthe SATA Mode item to [RAID Mode].

4 Save your changes, and then exit the BIOS Setup.

% Refer to Chapter 3 for details on entering and navigating through the BIOS Setup.

AQ\ Due to chipset limitation, when set any of SATA ports to RAID mode, all SATA ports run at
RAID mode together.

444 Intel® Rapid Storage Technology Option ROM utility

To enter the Intel® Rapid Storage Technology Option ROM utility:
1. Turn on the system.
2. During POST, press <Ctrl> + <I> to display the utility main menu.

Intel (R) Rapid Storage Technology - Option ROM - v10.5.1.1070
Copyright(C) 2003-10 Intel Corporation. All Rights Reserved.

1
4. Recovery ume Options
e 5. Acceleration Options
3. Reset 6. Exit

RAID Volumes:
None defined.

Physical Devices:

Port Device Model Serial # Size Type/Status(Vol ID)
0 ST3160812AS 9LSOHJIA4 149.0GB

1 ST3160812AS 9LSOF4HL 149.0GB

2 ST3160812AS 3LS0JYL8 149.0GB

3 ST3160812AS 9LSOBJ5H 149.0GB
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[1|]-Select [ESC]-Exit [ENTER]-Select Menu
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The navigation keys at the bottom of the screen allow you to move through the menus

and select the menu options.

% The RAID BIOS setup screens shown in this section are for reference only and may not

exactly match the items on your screen.

% The utility supports maximum four hard disk drives for RAID configuration.

Creating a RAID set

To create a RAID set:

1. From the utility main menu, select 1. Create RAID Volume and press <Enter>. The

following screen appears:

Intel(R) Rapid Storage Technology - Option ROM - v10.5.1.1070
Copyright(C) 2003-10 Intel Corporation. All Rights Reserved.

L 1

Name: M 0
RAID Level ripe)
Disks: Select Disks
Strip Size:
Capacity: 0.0 GB
Sync: N/A
Create Volume

Enter a unique volume name that has no special characters and is

16 characters or less.

[1|]Change [TAB]-Next [ESC]-Previous Menu [ENTER]-Select

Enter a name for the RAID set and press <Enter>.

When the RAID Level item is selected, press the up/down arrow key to select a RAID

level to create, and then press <Enter>.

4. When the Disks item is selected, press <Enter> to select the hard disk drives you want

to include in the RAID set. The SELECT DISKS screen appears:

Port Drive Model i Status
9 ) A Z NOT

- o S|

ST3160812AS 3LS0JYL8 149.0GB Non-RAID Disk

ST3160812AS 9LSOBJISH 149.0GB Non-RAID Disk

Select 2 to 6 disks to use in creating the volume.

[1|]1-Prev/Next [SPACE]-SelectDisk [ENTER]-Done
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Use the up/down arrow key to select a drive, and then press <Space> to select. A small
triangle marks the selected drive. Press <Enter> after completing your selection.

Use the up/down arrow key to select the stripe size for the RAID array (for RAID 0, 10
and 5 only),and then press <Enter>. The available stripe size values range from 4KB
to 128KB. The following are typical values:

RAID 0: 128KB

RAID 10: 64KB

RAID 5: 64KB

4& We recommend a lower stripe size for server systems, and a higher stripe size for

multimedia computer systems used mainly for audio and video editing.

When the Capacity item is selected, enter the RAID volume capacity that you want
and press <Enter>. The default value indicates the maximum allowed capacity.

When the Create Volume item is selected, press <Enter>. The following warning
message appears:

Are you sure you want to create this volume? (Y/N):

Press <Y> to create the RAID volume and return to the main menu, or <N> to go back
to the CREATE VOLUME menu.
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Deleting a RAID set

y '\\\ Take caution when deleting a RAID set. You will lose all data on the hard disk drives when
GELER) you delete a RAID set.
To delete a RAID set:

1. From the utility main menu, select 2. Delete RAID Volume and press <Enter>. The
following screen appears:

Intel (R) Rapid Storage Technology - Option ROM - v10.5.1.1070
Copyright(C) 2003-10 Intel Corporation. All Rights Reserved.

L 1

Name Level Drives Capacity Status Bootable
0lume0 RAIDO(Stripe 2 298.0GB Norma

Yes

Deleting a volume will reset the disks to non-RAID.

ALL DISK DATA WILL BE DELETED.
(This does not apply to Recovery volumes)

[t|]-Select [ESC]-Previous Menu [DEL]-Delete Volume

2. Use the up/down arrow key to select the RAID set you want to delete, and then press
<Del>. The following warning message appears:

(This does not apply to Recovery volumes)

Are you sure you want to delete volume “Volume0™? (Y/N):

3. Press <Y> to delete the RAID set and return to the utility main menu, or press <N> to
return to the DELETE VOLUME menu.

Exiting the Intel® Rapid Storage Technology Option ROM utility
To exit the utility:

1. From the utility main menu, select 5. Exit, and then press <Enter>. The following
warning message appears:

L 1

Are you sure you want to exit? (Y/N):

Chapter 4

2. Press <Y>to exit or press <N> to return to the utility main menu.
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445 Marvell RAID utility

The onboard Marvell SATA 6.0 Gb/s controller allows you to create a RAID 0 or
RAID 1 array using two SATA hard disk drives. Refer to Chapter 2 of your motherboard user
manual for the exact location of the Marvell SATA 6.0 Gb/s connector.

To enter the Marvell utility, press <Ctrl> + <M> during POST.

/ ' i All exisiting data on the hard disk drives will be erased when creating or deleting a RAID
(@) array. Ensure that you have back up all your data in your hard disk drives before making

any change to the drive status.

Marvell BIOS Setup (c) 2009 Marvell Technology Group Ltd.

Topology: Information

[

t PD 0: ST3160812AS 1.0.0.1028

PD 8: ST3160812AS 2.2.0.1105
5.0Gbps
AHCI Mode

1B4B

Help-

Marvell RAID on chip controller.
ENTER: Operation F10: Exit/Save ESC: Return

Create a RAID Array
1. Move the selection bar to HBA 0: Marvell 0 and press <Enter>.
2. Select Configuration Wizard and press <Enter>.

Marvell BIOS Setup (c) 2009 Marvell Technology Group Ltd.

Configure->Select free disks:
(0]

0
SATA PD
Unconfigured

L PD 8: ST3160812AS 152626MB
MCQ 3G 48Bits
36

ST3160812AS
9LSOF4HL
3.AAE

Help:
Use space bar to select the free disks to be used in the array.
ENTER: Operation SPACE: Select F10: Exit/Save ESC: Return

3. Press <Space> to select the hard drives to be included in the RAID array.
An asterisk (*) appears in front of the selected hard drive. After selecting all the drives
needed for the RAID array, press <Enter> to continue.

O
>
Q
©
—+
D
=
N
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Marvell BIOS Setup (c) 2009 Marvell Technology Group Ltd.

Configure->Select free digksCreate Virtual Disk:

t Stripe Size > 64KB
* | PD 0: ST3160812AS Gigabyte Rounding : 1G

Name = Default

Next

Help:

Virtual disk configurations.
ENTER: Select F10: Exit/Save ESC: Return

4. Use the up or down arrow key to move the selection bar and press <Enter> to
configure further RAID settings.

RAID Level: Select a RAID Level. Configuration options: [RAID 0] [RAID 1]

Stripe Size: Specifies the size of single data block on the virtual disk. In general, a
larger stripe size is recommended for applications requiring large data transfers such
as audio, video, and graphics. A smaller stripe size is better for applications with
content in much smaller size, such as e-mails and documents.

Configuration options: [32K] [64K]

Gigabyte Rounding: In the event of a single physical disk failure in a RAID 1 virtual
disk, Gigabyte Rounding allows the replacement physical disk to be of a size slightly
smaller than the existing physical disk. The capacity of the rebuilt virtual disk equals
to the size of the smaller physical disk included in the RAID 1 array. The configuration
options represent the tolerance value of drive capacity difference.

Configuration options: [None] [1G] [10G]

Name: Enter a name with 1-10 letters (no special characters) for the RAID array.
5. Move the selection bar to Next and press <Enter>. The following warning message
appears:

Create Virtual Disk
Do you want to create this virtual disk ?

es (o]

Press <Y> to create the RAID array, or press <N> to cancel. The new RAID array
appears under Virtual Disks, as shown in the image below.
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Marvell BIOS Setup (c) 2009 Marvell Technology Group Ltd.

F pology

s
{ L'VD 0O:

Information

New_VD
PD 0: ST3160812AS
PD 8: ST3160812AS

RAID on chip contr
eration F10: Ex

1B4B

9130

Bl
1.0.0.1028
2.2.0.1105
5.0Gbps
AHCI Mode

6.  Press <F10>. The following warning message appears:

Exit:

Do you want to exit from Marvell BIOS Setup?

Press <Y> to save the RAID setting and exit the Marvell RAID utility.

Delete an existing RAID Array

1.  Select the RAID array to delete and press <Enter>. Select Delete and press <Enter>.
Marvell BIOS Setup (c) 2009 Marvell Technology Group Ltd.

Vs Informa
ar

tPD : ST316
PD 8: ST316

Help:
Delete the selected virtual disk.
ENTE =

eration F10: it/Save

0

New_VD
Functional
64K

RAIDO
304128MB
N/A

2
038

ESC: Return
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2. The following warning message appears:

Delete Virtual Disk
Do you want to delete this virtual disk ?

ES) (o]

Press <Y> to delete the selected RAID array. The following warning message appears:

Delete MBR:
Do you want to delete MBR from this virtual disk ?

ES) (o]

Press <Y> to delete the Master Boot Record (MBR) from the selected RAID array.
3. Press <F10>. The following warning message appears:

Exit:
Do you want to exit from Marvell BIOS Setup?

es (]

Press <Y> to save the RAID setting and exit the Marvell RAID utility.
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4.4.6 Introduction to Intel® 2012 Desktop responsiveness
technologies

This document details the overview of the installation and configuration procedures of the
Intel® 2012 Desktop responsiveness technologies.

Intel® 2012 Desktop responsiveness technologies feature the three technologies:
. Intel® Smart Response Technology
. Intel® Rapid Start Technology

. Intel® Smart Connect Technology

System Requirements for Intel® 2012 Desktop responsiveness
technologies
In order for the system to run smoothly for the Intel®* 2012 Desktop responsiveness, you must

meet the following requirements:
1. CPU: Intel® 3rd/2nd generation Core Processor family
2. OS: Windows® 7 operating systems

3. SSD: One dedicated SSD (Solid State Disk) to support Intel® Smart Response and
Intel ® Rapid Start Technology is necessary.

capacity, and system memory requirements.

% Refer to the SSD Capacity Requirements table for the information of SSD size, partition
4. HDD:

At least one HDD (Hard Disk Drive) for the system OS drive.

5. DRAM: To enable Intel® Rapid Start Technology, DRAM size smaller than 8GB is
required.

% Ensure to enable the acceleration of Intel® Smart Response Technology before
/ ' i creating the partition for the Intel® Rapid Start Technology.
LJ

Chapter 4: Software support



SSD Capacity Requirements

SSD Partition Capacity
Requirements

Intel®Rapid Start
Intel® Smart Response
Intel® Smart Response

and
Intel® Rapid Start

®storage combinations

Intel® Smart Response,
Intel® Rapid Start,
and
Intel® Smart Connect

2GB

System DRAM

lel:)
4GB

8GB

20GB 20GB 20GB
Separate 20GB Separate Separate
and 2GB 20GB and 4GB = 20GB and 8GB
partition partition partition
(SSD size > (SSD size > (SSD size >
22GB) 24GB) 28GB)
Separate Separate 20GB
Separate 2068 065004468 and 8GB
and 2GB partition ” .
(SSD size > partition partition
22GB) (SSD size > (SSD size >
24GB) 28GB)

creating RAID.

The SSD used for Intel® Rapid Start and Intel® Smart Response is not allowed for

+  Due to OS behavior, Intel® Rapid Start Technology works inefficiently with over 4G
system memory under Windows® 7 32-bit operating system.
«  Only Intel® internal SATA ports (gray and blue) support Intel® 2012 Desktop
responsiveness technologies.
«  The performance of Intel® Smart Response Technology and Intel® Rapid Storage
Technology vary by the installed SSD.
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Intel® Smart Response Technology
Intel® Smart Response Technology boosts overall system performance. It uses an installed

fast SSD (min. 20GB available) as a cache for frequently accessed operations, speeding up
hard drive/main memory interaction. Key benefits are expedited hard drive speeds, reduced
load and wait times, and maximized storage utilization. Power consumption also goes down
by reducing unnecessary hard drive spin.

A5

Before applying Intel® Smart Response Technology, setting the SATA Mode BIOS item to
[RAID mode] in BIOS setup is necessary. Refer to section 3.5.3 SATA Configuration for

details

Installing Intel® Smart Response Technology

1.

2.
3.

Place the support DVD to the optical drive. The Drivers installation tab appears if your
computer has enabled the Autorun feature.

Click the Drivers tab, then click Intel® Rapid Storage Technology Driver software.

Follow the onscreen instructions to complete the installation.

Using the Intel® Smart Response Technology

1.

Click Accelerate to launch Smart Response
Technology settings.

. Select the SSD you want to use to

accelerate your storage system.

. Select the size allocated for SSD

caching.

. Select which HDD for caching.
. Enhanced mode: WRITE THROUGH,

write to SSD and HDD at the same
time.

Maximized mode: WRITE BACK, write
to SSD and write back to HDD in a later
time.

L4451 100 $00G-42ADE Orive yOu WA 16 Ube 10 BECRITEIE YOur SIOAIGE EYIBT

® Ful sk capacity masimum 64 CX
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3. Select Disable Acceleration to disable s
this function, and select Change Mode to m:ﬂﬂ

switch acceleration mode to Enhanced/
Maximized.

R « To enable Intel® Smart Response Technology, you need at least one SSD (220GB) and
a HDD, and only one SSD can be assigned for caching.

If you want to restore the OS, go to BIOS Option ROM > Acceleration Options and

remove the Disks/Volume Acceleration to disable Intel® Smart Response Technology.

Refer to Chapter 4, section Installing Serial ATA hard disk for the entry of BIOS Option

ROM.
+ The maximum caching size on the SSD is 64GB. If it exceeds, the storage capacity left

out for caching can still be identified by the system for normal storage.

Intel® Rapid Start Technology

Intel® Rapid Start Technology allows you to quickly resume your computer from sleeping
mode. Saving your computer’s system memory to the configured SSD provides a faster
wake-up response time, but keeps the energy in a low profile.

«  Before applying Intel® Rapid Start Technology, go to Advanced Mode > Advanced >
PCH Configuration in BIOS item, and enable Intel® Rapid Start Technology.
*  Ensure to follow the procedure Creating a partition precisely to enable the Intel
R Rapid Start function. Error message appears if you install the Intel® Rapid Start Utility
before creating a partition.

Creating a partition

«  Ensure to backup your data before using the Microsoft partition tool. Incorrect
' partitioning process will result to data loss.
° *  Adjusting the DRAM to a high frequency will result to unstable system performance.

1. Goto Start, right-click Computer > Manage > Disk Management.

2. Select the SSD that you want to create the partition.

ASUS P8Z77-V DELUXE
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Right click the New Volume
that you want to shrink from,
and select Shrink Volume.

AP R TT T I T

New Volume (D3 S
62 GBINTFS 77

Primary partition

SIS Open
e

Explore

Mark Partition as Active
Change Drive Letter and Paths...

Format...

Extend Volume...
* Shrink Volume...
Add Mirrer...

Delete Volume...

Properties

Help

If your SSD is not initialized and unformatted:
a. Right click the disk that you want to create the partition, and select Initialize.
b. Right click the unallocated volume, select New Simple Volume, and follow the

remaining steps.

“@Disk 1

Unknown

60.00 GB 60.00 GB
Mot Initialized Unallocated

If your SSD is smaller than 64GB, and is set to Full disk capacity caching option for Intel®
Smart Response, you can not see any volume in the Disk Management. Ensure to set your
cache memory value of 18.6GB in Intel® Smart Response to allow enough capacity for the

Intel® Rapid Start partition.

Key in the required partition
size, and must be equal to
the system DRAM memory
(1GB = 1024MB). Click
Shrink.

Go to Start > Control
Panel > System and
Security > System, and
check the DRAM size
information.

The unallocated volume is

allocated to the selected disk.

~

o
Shrink D: =5
Total sz befors shrnk in MB fioss
Size of available shrink space in MB: i
Enter the amount of space to shink in MB 3152
Total sizs after shrink in M5 52863

operation when it has completed.

See Shrink a Basic Volume in Disk

17 You cannot shink a volume beyand the poirt where any unmovable files are located
" Ses the "defrag" svent inthe Application log for detailed information about the

 help for more information

New Volume (D2}
51.62 GB NTFS
Healthy (Primary Partition)

0068
Unallocated «

Chapter 4: Software support



10.

11.

To launch the disk partitioning tool, click Start > Programs > Accessories >

Command Prompt tool.

Type diskpart and press Enter.

In the diskpart prompt, type
list disk after DISKPART,

and press Enter. Select the disk
with the unallocated volume by

typing select disk x (x=

disk number), and press Enter .

y o

Type create partition
primary, and press Enter.

After creating a primary
partition, type detail
disk, and press Enter
to view the details of the
partitioned disk.

Select the RAW volume
which has the same size as
the shrinked volume, type
select volume X (x=
number), and press Enter
to store the Intel® Rapid
Start partition.

DISKPART> list disk

Free Dyn Gpt
1624 KB =
8 GB

2794 GB
59 GB

DISKPART > select disk 1

Disk 1 is now the selected disk.

The value “X” refers to a disk number where you created the unallocated partition.
Refer to step 5 for details about the unallocated disk space in the SSD.

IDISKPART > create partition primary
DiskPart succeeded in creating the specified partition.

DI SKPART >

DISKPART> select volume 3

olume 3 iz the selected volume.

DTS KPART >

// e The value “X" refers to a disk number where you want to create the store partition.
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12. Type set id=84 override, press Enter, and wait for the “shrinking process” until
the Disk Management utility identifies a new partition called Hibernation Partition.

DISKPART> select volume 3

I Uolume 3 is the selected volume.
DISKPART> set id=84 override

ol DiskPart s ssfully set th rtiti 1D

Healthy (Hibernation Partit izkbart successiully se e partition -

D1 SKPART >

% The Hibernation Partition does not appear when you choose “GPT (GUID Partition Table
store type”. Ensure the “Unallocated” disappears from the volume, and a new partition is
identified.

13. Reboot the system after creating the partition.

The partition for Intel® Rapid Start Technology is incomplete if the computer is not rebooted,
. and this results to function failure of Intel® Rapid Start Technology.

Enabling and disabling the Intel® Rapid Start Technology under the
oS

R Install the Intel® Rapid Start Technology first from your support DVD in order to launch the
Intel® Rapid Start Manager.

After creating the partition, launch the Intel® Rapid Start Manager to enable or disable the
Intel® Rapid Start Technology.

1. Click the Show hidden icons arrow from the right
side of the task bar, and click Intel® Rapid Start
Technology Manager icon.
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2. Tick On in the Status field to enable the function, and click Save.

Select and click to enable
or disable the function

Intel® Rapid Start Technology Manager [

Intel® Rapid Start Technology Manager

Status
Inted Rapid Start Technology @ | @ On Off I ‘

Hide Advanced Settings

Click to enable or ;
Advanced Settings

disable battery

saving mode. This fritical Battery @ On s o |
function only applies s
to notebooks. e @ 0On o off
10 Minutes
J
0 120
Save J Cancel _J

Click to enable or disable the timer. When enabled, move  Click to save the Click to cancel the
the scroll bar to the desired time. When the system is settings made.  settings made.
idle for more than the time period you set, the system

automatically goes into the Intel® Rapid Start mode.

Default time is 10 minutes.

Recovering the partition

This procedure allows you to delete the Intel® Rapid Start Technology from your system, and
recover the partition you made for the Intel Rapid® Start Technology installation.

1. Runthe Command Prompt tool.

2. Typediskpart and press Enter.

3. Atthe diskpart prompt, type DISKPART> list disk
list disk after DISKPART,

and press Enter. i Online 2794 GB
Online 59 GB

4.  Select the disk (SSD) where the TSR G L Io I T,
Intel® Rapid Start Technology
NS CUEVROR TNy Al izl 1 is now the selected disk.

type select disk x DISKPART >
(X = number), and press Enter.

/ The value “x” refers to a disk number where you want to delete the store partition.
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5.  Type list partition, DISKPART> 1ist partition

press Enter, and select the Partition ##t Type
partition where the Intel® Fartition 1  Primary 1824 B

Partition 2 OEM 51 GB

Rapid Start Technology is
installed by typing select
partition X (x =number),
and press Enter.

DISKPART > select partition 2
Partition 2 is now the selected partition.

DISKPART >

% The value “X” refers to a disk number where you want to delete the store partition.

6. Typedelete partition override, and press Enter. The diskpart utility deletes
the selected partition.

I artition 2 is now the selected partition.

IDISKPART > delete partition override
8.00 GB
Unallocated « [DiskPart successfully deleted the selected partition.

DISKPART >

7. Inthe desktop, click Start, right-click Computer, and click Manage.

8. Inthe Computer Management window, I —— ——
click Disk Management, right click the New Volume (D:)
. 51.62 GB NTFS 8.00GB
shrinked new volume, and select Extend Healthy (Primary Partition) Unallocated
Volume. Lz | Open

Explore

Mark Partition as Active

Change Drive Letter and Paths..
Primary pai  Format..

|
e .ﬁ,ﬁ

Shrink Volume...
Add Mirror...

Delete Volume...

Properties
Help
9.  As the Extend Volume Wizard appears, | esmsvoumews ==
click Next. | Welcome to the Extend Volume
| Wizard
| Tha wi o the st o eyl st

atened ok by sddng

space fom ane or ponal dsk

T cxmtrue, chek bt

™ [
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10. Click Next after selecting the default e o Wy — =
selected disk. Select Disks
Foralable: Selected
\_chemovy_ |
[T
Total volume se in megabytes (ME}: 05555
Haumus svalable sace in ME L1
Seect the amaurt of apace n MY ne
TN .

11. Extend volume setup is completed. Click Finish to recover the Intel® Rapid Start
Technology partition.

12. Reboot the system after deleting the partition.

13. Goto Start > Control Panel > Programs > Programs and Features > to remove the
Intel® Rapid Start Manager for the complete deletion of Intel® Rapid Start Technology.

Intel® Smart Connect Technology

The Intel® Smart Connect Technology is a feature that provides the latest content updates
and energy efficiency to your computer’s platform.

Once installed and activated, the Intel® Smart Connect Technology periodically wakes up the
system from sleeping mode, performs user state gathering, and initiates re-entry to sleeping
mode to wake-up after a set time interval.

* Intel® Smart Connect Technology supports Windows® Live Mail, Microsoft Outlook,
and Seesmic applications.

— It is necessary to enable the items of the PCH Configuration in the BIOS before
applying the Intel® Smart Connect Technology. Go to Advanced Mode > Advanced
> PCH Configuration, and enable the Intel® Smart Connect Technology.

Installing the Intel® Smart Connect Technology
1.  Place the support DVD to the optical drive.

2. Goto Utilities, and click Intel® Smart Connect Technology.
3. As the setup wizard appears, click Next to begin the setup.
4

Tick | accept the terms in the License Agreement, and click Next.

ASUS P8Z77-V DELUXE
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5.  Select all and click Next for 2 ol Sraor Gz Tacbiockigy 20 8 i )
Custom Setup.

Clek the rcorsl 1 Pt e below 10 change T way festures rll be ratalled.

D acee |
o - | ST

Tha feature recuires 2000 o your
hard drove..

6. Click Install to proceed the installation.

7.  Click Yes to restart your system, and for the newly installed Intel® Smart Connect
Technology to take effect.

Using the Intel® Smart Connect Technology

R «  Before the system goes to sleep mode, ensure to keep your applications on the
desktop, and enter the applications, passwords.
e Ensure that the internet is in connection when enabling the Intel® Smart Connect
Technology.

1. Click Start > All Programs > Intel > Intel® Smart Connect Technology.

2. Inthe Basic tab, click Enable Updating. When enabled, the Advanced tab is available
for advanced function settings.

The Advanced tab is activated Click to view version
when updating is enabled information and help topics

Click to configure

the basic settings —ff—8aic | Adwnced [ Hep ] 1 When updating is
Click to enable __| Eobie Upeating ___enabled, click to
or disable the (|n e reset all settings
function Not updating to default.

More Mare
Frequent
Uppelates

{5 manutes) {60 minuses)

When the scroll bar
is activated, adjust_}
the waking up time
period for Internet s Mot Setove plocing yous tystem in stsnt
data Update L Windows Live Mol ™, Outicot & &
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3. Todisable the

updating function, click

Disable Updating.
Clicking this button
automatically disables

the configuration in the
Advanced tab. To reset
to defaults, click Reset

All to Defaults.

4. Inthe Advanced tab,
set up the schedule

during low power usage

time period for power

saving. This setting only
applies to the assigned

time period.

[l et e e e

Gaic | Adweced [ velp |

e Y v T
(mtel
Will update every 15 minutes when your computer is asieep

Mere Mere
Frequent “ Battery
Updates Lie

{5 minutes} 180 mimutes)
Umer Miote: EAoBiing Bhit Servite provides for from the it your fyziem

s sutpenced (Heepingl ING (BN Couie G IMOECE 10 DOTiery AT, PlFGse MOGKE fune you Tum off your wineiess Sevioe
guring oir trave 10 conform fo il reguistions.

Alsg biese: Bedore iing your sysiem in siangby (Heer). moRe sore thot infermer anpikctions which Jou movid lite
wpdated (ke Wistoms Live Mail™, Cotioot$ and Secimic3) are rumeiing.

Startat | 700 FM -

Extended Pawer Savings:

User Note: Extented Power Sovingt oilws you 10 542 Ihe ime peviad during which ytur PC will Sonseree power by
UpESting less oflEem (Euch G mrhen jou Gre iires or ol of werkh

In the Help tab, click About to view the feature’s version. Click Topics to learn more

about the Intel® Smart Connect Technology and its configuration.
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4.5 Creating a RAID driver disk

A floppy disk with the RAID driver is required when installing a Windows® operating system
on a hard disk drive that is included in a RAID set.

R *  The motherboard does not provide a floppy drive connector. You have to use a
USB floppy disk drive when creating a SATA RAID driver disk.

*  Windows® XP may not recognize the USB floppy disk drive due to Windows® XP
limitation. To work around this OS limitation, refer to section 4.5.4 Using a USB
floppy disk drive.

45.1 Creating a RAID driver disk without entering the OS

To create a RAID driver disk without entering the OS:

Boot your compulter.

Press <Del> during POST to enter the BIOS setup utility.

Set the optical drive as the primary boot device.

Insert the support DVD into the optical drive.

Save changes and exit BIOS.

When the Make Disk menu appears, press <1> to create a RAID driver disk.
Insert a formatted floppy disk into the USB floppy disk drive, then press <Enter>.
Follow the succeeding screen instructions to complete the process.

©® N o gk~ wDd e

45.2 Creating a RAID driver disk in Windows®

To create a RAID driver disk in Windows®:

1.  Start Windows®.

2 Plug the USB floppy disk drive and insert a floppy disk.

3. Place the motherboard support DVD into the optical drive.
4

Go to the Make Disk menu, and then click Intel AHCI/RAID Driver Disk to create a
RAID driver disk.

5. Select USB floppy disk drive as the destination disk.
6.  Follow the succeeding screen instructions to complete the process.

/ Write-protect the floppy disk to avoid a computer virus infection.

O
>
Q
©
—+
D
=
N
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Installing the RAID driver during Windows® OS installation

To install the RAID driver in Windows® XP:

1.

During the OS installation, the system prompts you to press the F6 key to install third-
party SCSI or RAID driver.

Press <F6>, and then insert the floppy disk with RAID driver into the USB floppy disk drive.

When prompted to select the SCSI adapter to install, select the RAID driver for the
corresponding OS version.

Follow the succeeding screen instructions to complete the installation.

To install the RAID driver for Windows® Vista or later OS:

1.

During the OS installation, click Load Driver to allow you to select the installation
media containing the RAID driver.

Insert the USB flash drive with RAID driver into the USB port or the support DVD into
the optical drive, and then click Browse.

Click the name of the device you've inserted, go to Drivers > RAID, and then select
the RAID driver for the corresponding OS version. Click OK.

Follow the succeeding screen instructions to complete the installation.

% Before loading the RAID driver from a USB flash drive, you have to use another computer

to copy the RAID driver from the support DVD to the USB flash drive.
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454 Using a USB floppy disk drive

Due to OS limitation, Windows® XP may not recognize the USB floppy disk drive when you
install the RAID driver from a floppy disk during the OS installation.

To solve this issue, add the USB floppy disk drive’s Vendor ID (VID) and Product ID (PID) to
the floppy disk containing the RAID driver. Refer to the steps below:

1. Using another computer, plug the USB floppy disk drive, and insert the floppy disk
containing the RAID driver.

2. Right-click My Computer on the ]
- Open
Windows® desktop or start menu, e
and then select Manage from the |_ hj
pop-up window. Dbkevec ek ..
Cregte Shortodt
Uelete
Rerure
Propertes
3. Select Device Manager. From the
i H R wancdow
L_Jnlver_sal Serial Bus controllers, * ;‘"‘:‘ Cihiana
right-click xxxxxx USB Floppy, and o 5 Fodorait
then select Properties from the pop-up e e AR
W|nd0W. . Lol Users aned Grongs *| =
ey Maruger
Bk Stere & mdwiprhy Dl
otk e St
% The name of the USB floppy disk 5 0 e ot et :-wa“
A drive varies with different vendors. 3 B
Seaedard Uiversal T b LUSE Hodt Corbroler
A L0 Mo Srom e evice.
e L Bt b
A L Bk

4. Click Details tab. The Vendor ID (VID) [y
and Product ID (PID) are displayed.

General | Drivy | Detalls |

e Miumi U5 Floppy
|

ﬁl\ﬂ EEE&P\D_BSm:‘F&aszmssm&z

5. Browse the contents of the RAID driver ([, (@3]

disk to locate the file txtsetup.oem. (:] e
6.  Double-click the file. A window appears, R b
allowing you to select the program for B ey

opening the oem file BrOQrams on your computer,

What do you want ko do?

() Use the Wwieh service to find the program

I (%) Select the program From a list
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Open With

‘ ] Chonse the program you wank to use ta open this Fils:
Fils:  Extsstup.osm

Programs

) Recommended Programs: A
{8 Hotepad
) Other Pragrams:
B8 adobe Reader 8.1
@ Internet Explorer
W paint
) Windows Media Player
] Windows Ricture and Fax Wiewer
[ wordead ]
Type a description that you want to use For this kind of Fll:

[[] Always use the selscted program to open this kind of file

TF the program you wank is nok in the list or on your compter, you can look
for the appropriate program on the Web,

Find the [Hardwarelds.scsi.iaAHCI_DesktopWorkstationServer] and

[Hardwarelds.scsi.iaStor_DesktopWorkstationServer] sections in the txtsetup.oem

7. Use Notepad to open the file.
8.

file.
9.

Type the following line to the bottom of the two sections:

id = “USB\VID_xxxx&PID_xxxx", “usbstor”

[Hardwarelds.scsi . iaAHCI_DesktopWorkstationServer]
id= “PCI\VEN 8086&DEV_1C02&CC_0106",”iaStor”

Iid: “USB\VID_03EE&PID_6901”, “ushstor” I

[Hardwarelds.scsi . iaStor_DesktopWorkstationServer]
id= “PCI\VEN_8086&DEV_2822&CC_0104",”iaStor”

Iid: “USB\VID_03EE&PID_6901”, “ushstor” I

AEN

Add the same line to both sections.

The VID and PID vary with different vendors.

7

10. Save and exit the file.
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51 ATI® CrossFireX™ technology

The motherboard supports the ATI® CrossFireX™ technology that allows you to install
multi-graphics processing units (GPU) graphics cards. Follow the installation procedures in
this section.

5.1.1 Requirements

. In Dual CrossFireX mode, you should have two identical CrossFireX-ready graphics
cards or one CrossFireX-ready dual-GPU graphics card that are ATI® certified.

. Ensure that your graphics card driver supports the ATI CrossFireX technology.
Download the latest driver from the AMD website (www.amd.com).

. Ensure that your power supply unit (PSU) can provide at least the minimum power
required by your system. See Chapter 2 for details.

ZE\\ *  We recommend that you install additional chassis fans for better thermal environment.

Visit the ATI Game website (http://game.amd.com) for the latest certified graphics card
and the supported 3D application list.

5.1.2 Before you begin

For ATI CrossFireX to work properly, you have to uninstall all existing graphics card drivers
before installing ATI CrossFireX graphics cards to your system.

To uninstall existing graphics card drivers:

Close all current applications.

For Windows XP, go to Control Panel > Add/Remove Programs.
For Windows Vista, go to Control Panel > Programs and Features.

3. Select your current graphics card driver/s.

4, For Windows XP, select Add/Remove.
For Windows Vista, select Uninstall.

5. Turn off your computer.

ASUS P8Z77-V DELUXE
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513 Installing two CrossFireX™ graphics cards

4& The following pictures are for reference only. The graphics cards and the motherboard
layout may vary with models, but the installation steps remain the same.

(@)

oy

Q 1.  Prepare two CrossFireX-ready graphics
-E cards.

2 2. Insert the two graphics card into the

o1

PCIEX16 slots. If your motherboard
has more than two PCIEX16 slots,
refer to Chapter 2 in this user manual
for the locations of the PCIEX16 slots
recommended for multi-graphics card
installation.

3. Ensure that the cards are properly
seated on the slots.

4. Align and firmly insert the CrossFireX
bridge connector to the goldfingers on
each graphics card. Ensure that the
connector is firmly in place.

goldfingers

CrossFireX bridge
(bundled with
graphics cards)

5. Connect two independent auxiliary power
sources from the power supply to the two
graphics cards separately.

6.  Connecta VGA or a DVI cable to the
graphics card.
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514 Installing the device drivers

Refer to the documentation that came with your graphics card package to install the device
drivers.

Z&\\ Ensure that your PCI Express graphics card driver supports the ATI® CrossFireX™
technology. Download the latest driver from the AMD website (www.amd.com).

515 Enabling the ATI® CrossFireX™ technology

After installing your graphics cards and the device drivers, enable the CrossFireX™ feature
through the ATI Catalyst™ Control Center in Windows environment.

Launching the ATI Catalyst Control Center

To launch the ATI Catalyst Control Center: T Catalyst(TV) Control Center
) ) ) Vi
1. Right-click on the Windows® desktop and select e ’
Catalyst(TM) Control Center. You can also Sort By ’
right-click the ATl icon in the Windows notification Refresh

area and select Cayalist Control Center. e
asie

Paste Shortcut

¢ AnSy (&, ) 320 PM

MNew 3

B% Personalize

2. The Catalyst Control Center Setup =
et

Assistant appears when the system ATl Catalyst I e sy
detects the existance of multi-graphics o
cards. Click Go to continue to the
Catalyst Control Center Advanced
View window.

Enabling Dual CrossFireX

technology
1. In the Catalyst Control Center window, :
click Graphics Settings > CrossFireX > | "%, e e e e g
Configure. 2 Frrtiee =
2. From the Graphics Adapter list, select g -
the graphics card to act as the display e
GPU.
Select Enable CrossFireX. sty
Click Apply, and then click OK to exit
the window.
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54

5.2 NVIDIA® SLI™ technology

The motherboard supports the NVIDIA® SLI™ (Scalable Link Interface) technology that
allows you to install multi-graphics processing units (GPU) graphics cards. Follow the
installation procedures in this section.

52.1 Requirements

. In SLI mode, you should have two identical SLI-ready graphics cards that are NVIDIA®
certified.

. Ensure that your graphics card driver supports the NVIDIA SLI technology. Download
the latest driver from the NVIDIA website (www.nvidia.com).

. Ensure that your power supply unit (PSU) can provide at least the minimum power
required by your system. See Chapter 2 for details.

R *  We recommend that you install additional chassis fans for better thermal environment.

+  Visit the NVIDIA zone website (http://www.nzone.com) for the latest certified graphics
card and supported 3D application list.

522 Installing two SLI-ready graphics cards

R The following pictures are for reference only. The graphics cards and the motherboard
layout may vary with models, but the installation steps remain the same.

Prepare two SLI-ready graphics cards.

Insert the two graphics card into the
PCIEX16 slots. If your motherboard
has more than two PCIEX16 slots,
refer to Chapter 2 in this user manual
for the locations of the PCIEX16 slots
recommended for multi-graphics card
installation.

3. Ensure that the cards are properly seated
on the slots.
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4. Align and firmly insert the SLI bridge connector to the goldfingers on each graphics
card. Ensure that the connector is firmly in place.

5. Connect two independent auxiliary power sources from the power supply to the two
graphics cards separately.

6.  Connecta VGA or a DVI cable to the graphics card.

Lo
S
Q
fh]
o
@©
e
@)

SLI bridge

Goldfingers

523 Installing the device drivers

Refer to the documentation that came with your graphics card package to install the device
drivers.

k Ensure that your PCI Express graphics card driver supports the NVIDIA® SLI™ technology.
Download the latest driver from the NVIDIA website (www.nvidia.com).

524 Enabling the NVIDIA® SLI™ technology

After installing your graphics cards and the device drivers, enable the SLI feature in NVIDIA®
Control Panel under the Windows® Vista™ operating system.

Launching the NVIDIA Control Panel
You can launch the NVIDIA Control Panel by the following two methods.

A.  Right click on the empty space of the Windows® desktop View .
and select NVIDIA Control Panel. Sort By >
The NVIDIA Control Panel window appears (See Step B5). Refresh
Paste
Paste Shortcut
Mew 3
By Personalize
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B1. If you cannot see the NVIDIA Control Panel item in step View »
(A), select Personalize. Sort By ’
Refresh

Paste
Paste Shortcut
Undo Copy Ctrl+7

New 3

(5 Personalize ))

O
I
Q
©
~+
@
=
a1

B2. From the Personalization window,
select Display Settings.

B3. From the Display Settings dialog box, [
click Advanced Settings. e | :
Dirag the icans to match your manitars. | Identify Monitors.
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B4. Select the NVIDIA GeForce tab, and
then click Start the NVIDIA Control
Panel.

B5. The NVIDIA Control Panel window
appears.

Enabling SLI settings

From the NVIDIA Control Panel window, select
Set SLI Configuration. Click Enable SLI

and set the display for viewing SLI rendered
content. When done, click Apply.

ASUS P8Z77-V DELUXE
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Lacking farthe NVIDIA Display Cortrol Panel?

Al of the NVIDIA control panels have been consolidated into a single:
application. the NVIDIA Control Panel. f can be launched from the Windows
Control Pare! or by right clcking on the Windows desktop

St the NVIDIA Crirl Panel

[ ok ][ concel Apply

Adapter Monitor B —
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53 LucidLogix Virtu MVP

LucidLogix Virtu MVP allows your computer's VGA output and discrete graphic cards

to perform better, respond faster and process media files smoother within a low power
environment. Its GPU virtualization assigns tasks to the best available graphic source while
the newly-designed Virtual Vsync gives you a smoother gaming experience.

R . LucidLogix Virtu MVP supports Windows 7® operating systems.

. Intel® Quick Sync Video feature is supported by the 3rd/2nd generation Intel®
Core™ processor family.

. iGPU Multi-Monitor support option must be enabled in BIOS and install
both Intel® Graphics Accelerator, and graphics card driver before installing
LucidLogix Virtu MVP from ASUS support DVD. Refer to 3.5.4 System
Configuration for details.

. Hyperformance® and Virtual Sync are enabled when using more than one
discrete GPU at the same time.

. Supports NVIDIA® GF4xx/5xx series and AMD® HD5xxx/6xxx series graphic
cards.

. We do not recommended to use LucidLogix Virtu MVP under RAID mode.

53.1 Installing LucidLogix Virtu MVP
To install LucidLogix Virtu MVP:

1. Insert the support DVD in the optical drive. The ASUS Support Wizard appears if your
computer has enabled the Autorun feature.

2. Click the Utilites tab, then click LucidLogix Virtu MVP Software.

3. Follow the succeeding onscreen instructions to complete the installation.

After you successfully installed the LucidLogix Virtu MVP, the LucidLogix Virtu MVP icon
appears in the notification area.

Chapter 5: Multiple GPU technology support



53.2 Setting up your display

LucidLogix Virtu MVP solution comes with two distinct modes that allows you to enjoy better
graphics either from your built-in video output (i-Mode) or from a discrete graphics card
(d-Mode).

i-Mode
To use LucidLogix Virtu MVP in i-Mode, the display must be connected to the onboard video
output.

Lo
S
Q
fh]
o
]
e
@)

k Ensure to set the Primary Display to iGPU in BIOS to activate i-Mode support.

d-Mode
To use LucidLogix Virtu MVP in d-Mode, the display must be connected to the installed
graphics card.

R . Ensure to set the Primary Display to PCIE or PCIE/PCI in BIOS to enable
d-Mode support.

. d-Mode is recommended for an enhanced 3D gaming performance.

d-Mode (VGA output from

i-Mode (VGA output
discrete graphics card)

from motherboard)

k The motherboard’s 10 ports and discrete graphic card is for reference only and may vary in
different models.
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5.3.3 Configuring LucidLogix Virtu MVP

Launch the Virtu MVP Control Panel to allow you to configure the main features, adjust the
performance settings and select applications for graphical virtualization.

To open the control panel, right-click LucidLogix Virtu MVP icon in the notification area and
select Open Virtu MVP Control Panel.

ID Cpen Virtu MYP Control Panel I
Check for updates
Disable Virtu MVP

(@)
>
o)
©
(g
®
=
)

Remaove from system tray

R LucidLogix Virtu MVP is automatically activated when your system is powered on. Select
Remove from system tray if you want to remove LucidLogix Virtu MVP icon from the

notification area.

Main
Allows you to turn ON/OFF the GPU virtualization. Also from the Main tab, you can set to
show or hide the In-Game icon.

Click to turn ON/OFF the LucidLogix Virtu MVP

[Main |[ Performance | Applications | About |

GPU Vi tualization In-Game Icon

@ Show

@ Show for a few seconds

@ ‘% @ Hide

Integrated Descrete
GPU GPU

NIRTUMVP
GPU.

PU.Virtualization
by Lucid

Show in system tray

Click to restore to default Tick to show icon Select display
settings in system tray option for In-Game
icon
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Performance

Allows you to turn ON/OFF the Hyperformance® or Virtual Vsync function.

Chapter 5

Click to turn I nproves overall game performance and
Hyperformance® W
ON or OFF
Virtual Vsync
Click to turn 'Eau.tab\esgames to run at higher FPS with
- ster user res,
Virtual Vsync i

“_ _/ tearing artifact:
ON or OFF

.GPU.Virtualization
L

by Lucid
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Applications
Allows you to select applications for graphic virtualization.

Click to select a program to run by
discrete card, iGPU, or Hyperformance®

Application name: D
3DMark 11 Workloac @
3DMark vartage

3DMark vantage cm

3DMark06

Age of Empires 3

Age of Pirates 2

Aion i
Aliens V5 Predetor D &

Aiens WS Predetor D &

Aliens vs. Predator b

Anno 1404

Arcania Gothic 4

AmAZ

Assassing Creed 2

Assassin’s Creed D
Assassin’s Creed DX 4

[F7] Aes Thon S

(@)
)
jo)
©
—+
®
=
)

Click to add, edit, or remove programs

See the descriptions of these columns below:

. D column allows you to run applications with the discrete graphic card. Select D to
enable 3D graphical performance for that application.

. | column allows to run applications with iGPU. Select | for applications with media
extensive performance.

. H column allows you to run applications with Hyperformance®. Tick H to enhance
graphical performance for that application.

% Actual graphical performance varies with the application used and graphics card installed.
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Appendices

Notices

Federal Communications Commission Statement

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions:

*  This device may not cause harmful interference.

»  This device must accept any interference received including interference that may cause
undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not installed

and used in accordance with manufacturer’s instructions, may cause harmful interference
to radio communications. However, there is no guarantee that interference will not occur

in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user
is encouraged to try to correct the interference by one or more of the following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

«  Connect the equipment to an outlet on a circuit different from that to which the receiver is
connected.

«  Consult the dealer or an experienced radio/TV technician for help.

The use of shielded cables for connection of the monitor to the graphics card is required
to assure compliance with FCC regulations. Changes or modifications to this unit not
expressly approved by the party responsible for compliance could void the user’s authority
to operate this equipment.

IC: Canadian Compliance Statement

Complies with the Canadian ICES-003 Class B specifications. This device complies with RSS
210 of Industry Canada. This Class B device meets all the requirements of the Canadian
interference-causing equipment regulations.

This device complies with Industry Canada license exempt RSS standard(s). Operation is
subject to the following two conditions: (1) this device may not cause interference, and (2)
this device must accept any interference, including interference that may cause undesired
operation of the device.

Cut appareil numérique de la Classe B est conforme a la norme NMB-003 du Canada.
Cet appareil numérique de la Classe B respecte toutes les exigences du Reglement sur le
matériel brouilleur du Canada.

Cet appareil est conforme aux normes CNR exemptes de licence d'Industrie Canada. Le
fonctionnement est soumis aux deux conditions suivantes :

(1) cet appareil ne doit pas provoquer d'interférences et

(2) cet appareil doit accepter toute interférence, y compris celles susceptibles de provoquer
un fonctionnement non souhaité de I'appareil.
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Canadian Department of Communications Statement

This digital apparatus does not exceed the Class B limits for radio noise emissions from
digital apparatus set out in the Radio Interference Regulations of the Canadian Department
of Communications.

This class B digital apparatus complies with Canadian ICES-003.
VCCI: Japan Compliance Statement

VCCI Class B Statement

R EEBE ML B ERMIconT

IOBI - HRABHESEERSOEIAMEBAS (V) OBRICETC 7 7 ABEMLREE
TY - LORBRREMRTEASNIZLEEMLLTOL TS  TORBEF VAT LEY
IUREMCEREL THEShEL  BARELSISEITILAB 2T -

REHABI > TELWEHIRBELTTFE N -
KC: Korea Warning Statement
B 7171 ¢1AE WEFA7AA)

o] 7171€ AR 4BHE) AARHYI 2N F2 AN AEFdE A& FHos
gH, ZE A YA A + &Y.

‘29 F94NT YA AF40) 2222 IYIYH IIY AT ¢ 4
o=,

aly

REACH

Complying with the REACH (Registration, Evaluation, Authorisation, and Restriction of
Chemicals) regulatory framework, we published the chemical substances in our products at
ASUS REACH website at http://csr.asus.com/english/REACH.htm.

DO NOT throw the motherboard in municipal waste. This product has been designed to
enable proper reuse of parts and recycling. This symbol of the crossed out wheeled bin
[ ]

indicates that the product (electrical and electronic equipment) should not be placed in
municipal waste. Check local regulations for disposal of electronic products.

DO NOT throw the mercury-containing button cell battery in municipal waste. This symbol
of the crossed out wheeled bin indicates that the battery should not be placed in municipal
waste.

ASUS Recycling/Takeback Services

ASUS recycling and takeback programs come from our commitment to the highest standards for
protecting our environment. We believe in providing solutions for you to be able to responsibly
recycle our products, batteries, other components as well as the packaging materials. Please
go to http://csr.asus.com/english/Takeback.htm for detailed recycling information in different
regions.
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RF Equipment Notices

CE: European Community Compliance Statement

The equipment complies with the RF Exposure Requirement 1999/519/EC, Council
Recommendation of 12 July 1999 on the limitation of exposure of the general public to
electromagnetic fields (0-300 GHz). This wireless device complies with the R&TTE Directive.

Wireless Radio Use

This device is restricted to indoor use when operating in the 5.15 to 5.25 GHz frequency
band.

0
Q
=
o
c
o
o
o
<

Exposure to Radio Frequency Energy

The radiated output power of the Wi-Fi technology is below the FCC radio frequency
exposure limits. Nevertheless, it is advised to use the wireless equipment in such a manner
that the potential for human contact during normal operation is minimized.

FCC Bluetooth Wireless Compliance

The antenna used with this transmitter must not be colocated or operated in conjunction with
any other antenna or transmitter subject to the conditions of the FCC Grant.

Bluetooth Industry Canada Statement

This Class B device meets all requirements of the Canadian interference-causing equipment
regulations.

Cet appareil numérique de la Class B respecte toutes les exigences du Reglement sur le
matériel brouilleur du Canada.

BSMI: Taiwan Wireless Statement

EARMNESRA

BRRA S Z AR E R - SRR - A8 - SR E RS M e W -
AT MW b R B AE - (ECh M MR (AT RS RA T 2 BT A R
ERSYELA MBI - MEXCE P A - 0P8 B AR O 07 AR A - MTH S A P AR
EREFRZFGEY - EHENATMAZSSRANNIR - ARRENAREREER
0 T -

4 5.25GHz & 5.35GHz Bigi iR >
MGRHENESRE

T{F5A% 5250 ~ 5.350GHz AR N EAER -

Japan RF Equipment Statement
oML, ABEHERSI5~535CHeTEIELTWA L &1, BARSvToLEAARTT.
KC (RF Equipment)

gEs 34 4 g5

HEAIA GE nAAY

H FHduE &4 F AT st s,

o] 7171 A4} BHAH AMul2d AT &+ gFd
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ASUS contact information

ASUSTeK COMPUTER INC.

Address 15 Li-Te Road, Peitou, Taipei, Taiwan 11259
Telephone +886-2-2894-3447

Fax +886-2-2890-7798

E-mail info@asus.com.tw

Web site WWW.asus.com.tw

Technical Support

Telephone +86-21-38429911

Online support support.asus.com

ASUS COMPUTER INTERNATIONAL (America)

Address 800 Corporate Way, Fremont, CA 94539, USA
Telephone +1-812-282-3777

Fax +1-510-608-4555

Web site usa.asus.com

Technical Support

Telephone +1-812-282-2787

Support fax +1-812-284-0883

Online support support.asus.com

ASUS COMPUTER GmbH (Germany and Austria)

Address Harkort Str. 21-23, D-40880 Ratingen, Germany
Fax +49-2102-959911

Web site www.asus.de

Online contact www.asus.de/sales

Technical Support

Telephone +49-1805-010923*

Support Fax +49-2102-9599-11

Online support support.asus.com

* EUR 0.14/minute from a German fixed landline; EUR 0.42/minute from a mobile phone.
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